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What’s New

Overview

New and enhanced features in SAS Web Report Studio include the following:

o0 improved workflow for reports

O 0o oo o o

more control over report creation

improved scheduling

more control over formatting viewed reports

new filtering capabilities for tables, graphs, and maps
ability to distribute reports via e-mail

ability to insert geographical maps

Note: You must have permission to use some of the following features. If you have
questions about your authorization, contact your system administrator. A

Improved Workflow for Reports

The following enhancements were made to the workflow:

O

The new Report Management page enables you to interact with the entire
repository of reports. Actions include viewing a list of reports that you have
scheduled, and moving, copying, and deleting multiple selected reports.

o0 For existing reports, you can save without having to view the Save As dialog box.

0 You can maintain an archive for a report. Archived reports are saved in PDF file

format.

More Control over Report Creation

Improved Layout Design

You can exercise more control over layout design by using these new layout features:



viii

What’s New

The new drag-and-drop functionality enables you to place objects into the body
grid “cells.”

You can merge and split cells in the body grid to position objects exactly where you
want them to appear.

0 You can align objects within cells.

0 You can add visual elements such as headers, footers, images, and text to report

sections that contain a stored process. The visual elements are independent of the
stored process output. (Previously, a stored process section could contain only the
stored process.)

New Group Break Features

These new group break features enable you to refine your output:

O

For multidimensional data sources, you can specify group breaks for any level of a
hierarchy. For example, if a time hierarchy has the levels Year, Quarter, and
Month, you can select any level as a group break level. (Previously, you could only
select Year.)

0 You can include dynamic text with each group break level.

0 You can add an ascending or descending sort to each group break level.

0 You can select group breaks based on the number of categories or hierarchies in

the report section. For example, if there are six categories in the report section,
then you can select up to five group break levels. (Previously, you could specify a
maximum of three group breaks, regardless of the number of categories or
hierarchies used in the report section.)

More Flexihility in Defining the Query for a Report Section

Your ability to define the query that obtains the data for a report section has been
enhanced in the following ways:

O

For multidimensional data sources that contain a time hierarchy, you can create
custom data items that are based on relative time. You can calculate the difference
in a selected measure over a previous period or previous year, percentage change
of a selected measure over a previous period or previous year, and a selected
measure’s cumulative value to the current period.

You can reorder data items after you have selected them for the report section.
The order of the data items determines how they are assigned by default in tables,
graphs, and maps. (Previously, you could not move data items up or down in the
selection list after you selected them.)

o0 You can add more than one stored process to a report section.

o You can create a report section that uses both query methods: data items selected

from data sources and stored processes.

For categories in relational data sources, you can create prompted section filters
that enable users to query for prompt values.

Improved Scheduling

Report scheduling has been enhanced in the following ways:

O

A new Schedule Report Wizard makes it easier for you to specify scheduling
options.
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0 You can schedule stored processes and reports that use stored processes.
(Previously, you could only schedule reports that exclusively used data items from
a data source.)

0 You can schedule an entire folder of reports.
0 You can specify prompt values for reports and stored processes that have prompts.

More Control over Formatting Viewed Reports

When you are viewing a report, this additional functionality is available:
0O You can resize individual table columns by using your mouse.
0 You can resize graphs and maps by using your mouse.

0 You can modify table, graph, and map properties. (Previously, properties could be
changed only when editing or creating reports.)

New Filtering Capabhilities for Tables, Graphs, and Maps

Your ability to filter tables, graphs, and maps has been improved in the following
ways:

o For tables, graphs, and maps, you can filter on relative time periods. For example,
create a filter to see values based on a purchase date as of yesterday.

0 Data items that are assigned to the hidden function in tables, graphs, and maps
can be included in filters for those objects.

Ahility to Distribute Reports via E-mail

A new Distribute Report Wizard enables you to distribute reports via e-mail as a
PDF attachment or embedded HTML. Reports with group breaks can be distributed to
targeted recipients based on the breaks. For example, you have a sales report with
group breaks on regions. Each sales manager in the recipient list could receive
information on just his or her respective region.

Ability to Insert Geographical Maps

If geographic mapping is enabled for a multidimensional data source that is used in a
report section, you can insert a map object into the layout of a report. This means that
queries can consider spatial proximity as part of the analysis.
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What Is SAS Web Report Studio?

Overview

As one of the business intelligence components of the SAS Intelligence Platform, SAS
Web Report Studio enables you to view, create, and share Web-based reports. The
reports, which obtain their data from data sources that are specially prepared for use
by nontechnical report builders, provide access to the analytical power of SAS without
requiring that you understand database complexity or have programming knowledge.

Report Creation Tasks

Here are the major tasks that you can perform:
O create reports that contain data obtained from relational tables and cubes
O create reports that contain multiple sections, each using different data

O use a wizard to create simple, one-section reports that contain one table and one
graph
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Report Presentation Tasks A Chapter 1

O oo o oo o

create automatically or manually refreshed reports

specify that tables, graphs, and maps are synchronized or independent

generate quick reports simply by selecting a data source

create report templates that contain layout information

for multidimensional data sources, specify a group break at any level of a hierarchy
for multidimensional data sources, create time-based measures

render data in any of six different graph types: bar charts, bar-line charts, line
graphs, pie charts, progressive bar charts, and scatter plots

o0 render data in two different table types: list and crosstabulation

0 render multidimensional data that is enabled for geographic mapping in a map

o link text, images, group break values, table values, and graph values to a report or

to a Web page

0 add images and formatted text to reports

o filter relational data in a report section, including creating filters that prompt

users for values

Report Presentation Tasks

Here are the major tasks that you can perform:

O

O 0o o o oo o

filter and rank data in a table, graph, or map, including filtering on relative time
periods in tables and graphs

drill and expand tables, graphs, and maps

highlight table and graph values that meet specified conditions

sort tables and graphs

change data selections for tables, graphs, and maps

change the properties of tables, graphs, and maps

add percent of total calculations to tables based on relational data sources

show or hide totals in tables

Report Management Tasks

Here are the major tasks that you can perform:

0o oo oo o o o o o

schedule reports

distribute reports via e-mail as a PDF attachment or embedded HTML
copy reports

move reports

save reports as PDF files

save multiple versions of reports

save reports to publication channels

print reports (after displaying them as PDF files)

export formatted table, graph, and map data to Microsoft Excel

export an entire report to a zipped file whose contents can be opened in Microsoft
Excel or a Web browser

share saved reports or keep them private



Introduction to SAS Web Report Studio /\ About the SAS Web Report Studio User Interface

5

Log On to SAS Web Report Studio

To access SAS Web Report Studio, complete these steps:
1 To display the SAS Web Report Studio logon window, click on the URL that is

supplied by your system administrator. For example, you might click http://
server0Ol.na.abc.com:8080/SASWebReportStudio/

2 To log on, complete these steps:

a Type your User name.
b Type your Password.
¢ Click Log On.

The Welcome to SAS Web Report Studio window is displayed (see “About the
SAS Web Report Studio User Interface” on page 5).

Note: Your password is case sensitive. Your user name might or might not be case
sensitive, depending on the operating system that is used to host the Web application
server. If you need assistance, contact your system administrator. A

Log Off of SAS Web Report Studio

To log off of SAS Web Report Studio, click Log 0ff in the upper right corner of the
user interface.

Note: If there is no activity for 30 minutes, SAS Web Report Studio automatically
logs you off. Thirty minutes of inactivity is the default setting. Your system
administrator can change this value. A

About the SAS Web Report Studio User Interface

When you log on to SAS Web Report Studio, you see the following Welcome to SAS
Web Report Studio window.
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Display 1.1 The Main Features of SAS Web Report Studio That Are Available When You First Log On

1 Click Manage to access the Report Management page. The Report Management
page enables you to interact with the entire repository of reports. Actions include
viewing a list of reports that you have scheduled, and moving, copying, and
deleting multiple selected reports.

2 Click Preferences to personalize your use of SAS Web Report Studio (see “Set
SAS Web Report Studio Preferences” on page 6).

3 Click Log off to exit SAS Web Report Studio.

4 Select the Help menu to get help on using SAS Web Report Studio (see “Get Help
on SAS Web Report Studio” on page 8).

5 Select the Report menu to access task options such as Quick Report and New
Using Wizard.

6 Select the How Do I? menu to see a Help topic that relates to the currently active
feature.

7 Click Report > New to create a new report by using the Edit Report view (see
“About the Edit Report View” on page 30).

8 Click Report > Open to open an existing report or a stored process in the View
Report view (see “View a Saved Report” on page 39 and “Run a Stored Process” on
page 42).

Set SAS Web Report Studio Preferences

To set preferences for new reports, complete these steps:

Note: Changes in the Preferences dialog box do not affect existing reports. A

1 Click preferences in the upper right corner of the user interface to open the
Preferences dialog box.



Introduction to SAS Web Report Studio /A Integration with Other SAS Reporting Products 7

2 On the General tab, complete these steps:

a Specify the folder that you want to Open by default when you access the Open
dialog box or the Report Management page. If you choose Shared folders or
My folders, then select the folder.

b Specify the folder that you want selected by default in the Save As dialog box
when you Save a new report.

¢ Specify your default save reports as preference. You can change your
preference for specific reports when you save them.

Note: For information about the save options, see “Data Refresh: Manual vs.
Automatic” on page 217. A

3 On the Report Creation tab, complete these steps:

a Select the bata source that you want selected by default for all new reports
that you create.

b Select the default Report style for creating new reports. The style that you
select affects the color and font text of report objects such as tables and graphs.
The three styles that are shipped with SAS Web Report Studio are seaside (the
default), Festival, and Meadow.

Note: You also can use the Report Properties dialog box to change the style
of a viewed report. For more information, see “Set or Modify Properties for a
Viewed Report” on page 99. A

¢ For the Report header and Report footer, select one or both of the following
options:

Banner
Select the name of the image that you want to include in the header or footer
of the new reports that you create. The list contains images that have been
prepared for you by your system administrator. If you do not want to include
an image in the header or footer of your reports, then select None. (If your
system administrator did not make any images available, then None is your
only choice for Banner.)

Text
Type the text that you want to include in the header or footer of the new
reports that you create.

4 When you are done, click OK.

Note: To restore the fields of the current tab to their default settings, click Reset
Defaults. A

Integration with Other SAS Reporting Products

SAS Web Report Studio enables you to view reports that are created by using a
variety of other SAS products, including SAS Web OLAP Viewer for Java and SAS
Enterprise Guide. Some reports can be edited as if they had been created in SAS Web
Report Studio; other reports might support only some or no editing features.

This documentation focuses on tasks that you can perform on reports that were
created by using SAS Web Report Studio.
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Get Help on SAS Web Report Studio

There are three ways to access Help from within SAS Web Report Studio:

0 Select Help » [Help option]. Your Help options include viewing the table of
contents, viewing the index for the product Help, and accessing the SAS Technical
Support Web page.

0 Select How Do I? » [topic]l. This menu includes a list of Help topics that are
related to the currently active feature.

0 Click the Help button, which is available from any SAS Web Report Studio dialog
box and wizard page.

The Primary SAS Web Report Studio Menus

Report Menu

The Report menu is available except when the Report Wizard and Report
Management page are active. These are the options:

New
opens the Edit Report view so that you can begin creating a new report.

New Using Wizard
launches the Report Wizard. You can use the Report Wizard to create a
one-section report with one table and one graph.

New From Template
enables you to select a template to use as the basis for a new report. All sections
in the template will be used.

Open
opens the Open dialog box. From the Open dialog box, you can perform tasks such
as viewing, copying, and moving reports, running stored processes, and creating
folders.

Quick Report
enables you to display a default view of a selected data source in one
crosstabulation table and one bar chart. You can save the display as a report.

Save
saves the currently displayed report without prompting. If the currently displayed
report exists, then save overwrites the report. If the currently displayed report
has not previously been saved, then the Save As dialog box opens.

Save As
opens the Save As dialog box, where you can enter information for a new report,
change information for an existing report, save a report to a publication channel,
or save a report as a template.

Export
exports the contents of the currently open report as a zipped file whose contents
can be opened in a Microsoft Excel spreadsheet or a Web browser.
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Schedule
launches the Schedule Report Wizard. The Schedule Report Wizard enables you to
schedule a time for the currently displayed report or stored process output to be
pre-generated.

Note: The scheduling feature is not available if a scheduling server is not
available or if you do not have authorization to schedule reports. A

Distribute
launches the Distribute Report Wizard. The Distribute Report Wizard enables you
to schedule a time for the currently displayed report to be distributed via e-mail as
a PDF attachment or embedded HTML. (The output is external only; it is not
saved to the report repository.)

Note: The distribution feature is not available if a scheduling server is not
available or if you do not have authorization to distribute reports. o

Page Setup
enables you to set defaults for printing options such as margins.

Print
displays the current report as a PDF file that you can print.

Report Properties
enables you to set or modify report properties such as description, keywords,
report style, and display of filter information.

(the last four recently viewed reports and stored processes)
displays your selection in the View Report view.

Help Menu
The Help menu is always available. These are the options:

Contents
displays the table of contents for the Help system.

Index
displays the index for the Help system.

Using this Window
displays a Help topic that is specific to the currently active feature.

Technical Support
displays the SAS Technical Support Resources Web page.

Submit Feedback
displays the SAS Technical Support Web page for providing feedback about SAS
software or services.

SAS Home
displays the SAS corporate home page.

View Log
displays a log about the results of running the currently displayed stored
process(es).

About SAS Web Report Studio
displays copyright and other information about SAS Web Report Studio.
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How Do 1? Menu

The How Do I? menu is always available. This menu lists Help topics that explain
tasks that are applicable to the currently active feature.

Tasks That Require Authorization

You must have authorization in order to perform the following tasks:

O

O oo oo oo o o

O o o o

Access the Edit Report view.

You need access to the Edit Report view in order to perform tasks such as
creating new reports and making report modifications such as changing the query
method, and adding or removing headers, footers, group breaks, and objects.

Copy reports.

Delete folders.

Delete reports.

Move reports.

Open quick reports.

Publish reports to publication channels.
Rename folders.

Rename reports.

Save modifications to viewed reports such as filtering, sorting, and conditional
highlighting.

Save archived copies of reports.
Save viewed reports as templates.
Use a report template to create new reports.

Use the Distribute Report Wizard to distribute reports via e-mail as a PDF
attachment or embedded HTML.

Use the Report Wizard to create new reports.

Use the Schedule Report Wizard to schedule reports to be pre-generated.

If you have questions about your authorization, contact your system administrator.

About This Documentation

This documentation is written for the following audiences:

O

O

persons responsible for designing and creating Web-based reports for their
enterprise

persons responsible for analyzing report data and making decisions based on that
data

Some report tasks require specific authorization (see “Tasks That Require
Authorization” on page 10); however, everyone can view saved reports and run stored
processes.

Note: Report content depends on your authorization. Your data source
administrator determines what data you are authorized to view. A
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Documentation Part

Content

Introduction

Working with Viewed Reports

Creating and Editing Reports®

Managing Reports and Report Templates

Examples

Appendixes

instructions for logging on and off, and setting
preferences; explanations of the primary menus,
the SAS Web Report Studio interface, the
reporting elements, the report views, and the
report types

instructions for viewing saved reports, stored
processes, and quick reports, and making
changes to viewed reports such as filtering,
highlighting, sorting, and showing or hiding
totals; tips for filtering and ranking tables,
graphs, and maps

explanations of the report building tools;
instructions for obtaining data and designing
the layout of a report section; tips for creating
section filters and for defining prompts for
report linking; instructions for adding, deleting,
renaming, and reordering report sections

instructions for saving reports, organizing
reports, scheduling reports’, distributing
reports®, printing reports, renaming reports,
exporting reports, and creating and saving
templates

step-by step examples for creating a new report,
for linking a high-level report to a more detailed
report, and for filtering and ranking

an explanation of what it means to save reports
as manually or automatically refreshed;
guidelines for naming; tips for using reports
created with a previous version of SAS Web
Report Studio; a glossary

1 This documentation does not explain how to use the Schedule Report Wizard. For information
about using the Schedule Report Wizard, click Help in any wizard page.
2 This documentation does not explain how to use the Distribute Report Wizard. For information
about using the Distribute Report Wizard, click Help in any wizard page.
3 This documentation does not explain how to use the Report Wizard. For information about using
the Report Wizard, click Help in any wizard page.
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Overview of the Reporting Elements

Reports can include the following elements:

Data
The data in a report section is the result of a query (a set of instructions) sent to a
source of data such as a relational table or a cube. Each section of a report can use
one or both of these query methods:

Data items from One way to define a query is to select data items from a

data sources relational or multidimensional data source that has been
prepared especially for use by SAS Web Report Studio report
builders. If you use this method, you can refine the query by
performing tasks such as creating filters, combining filters, and
changing data formats. Task availability depends on the type
of data source.

Stored processes You also can submit a query by selecting one or more stored
processes. A stored process is saved SAS code that defines a
query that can include filtering, formatting, sorting, and layout
information. You cannot modify the query from within SAS
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Web Report Studio; however, you can perform some layout
design such as adding images, headers, and footers that are
independent of the stored process output.

Graphs
If you are using a relational or multidimensional data source, you can include six
different types of graphs in the layout of a report section: bar charts, bar-line
charts, line graphs, pie charts, progressive bar charts, and scatter plots.

Group Breaks
If you are using a relational or multidimensional data source, group breaks enable
you to divide report sections by distinct category or hierarchy level values.

Images
You can include images from a repository or from a local directory.

Maps
If you are using a multidimensional data source that has geographic mapping
enabled, you can include a map in the report section. Maps enable you to consider
spatial proximity as part of the analysis.

Tables
If you are using a relational or multidimensional data source, you can include two
different types of tables in the layout of a report section: list and crosstabulation.
Relational data can be displayed in either a list table or crosstabulation table.
Multidimensional data must be displayed in a crosstabulation table.

Text Objects
You can include text in the layout of a report section.

This chapter provides additional information about each element.

Ahout Relational and Multidimensional Data Sources

The data in a report section is the result of a query sent to a source of data such as a
relational table or a cube. One way to define the query is to select data items from a
relational or multidimensional data source.

These data sources are a collection of data items and filters that hide the technical
complexity of databases while providing a business-relevant view of your company’s
data. They are created by a data source administrator for use by report builders. For
example, you might have a data source named Order Information that includes several
data items, including Order ID, Product ID, Order Date, and Order Amount.

There are two types of data sources: relational (two-dimensional) and
multidimensional. The following table provides comparison of the functionality that
might be available when building reports that are based on the two types of data
sources. The data source administrator determines whether a particular data item can
be filtered, ranked, sorted, drilled, or expanded.
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Table 2.1 Functionality That Might Be Available for Each Type of Data Source

Feature Relational Data Multidimensional Comments
Source Data Source
Filtering category values yes no

in a report section

Filtering and ranking data yes yes
in tables, graphs, and

maps

Creating prompted report yes no

section filters

Sorting in tables and yes yes

graphs

Modifying detail and yes no For multidimensional data, records

aggregation settings are always grouped and the
aggregation method of a measure
cannot be changed.

Rendering in a list table yes no

Rendering in a yes yes In a report section that is based on

crosstabulation table a multidimensional data source,
crosstabulation tables might
provide the ability to drill down
into the data or to expand the data.

Rendering in a map no yes The data source must be enabled
for geographic mapping.

Creating custom data yes yes

items

Viewing detail data no yes A data source administrator must

enable the data source to support
this feature.

About Standard Data Items

Each data source includes one or more standard data items. You decide which data
items to use to define a query for a report section. You can use all the data items in the
data source or just a subset of data items.

The following table lists the types of standard data items, which data sources can
contain them, and a description of each type.
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Table 2.2 Standard Data ltem Descriptions

Data Source Description
Type Icon Relational Multidimensional
Category 'EI Yes Yes A data item whose distinct values are used to group

and aggregate measures. There are four types of
categories: alphanumeric, date (MM/DD/YYYY),
timestamp (MM/DD/YYY HH:mm:ss), and time
(HS:mm.ss). Alphanumeric categories can be made up
of all letters, all numbers,' or a combination of the two.
Examples of alphanumeric categories include data
items such as Product ID, Country, Employee Number,
and Employee Name. Date, timestamp, and time
category examples are Order Year, Date of Sale, and
Delivery Time.

Yes Yes A data item whose values can be used in computations.

Measure * é‘?

and Sﬁ% Usually these values are numeric. Examples of
measures include Sales Revenue, Units Sold, and

Salary.

The default format of a measure is specified by the
data source that contains it. You can modify the
format of some measures.

Every measure has a default aggregation method,
which is specified by the data source that contains it.
In some cases, you can change the method. However, if
you use a measure as part of a custom data item, then
each value of the measure is always calculated by
using the default aggregation method.

No Yes An arrangement of the levels in a dimension from
[+ general to specific. The first level in the hierarchy is

Hierarchy

the root level.

For example, a commonly used hierarchy is Time.
Such a hierarchy enables a report user to look at data
for each Year (the root level), drill down to see the data
for each Quarter (second level) in a specific year, and
then drill down to see the data for the three Months
(third level) that make up a particular quarter.

1 Categories that have values that are all numbers might be classified as character or numeric data types. The
data type affects how values are handled in relation to some functionality such as filtering and formatting.
2 The ¥ icon represents a measure that is a calculation.

For information about how to use standard data items in a report, see “Managing
Standard Data Items” on page 108.

Abhout Custom Data Items

There are two types of custom data items that you can create:

0 You can use one or more measures in a selected data source to show data that is
based on data from other measures in the data source. For example, you could
create a custom data item called Profit, which is created by using this expression:
[Revenue]-[Cost] where Revenue and Cost are measures in a data source. You
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also could create this expression: [Total Retail Price] / 1000000 where
Total_Retail_Price is the measure divided by 1 million.

o If you are using data items from a multidimensional data source with a time
hierarchy, then you can create a custom data item that is based on relative time.
You can calculate the difference in a selected measure over a previous period or
previous year, percentage change of a selected measure over a previous period or
previous year, and a selected measure’s cumulative value to the current period.
(The cumulative function starts over with each calendar year.) For example, you
might create these expressions: Percent change over previous
year[Revenue] or Cumulative[COST_N].

Measures used in a custom data item expression are always calculated by using the
default aggregation method. (Within SAS Web Report Studio, it is not possible to
produce a detailed calculation.)

For information about how to use custom data items in a report, see “Managing
Custom Data Items” on page 121.

Ahout Stored Processes

The data in a report section is the result of a query sent to a source of data such as a
relational table or a cube. One way to submit the query is to use a stored process.

A stored process is a SAS program that is stored in a central location and which can
be executed as requested by client applications. A stored process is created by a data
source administrator to provide a way for you to include the results of SAS code in your
reports. Some stored processes require that the user answer prompts before their
output is rendered.

You cannot modify a stored process query from within SAS Web Report Studio. You
also cannot edit the output of a stored process shown in the View Report view. However,
in the Edit Report view, you can perform some layout design tasks, such as adding
images, headers, and footers that are independent of the stored process output.

Note: Stored process reports that were created by using SAS Enterprise Guide do
not support any layout design. However, you can rename and delete sections (see
Chapter 11, “Managing Report Sections,” on page 157). A

For information about how to include a stored process in a report section, see
“Managing Stored Processes” on page 125.

For information about how to run a stored process directly without first inserting it
into a report section, see “Run a Stored Process” on page 42.

About Graphs

Ahout Bar Charts

A bar chart consists of a grid and some vertical or horizontal columns (bars). Each
column represents quantitative data. Bar charts are applicable when you are using
data items selected from relational or multidimensional data sources.
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Display 2.1 A Bar Chart That Is Based on Relational Data
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For information about how to use a bar chart in a report, see “Managing Graphs” on
page 145.

For information about how to make changes to a viewed bar chart, see Chapter 6,
“Changing Data in a Viewed Report,” on page 47 and Chapter 7, “Changing the
Presentation of a Viewed Report,” on page 81.

Ahout Bar-Line Charts

A bar-line chart is a bar chart with an overlaid line graph. Bar-line charts are
applicable when you are using data items selected from relational or multidimensional
data sources.

Display 2.2 A Bar-Line Chart That Is Based on Relational Data
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For information about how to use a bar-line chart in a report, see “Managing
Graphs” on page 145.

For information about how to make changes to a viewed bar-line chart, see Chapter
6, “Changing Data in a Viewed Report,” on page 47 and Chapter 7, “Changing the
Presentation of a Viewed Report,” on page 81.

About Line Graphs

A line graph shows the relationship of one variable to another, often as movements or
trends in the data over a period of time. Line graphs summarize source data and
typically are used to chart response values against discrete categorical values. Line
graphs are applicable when you are using data items selected from relational or
multidimensional data sources.

Display 2.3 A Line Graph That Is Based on Multidimensional Data

For information about how to use a line graph in a report, see “Managing Graphs” on
page 145.

For information about how to make changes to a viewed line graph, see Chapter 6,
“Changing Data in a Viewed Report,” on page 47 and Chapter 7, “Changing the
Presentation of a Viewed Report,” on page 81.

About Pie Charts

A pie chart is a circular chart that is divided into slices by radial lines. Each slice
represents the relative contribution of each part to the whole. Pie charts are applicable
when you are using data items selected from relational or multidimensional data
sources.
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Display 2.4 A Pie Chart That Is Based on Multidimensional Data

For information about how to use a pie chart in a report, see “Managing Graphs” on
page 145.

For information about how to make changes to a viewed pie chart, see Chapter 6,
“Changing Data in a Viewed Report,” on page 47 and Chapter 7, “Changing the
Presentation of a Viewed Report,” on page 81.

About Progressive Bar Charts

A progressive bar chart shows how the initial value of a measure increases or
decreases during a series of operations or transactions. The first bar begins at the
initial value, and each subsequent bar begins where the previous bar ends. The length
and direction of a bar indicates the magnitude and type (positive or negative, for
example) of the operation or transaction. The resulting chart is a stepped cascade that
shows how the transactions or operations lead to the final value of the measure.
Progressive bar charts are applicable when you are using data items selected from
relational or multidimensional data sources.
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Display 2.5 A Progressive Bar Chart That Is Based on Relational Data
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For information about how to use a progressive bar chart in a report, see “Managing
Graphs” on page 145.

For information about how to make changes to a viewed progressive bar chart, see

Chapter 6, “Changing Data in a Viewed Report,” on page 47 and Chapter 7, “Changing
the Presentation of a Viewed Report,” on page 81.

About Scatter Plots

A scatter plot is a two-dimensional plot that shows the joint variation of two data
items. In a scatter plot, each marker (represented by dots, squares, and plus signs)
represents an observation. The marker position indicates the value for each
observation. Scatter plots are applicable when you are using data items selected from

relational or multidimensional data sources.

Display 2.6 A Scatter Plot that Is Based on Multidimensional Data
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For information about how to use a scatter plot in a report, see “Managing Graphs”

on page 145.
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For information about how to make changes to a viewed scatter plot, see Chapter 6,
“Changing Data in a Viewed Report,” on page 47 and Chapter 7, “Changing the
Presentation of a Viewed Report,” on page 81.

About Group Breaks

Each report section can be divided by one or more group breaks. Each group break is
based on a category or hierarchy level, and causes the data to be grouped for each
distinct value of that category or hierarchy level. Group breaks are applicable when you
are using data items selected from a data source.

Here are some group break features:

0 You can include a measure value with each group break level.
O You can sort each level in ascending or descending order.

o If you select a page break to go with each group break, the report displays a table
of contents for navigation.

0 You can link group break values to a report or to a Web page.

0 Reports with group breaks can be distributed to targeted recipients based on the
breaks. For example, you have a sales report with group breaks on regions. Each
sales manager in the recipient list could receive information on just his or her
respective region.

For information about how to specify group breaks in a report, see “Managing Group
Breaks” on page 132.

About Images

You can insert images from a repository or from your local machine. If you select an
image from your local machine, it is saved to the repository.

Note: If you are authorized to save reports, you should be able to save images to the
repository. If you cannot save images, contact your system administrator. A

You can add tool-tip text to an image and link the image to another report or to a
Web page.

For information about how to use an image in a report, see “Managing Images” on
page 153.

About Maps

A geographic information system (GIS) is a tool for organizing and analyzing data
that can be referenced spatially, that is, data that can be tied to physical locations.
Many types of data have a spatial aspect, including demographics, marketing surveys,
and customer addresses. A GIS helps you analyze your data in the context of location.

For example, if you need to evaluate population data for census tracts, you could
view the information in a table. However, it would be easier and more effective to view
the information in the context of the geography of the tracts. When viewing information
that has a spatial component, you might find it easier to recognize relationships and
trends in your data if you view the information in a spatial context.
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If you are using a multidimensional data source that is enabled for geographic
mapping, then you can insert a map object into the report layout. This means queries
can consider spatial proximity as part of the analysis.

Display 2.7 A Map Based on a Geography Hierarchy That Contains U.S. Data

ISum Of Sales j

[ 700,000 - $1,100,000

[J#1.100.000 - $1.500.000
[1%1.500,000 - $4.800.000
[[J 1200000 - $2.300.000
[ $2.200,000 - $2.700,000

For information about how to use a map in a report, see “Managing Maps” on page
149.

For information about how to make changes to a viewed map, see Chapter 6,
“Changing Data in a Viewed Report,” on page 47 and Chapter 7, “Changing the
Presentation of a Viewed Report,” on page 81.

About Tables

About Crosstabulation Tables

A crosstabulation table shows frequency distributions or other aggregate statistics for
the intersections of two or more categories. In a crosstabulation table, categories are
displayed on both the columns and the rows, and each cell value represents the data
result from the intersection of the categories on the specific row and column.
Crosstabulation table are applicable when you are using data items selected from a
relational or multidimensional data source.
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Display 2.8 A Crosstabulation Table That Is Based on Relational Data

Order Y 2001 2002
Revenue |Units Sold| Revenue |Units Sold
Country Product Group
. Eclipse Clothing | $15343577 347 | $26,380.43 493
Australia =
Eclipse Shoes $6,955.50 1| $21,697.89 2
. Eclipse Clothing | $15670.08 257 | §27,280.46 458
Belgium =
Eclipse Shoes . | $aa7a70 a0
Canada Eclipse Clothing | §1 26560 19 $328.30 11
] Eclipse Clothing | $4 00090 73| $5,316.00 93
Denmark =
Eclipse Shoes $3,985.10 95| $9,545.20 a7
France Eclipse Clothing | 332 78527 550| §33,726.36 B23
Eclipse Shoes £78,227.30 806 | $121,216.63 1,243
Eclipse Clothin
United Kingdom _n e| $55,175.04 965 | $66,674.07 1,227
Eclipse Shoes $99,691.52 1,034 |$101,031.15 1,001
Eclipse Clothin
United States .p 8 |F115615.50 2,095 | $115,750.96 2,066
Eclipse Shoes  [f129.7249 56 12688 |%132,580.19 1317

Display 2.9 A Crosstabulation Table That Is Based on Multidimensional Data

YEAR |[(*] 3] 2001 | 3] 2000

Revenue | Revenue

Catalog REGION
(]3] SOUTHWEST | $1,461.03| $1,241.24
[+|3 SOUTHEAST | g1 83891 $1517.37

[ 3 Toys [+| 3 MORTHWEST | g22237|  $13247
[+| 3] NORTHEAST | §228195| 196458
[+][3] CENTRAL $1,00093 | $1,349.53

[+|3 SOUTHWEST | g525100| 5425500
[+|[Z] SOUTHEAST | gs207.00| $5995.00

[#] [ sports [+|Z/NORTHWEST | $a1900| $1,042.00
[+] X NORTHEAST | §70s000| $4,656.00
[+][3] CENTRAL $4,31600|  $3,339.00

[+|[Z] SOUTHWEST | §343030| $1,831.00
[+|3 SOUTHEAST | §209649| $3220965
[+] @] software [+] 3] MORTHWEST $1 G44.55 F559.40
[+| 3] NORTHEAST | $324309| 192095
[+ 3] CENTRAL $2,39585 | $1,039.64
[+ 3] SOUTHWEST | $13300|  $251.00
[+ 3] SOUTHEAST $10400  $17.00
[#] ] Collectibles |[+] 3] MORTHWEST |  §107.00 $43.00
[+] [ HORTHEAST $580.00 |  $116.00
[+][3] CENTRAL $51.00|  $135.00

For crosstabulation tables that are based on multidimensional data sources, the
hierarchy level names are displayed in the table, rather than the hierarchy names. In
Display 2.9 on page 24, YEAR is a level in a Time hierarchy and REGION is a level in a
Geography hierarchy.
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For information about using a crosstabulation table in a report, see “Managing
Tables” on page 139.

For information about how to make changes to a viewed crosstabulation table, see
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Chapter 6, “Changing Data in a Viewed Report,” on page 47 and Chapter 7, “Changing
the Presentation of a Viewed Report,” on page 81.

About List Tables

A list table is a two-dimensional representation of data, in which the data values are

arranged in unlabeled rows and labeled columns. List tables are applicable when you

are using data items selected from a relational data source.

Display 2.10 A List Table

Product Group Revenue |Units Sold
Eclip=se Clothing $1,975,358.19 34674
Eclipse Shoes Fa3810107 25 358,119
Green Tomato $92,990 47 1,962
Knitwear 641 851 .08 7194
LSF F380 736 38 3,858
Leizure F305 BEE 51 3,590
Mazsif F1290ME10 439
Crion Fa02 791 .01 a,704
Crion Clothing 264 093 16 5108
Csprey F1868.114 30 3,236
Shoes ¥1 6584 53907 17157
Shorts Fa7 B52F7 1,448
Stockings & Socks F45 39218 2945
Street Wear Fa74 2389 5,279
T-Shirt= F100138 22 3450
Tracker Clothes $1,540,0583 89 30,866
Tracker Shoes 1,625 26205 21,232
Twvain F209 35913 Tag

For information about using a list table in a report, see “Managing Tables” on page

139.

For information about how to make changes to a viewed list table, see Chapter 6,

“Changing Data in a Viewed Report,” on page 47 and Chapter 7, “Changing the
Presentation of a Viewed Report,” on page 81.

About Text Objects

Text objects can be used to display static text, dynamic prompt values, and measure

values. You can also link selected text to another report or to a Web page.

For information about how to use text in a report, see “Managing Text Objects” on

page 151.
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Overview of the Report Views

SAS Web Report Studio displays reports in two different views:

View Report View
This is the view that all SAS Web Report Studio users can see. The View Report
view displays the output of a saved report or a stored process. Users who are
authorized to create and edit reports also can use the View Report view to open a
quick report and to preview new, unsaved reports.

Edit Report View
This is the view that enables report creators to define the query that will supply
the data for the report and to design the layout of the report, including placing
objects such as tables, graphs, maps, and images. The Edit Report view is also
used to make certain changes to existing reports such as adding new sections.

This chapter provides more details about each view.

About the View Report View

What Users Can Do in the View Report View

All SAS Web Report Studio users can display their own reports, shared reports, and
stored process output in the View Report view. If the report is based on a relational or
multidimensional data source, then users also can make changes to the default report
view. For example, users can perform these tasks:
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O O o ooogo od

show or hide totals in tables

drill and expand tables, graphs, and maps
add percent of total columns to tables
filter and rank tables, graphs, and maps
add or modify conditional highlighting
sort

move columns and rows in tables

O change table, graph, and map properties such as size and color

Authorized users can save their modifications. Otherwise, the modifications are
removed when they exit the report. For information about how to make changes to a
viewed report, see Chapter 6, “Changing Data in a Viewed Report,” on page 47 and
Chapter 7, “Changing the Presentation of a Viewed Report,” on page 81.

Authorized users also can perform these tasks from the View Report view:

O
O
O

save stored process output as a new report.
open a quick report and save it as a new report.

display the viewed report in the Edit Report view. (From the Edit Report view,
users can save changes to the viewed report or use the viewed report as the basis
for a new report.)

Note: If you have questions about your authorization, contact your system
administrator. A

The View Report View Interface

Depending on how the report creator designed the report, the View Report view
might contain the following items:

O

a header

O one or more tables

O O o oo d

O

one or more graphs
one or more images
a map

text

a footer

a data pane (for reports that contain synchronized objects, which includes quick
reports)

a table of contents (for reports with separate pages for group breaks)

Here is an example of a report displayed in the View Report view. The report
contains query results from a multidimensional data source. The main features of this
specific report and the View Report view interface are identified.
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Display 3.1 The View Report View with a Header, a Crosstabulation Table, and a Bar-Line Chart

't e "

?

—

Select the Report menu to access task options such as Export and Print.

2 Authorized users can click Edit Report to open the viewed report in the Edit
Report view.

3 view Report is bold when the View Report view is active.

4 Select the How Do I? menu to see a list of Help topics that relate to the View
Report view.

5 Click Refresh Data to re-generate the report section query and see the most
current results.
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6 A header that contains some dynamic text about when the report data was last
refreshed.

7 The table toolbar, which provides access to a variety of tasks such as setting table
properties, viewing table information, filtering, and conditional highlighting.

8 A crosstabulation table. For more information, see “About Crosstabulation Tables”
on page 23.

9 The graph toolbar, which provides access to a variety of tasks such as setting graph
properties, viewing graph information, filtering, and conditional highlighting.

10 A bar-line chart. For more information, see “About Bar-Line Charts” on page 18.
If the tables, graphs, and maps in the report do not contain a toolbar, or if users
cannot interact with the report objects, then one of these conditions is probably true:

O the report needs to be refreshed
o the table, graph, or map was generated from a stored process

O the report was created in a SAS reporting application that does not support all
editing features

How to Access the View Report View

There are five ways to access the View Report view:

O Select Report » Open to display the Open dialog box, then select the name of the
report or stored process.

0 Select one of the last four opened reports or stored processes from the Report
menu.

0 Click view Report when you are creating or editing a report in the Edit Report
view.

O Select Report » Quick Report.

O Click Manage in the upper right corner of the user interface to access the Report
Management page, and then select the report or stored process that you want to
view.

About the Edit Report View

What Users Can Do in the Edit Report View

Only authorized SAS Web Report Studio users can use the Edit Report view to create
new reports and edit saved reports.
Basically, creating reports involves performing these tasks for each report section:

O selecting the query method or methods that will be used to obtain the data

o selecting and placing the report objects that will contain the data such as tables
and graphs

0 adding optional group breaks, headers, footers, images, and text
Users also must access the Edit Report view in order to make certain changes to

saved reports such as modifying the query method and layout for a report section,
adding new sections, adding report links, and synchronizing report objects.
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Note: If the Edit Report view cannot be used to edit a report, then the report was
created in a SAS reporting application that does not support all editing features.
However, users might be able to add, delete, rename, and reorder report sections. 2

The Edit Report View Interface

Authorized users can access the Edit Report view to create new reports or to edit
existing reports. Here are some of the main features of the Edit Report view.

Display 3.2 The Edit Report View Interface

AT

—0
—e

i

I

—0

1 Select the Report menu to access options such as Quick Report and New Using
Wizard.

2 Edit Report is bold when the Edit Report view is active.
3 Click view Report when you are ready to view the report.
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4 Select the How Do I? menu to see a list of Help topics that relate to the Edit
Report view.

5 There is a tab for each section in the report. To switch between report sections,
click the tab for the section that you want to see.

6 Use the section menu to add new sections, switch between sections, and rename,
delete, or reorder existing sections. For more information, see “Managing Report
Sections” on page 157.

7 If you want to select data items from a data source to define a query for the report
section, then click select data.

After you select the data items, an Options menu is available. Depending on
the type of data source, you can use this menu to change the aggregation type of
selected measures, combine filters, and preview the results of the query. You might
also be able to select or define filters and change the default format.

For more information about defining a query that uses data items, see Chapter
9, “Obtaining Data for a Report Section,” on page 107.

8 Click Apply a template to select a template to use for the layout of the report.
For more information, see “Use a Report Template to Design a Layout” on page
130.

9 Click Header to enter header information for the report section. For more
information, see “Managing Headers” on page 130.

10 If you select data items from a data source, then you can specify group breaks for
the report section. For more information, see “Managing Group Breaks” on page
132.

11 The body of the report section consists of a grid for arranging objects such as
tables, graphs, and images, and two toolbars. For more information, see Chapter
10, “Designing the Layout of a Report Section,” on page 127.

The body can also include stored process objects that are used to obtain data for
the report section. For more information, see Chapter 9, “Obtaining Data for a
Report Section,” on page 107.

12 Use this vertical toolbar to delete and align objects, and merge, split, and add cells
to the body grid.

13 Use this horizontal toolbar to insert objects (tables, graphs, maps, stored processes,
text, and images), and to synchronize objects or make them independent.

14 Click Footer to enter footer information for the report section. For more
information, see “Managing Footers” on page 131.

15 Click Vview Report when you are ready to view the report.

How to Access the Edit Report View

There are six ways to access the Edit Report view:

o0 Select Report » New.

0 Select Report » New from Template to select a report template from a gallery
and display it in the Edit Report view.

0 Click Edit Report when a saved report, a quick report, or stored process output
is displayed in the View Report view.

O Select Report » New from Wizard. After at least one data item is selected, click
Finish on any wizard page to access the Edit Report view.

0 Select Report » Open to display the Open dialog box. Next to the name of a
report, click | in the Actions column, and then select Edit.

O Click Manage in the upper right corner of the user interface to access the Report
Management page. Navigate to the report that you want to edit. Next to the name
of a report, click | in the Actions column, and then select Edit.
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Overview of the Report Types

The content that can be displayed in the View Report view can be placed into these
four categories:

Saved Reports
Saved reports are reports that you saved by completing the Save As dialog box.

You can save quick reports, the output of a stored process, and any content in the
Edit Report view, including content that is created by using the Report Wizard.

Manually Refreshed Reports
When you view a manually refreshed report, you are looking at the results of a
query that was pre-generated (that is, a query that was run at some time before
you opened the report). In order to interact with a manually refreshed report, you

must refresh the data.

Direct Stored Process Output
You can run a stored process directly, without first inserting it into a report.

Quick Reports
Quick reports use one crosstabulation table and one bar chart to present the

results of a query that is based on three standard data items from your selected
data source.

This chapter provides additional information about each type of report.

Note: Only authorized users can save reports or open a quick report. If you have
questions about your authorization, contact your system administrator. A

Note: SAS Web Report Studio also enables you to view reports that are created by
using a variety of other SAS products, including SAS Web OLAP Viewer for Java and
SAS Enterprise Guide (for more information, see “Integration with Other SAS
Reporting Products” on page 7). A
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About Saved Reports

To create a saved report, you select Report » Save or Report » Save As and then
complete the Save As dialog box. When you save a new report, you name it, provide an
optional description and keywords, and indicate whether the content should be
manually or automatically refreshed. You can share saved reports or keep them private.

You can save the following content:

O any content in the Edit Report view, including content that is created by using the
Report Wizard

O the output of a stored process that was run directly

O a quick report

For information about how to complete the Save As dialog box, see “Save a Report”
on page 168.

Note: For existing reports, you can select Report » Save to bypass the Save As
dialog box. A

About Direct Stored Process Output

You can run a stored process directly from the Open dialog box or the Report
Management page as explained in “Run a Stored Process” on page 42.

When the results are displayed in the View Report view, you can choose to save the
stored process as part of a report. One advantage of saving the stored process in a
report is that you can use the Edit Report view to add some headers, footers, text, and
images that are independent of the stored process output.

For information about what a stored process is, see “About Stored Processes” on page
17.

About Quick Reports

A quick report uses one crosstabulation table and one bar chart to present the results
of a query that is based on three standard data items from a selected data source. The
data items are the first two categories or hierarchies and the first measure in the data
source. For multidimensional data sources, the hierarchies must be from different
dimensions.

Note: In order to display a quick report, the data source must have at least one
category or hierarchy and one measure. A

The following table explains how each data item is used in the table and bar chart.
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Data Item Data Assignment Function in the Function in the Bar
Crosstabulation Chart
Table

First category/ Columns Column Bars

hierarchy

Second category/ Rows Row Vertical matrix

hierarchy

Measure Columns Column Bar height

Quick reports are displayed with a data pane that can be used to change data
selections. For information about modifying data selections, see “Managing the Data
Used for Synchronized Report Sections” on page 74.

About Manually Refreshed Reports

Manually refreshed reports are saved reports (see “About Saved Reports” on page 34)
that contain data from a pre-generated query. Typically, a manually refreshed report
displays more quickly than a report that automatically queries the physical source of
data each time that it is viewed.

There are two ways to create a manually refreshed report from within SAS Web
Report Studio:

0 You can save the report as Data can be manually refreshed.

0 You can schedule saved reports to be run at a specified time.

When viewed, manually refreshed reports behave the same regardless of how they
were created.

You have the option to refresh the data in a viewed manually refreshed report. After
you refresh the data, you can perform these tasks:

o0 Customize the view (for report sections that contain data items from a data source).
For more information, see Chapter 6, “Changing Data in a Viewed Report,” on page
47 and Chapter 7, “Changing the Presentation of a Viewed Report,” on page 81.

O Save the report in order to embed the refreshed data as the new report content.
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Overview of Viewing Reports and Running Stored Processes

This chapter explains how to display the following content in the View Report view:

O a saved report

O a stored process

O a quick report
Note: You must be authorized to view (and save) a quick report. If you have
questions about your authorization, contact your system administrator. A

For more information about these report types, see the following topics:

o “About Saved Reports” on page 34

0 “About Direct Stored Process Output” on page 34

0 “About Quick Reports” on page 34

For more information about the View Report view interface, see “The View Report
View Interface” on page 28.

View a Saved Report

To open a report, you can select one of the last four opened reports from the Report
menu, use the Open dialog box, or use the Report Management page.

Note: Report content depends on your authorization. Your data source
administrator determines what data you are authorized to view. A
To use the Open dialog box or the Report Management page, complete these steps:
1 Perform one of these tasks:
o0 Select Report » Open to open the Open dialog box.

o Click Manage in the upper right corner of the user interface to access the Report
Management page.
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The Open dialog box and the Report Management page contain a Search
for reports section and a list of reports, stored processes, and folders.

Display 5.1 The Open Dialog Box Showing a List of Reports and a Folder Named StoredProcesses

43 Open - Microsoft Internet Explorer provided hy; i =] |

“ Search for reports

Search for: = Enter search text = Search |

Search what:

Search where:

¥l Search subfolders

Dateftime limits: INDnE j
In the last |1_ lm
Location: @ Shared folders o My folders
IREpDrtS d (& (3] | 5'5 [T Show report description
Name a Actions Author Date Heywords
LI storedProcesses b adrain - O4/1242005 j

4

peters  03/11/2005
renner 0373152005
smith  07/01/2005
blake  0B/29/2005

=
Close | Help |

Delivery Performance for US Gold Customers in 2004

4

Detailed Delivery Performance by US Operating Region

4

Orion Product Profitability Summary

4

Product Group Detail Report

2 Select a report. To search for a report, complete these steps:

If the search for reports section is not visible, click ¥ .

In the search for field, type the text for which you want to search. (For
searching tips, see “Tips for Searching for Reports and Stored Processes” on
page 46.)

In the search what drop-down list, choose whether you want to search for the
text in the Name, Description, or Keywords fields.

Note: You cannot search the content of a report. A

In the search where drop-down list, select a folder name.
(Optional) To also search for reports in folders that are contained in the folder
you are searching, select Search subfolders.
(Optional) To limit your search to a time frame, select Search for Files
Modified in the Date/time limits drop-down list. Then specify the time
frame by using the fields that are below the drop-down list.
Click search.

If there are any reports that match your criteria, they are shown.

Note: After a search, the report list also includes Path information for each
located report. To clear the search results, select an option in the Location
drop-down list. A

3 If necessary, respond to prompts. (For tips, see “Tips for Responding to Prompts”
on page 45.)

4 If the report that you opened has more than one section, click the section tabs in
order to view each section. If a section contains group breaks with page breaks,
you view each page by using the table of contents.
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Display 5.2 Table of Contents That Shows Page Navigation for Two Group Breaks (an Order Channel
Category and an Age Group Hierarchy Level)

s

= l4= 4= Papes 4 of M ] ‘
=-Catalog Sale

- Female.15-30 years

--Male.15-30 years

--Female.31-45 yvears

-» Male.31-45 years

--Female.46-60 years
--Male .46-60 years
--Female.61-75 years
--Male 61-7% years
-Internet Sale

[+-Retail Sale

To collapse the table of contents, click #*. To expand the table of contents, click

¥

The following report provides information about product group revenue, and includes
percentage contribution by channel and age group. Exceptional conditions are
highlighted for product group and age group combinations for a given channel where
the revenue contribution is less than 5% or greater than 40%. This information could
be used, for example, to decide which age groups to target for a promotional offering.

Display 5.3 Example of a Saved Report That Contains Query Results from a Data Source

AR Sror1s & QUTDOORS

Orion Star Sports & Outdoors
Product Group Revenue Contributions by Age
Department: Marketing

Last saved by SAS Administrator on Tuesday, April 19, 2005 3:40:35 PM EOT
Report data refreshed on Tuesday, June 21, 2005 11:31:17 L GT-04:00

Revenue Contributions for Year: 2001

B o B i
Order Channel Retail Sale Catalog Sale Internet Sale Total

Revenue | % of Subtotal | % of Total | Revenue | % of Subtotal | % of Total | Revenue | % of Subtotal | % of Total | Revenue | % of Subtetal | % of Total

Product Group  |Age Group
15-30 years $107,393 33.44% 3.94% 37,340 24.43% 0.29% $8,102 35.61% 030% | $123.341 32.80% 4.52%
31-45 years $79,884 24.87% 2.93% 36,442 26.30% 0.31% 37678 33.75% 0.28% 596,005 25.53% 3.52%
Ectipse Clothing |46-60 years $76,088 24.31% 2.86% 37,118 2215% 0.26% 36,780 29.80% 01.25% $91,995 24.46% 3.37%
61-75 years $55.818 17.38% 2.05% 561,597 27 0% 032% $190 _ 0.01% $64,704 17.21% 237%
Subtotal $321,198 100.00% 11.78% | $32,098 100.00% 1.18% | §22,750 100.00% 0.83% | $376,045 100.00% 13.79%
15-30 years 3217712 34.18% 7.83% $20,249 3295% 074% §16,947 37.10% 062% | $254,908 34.26% 9.35%
31-45 years $161,392 25.34% 592% $12,269 19.96% 045% §14 660 32.09% 054% | 5188320 25.31% 6.91%
Eclipse Shoes 46-60 years $141,105 2215% 518% $13.756 2238% 0.50% 14,074 30.81% 052% | $168,935 22.70% 6.20%
61-75 years $116,801 18.34% 4.28% $15,183 2471% 0.56% _ 5131,985 17.74% 4.84%
Subtotal $637,010 100.00% 23.36% | 561458 100.00% 2.25% | 545,680 100.00% 1.68% $744,148 100.00% 27.29%
15-30 years 36,476 39.86% 0.24% 3483 3515% 0.02% $238 35.70% 0.01% $7.195 39.36% 0.26%
31-45 years 34,768 29.35% 017% $533 3875% 0.02% $308 6.5T% 0.01% $5.610 30.68% 0.21%
Green Tomate 46-60 years 33,045 18.75% 0.11% 363 0.00% 7 17.73% 0.00% $3.132 17.68% 0.12%
61-75 years $1,955 12.03% 0.07% $291 21.14% 0% _ . 52,246 12.28% 0.08%
Subtotal $16,245 100.00% 0.60% | $1375 100.00% 0.05% 5662 100.00% 0.02% $18,283 100.00% 0.67%
15-30 years $32,670 3292% 1.20% $3,940 2727% 044% 31,507 29.76% 0.06% 438,118 32.10% 1.40%
31-45 years $26,820 27.03% 0.38% 53,821 26.44% 014% $1,953 36.56% 0.07% $32,594 217.45% 1.20%
Knitwear 46-60 years $26,267 26.48% 0.86% $2,850 1972% 010% 31,605 31.68% 0.06% $30,742 25.89% 1.13%
61-75 years 313454 13.56% 0.43%. 53,841 26.58% 014% _ $17,295 14.56% 0.63%
Subtotal §99,231 100.00% 364% | §14,452 100.00% 0.53% | $5,065 100.00% 0.19% | $118,748 100.00% 4.36%
15-30 years $20,561 3213% 0.76% 51,639 F336% 0.06% $1.418 28.35% 0.05% 523,719 32.03% 0.87%
31-45 years $16,491 2565% 0.60% 36856 17.42% 0.03% $1,851 36.31% 007% 519,198 25.93% 0.70%
LSF 46-60 years $15,702 24.42% 0.58% $1,136 2312% 0.04% $1,563 32.34% 0.08% 518,401 24.85% 0.67%
61-75 years $11.443 17.80% 0.42% 51,282 26.10% 0.05% . $12,725 17.19% 0.47%
Subtotal 564,297 100.00% 2.36% 54,913 100.00% 0.18% 54,833 100.00% 0.18% 574,043 100.00% 2.71%
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For information about how to make changes to a report that contains query results
from a data source (including conditional highlighting as shown in Display 5.3 on page
41), see Chapter 6, “Changing Data in a Viewed Report,” on page 47, and Chapter 7,
“Changing the Presentation of a Viewed Report,” on page 81. If you are authorized, you
can save your modifications. Otherwise, the modifications are removed when you exit
the report.

Run a Stored Process

To run a stored process, you can select one of the last four opened stored processes
from the Report menu, use the Open dialog box, or use the Report Management page.

Note: Report content depends on your authorization. Your data source
administrator determines what data you are authorized to view. A
To use the Open dialog box or the Report Management page, complete these steps:
1 Perform one of these tasks:
O Select Report » Open to open the Open dialog box.

o Click Manage in the upper right corner of the user interface to access the Report
Management page.

The Open dialog box and the Report Management page contain a Search
for reports section and a list of reports, stored processes, and folders.

Display 5.4 The Report Management Page with Three Stored Processes Listed

Report Manage ment Yiew scheduled and distributed reports

¥ Search for reports

Location: & Shared folders  ©' My folders

£] [#] £} [0 Show repart description

@ [T Hamea Actions Author | Date Keywiords
Profitable Products = 09/30/2005
Year-to-Quarter Sales Chart =l 09/28/2005
= Orion Forecast Sample = 10/M05/2005

2 Select a stored process. To search for a stored process, complete these steps. (For
searching tips, see “Tips for Searching for Reports and Stored Processes” on page
46.)

a If the search for reports section is not visible, click ¥ .

b In the search for field, type the text for which you want to search.

¢ In the search what drop-down list, choose whether you want to search for the
text in the Name, Description, or Keywords fields.

Note: You cannot search the content of a stored process. A

d In the Ssearch where drop-down list, select a folder name.
e (Optional) To also search for stored processes in folders that are contained in
the folder you are searching, select Search subfolders.
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f (Optional) To limit your search to a time frame, select Search for Files
Modified in the Date/time limits drop-down list. Then specify the time
frame by using the fields that are below the drop-down list.

g Click search.

If there are any stored processes that match your criteria, they are shown.

Note: After a search, the list also includes Path information for each located
stored process. To clear the search results, select an option in the Location
drop-down list. A

3 If necessary, respond to prompts. (For tips, see “Tips for Responding to Prompts”
on page 45.)

Display 5.5 Prompt Window for the Stored Process Output Shown in Display 5.6

Pleaze anzwer the prompts below and click the View Report button to continue,

Select Company Available values: Selected values:

Qrion UK Orion LISA
Qrion Australia
Qrian Germany
Qrion Denmark

2 E

Qrian faky
Qrian Spain
Forecast Yariable Available values: Selected values:
Cost Sales
Profit

2E

* Number of months forward [
you would like to forecast

Forecast Months

View Report Reset to Defaults

The following example of stored process output uses the predictive capabilities of
SAS to give executives a glimpse into the company’s financial future. After the user
enters preferences for the country, forecast variable (cost, profit, or sales), and the
number of months to forecast, SAS Web Report Studio displays a line chart by month,
including confidence intervals, and a supporting list table with values for the year,
month, actual sales, forecast, lower 95%, and upper 95%. (The prompt window for this
stored process is shown in Display 5.5 on page 43.)
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Display 5.6 Example of Stored Process Output

You cannot modify the output of a stored process. However, if you are authorized, you
can select Report » Save to save the output as a report. When a stored process is
saved as part of a report section, you can add visual elements such as headers, footers,
images, and text that are independent of the stored process.

View a Quick Report

A quick report uses one crosstabulation table and one bar graph to present the
results of a query that is based on three data items from selected data source. The data
items are the first two categories or hierarchies and the first measure in the data
source. Quick reports are synchronized by default (see “About Synchronized Reports” on
page 74).

Note: Report content depends on your authorization. Your data source
administrator determines what data you are authorized to view. A

To open a quick report, complete these steps:
1 Select Report » Quick Report.

2 In the Select Data Source dialog box, navigate the folder tree in order to select a
data source.

3 When you are done, click oK.

4 (Optional) Modify the default data assignments (see “Managing the Data Used for
Synchronized Report Sections” on page 74).

5 (Optional) If you are authorized, save the quick report. If you save the quick
report, you can make changes such as modifying the layout and adding sections.
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Display 5.7 Example of a Quick Report Based on a Multidimensional Data Source

¥ Dataselected from:  OrionGoldCube

B g | £
Order Channel Retail Sale Catalog Sale Internet Sale
Total Costsum Total Costsum Total Costsum
Customer Type
Orion Club Gold members high activity §4,036,120 65 §358,242 85 §301,705.15
Orion Club Gold members low activity §1,705,037 .50 $201 537 60 $166,619.50
& & | i
Customer Type Total Costsum
$5,000,000.00
$4,000,000.00
Orion Clulk Gold members high activity $3,000,000.00
$2,000,000.00 ]

$1,000,000.00
$0.00

$5,000,000.00
$4,000,000.00
Orion Club Gold members low activity $3,000,000.00 1
$2,000,000.00

$1,000,000.00
$0.00 =

Order Channel | Retail Sale |Catalog Sale|Internet Sale

Display 5.8 Expanded Data Pane for the Quick Report Showing the Default Data Item Assignments

a

# Data zelected from:  OrionGoldCube

Available data items: Selected data items: Category headers:
. yTntal Costzum = > BiChannel —~ Columns Rows Hidden =
ig? Total Salessum Bcustomers Fll_lﬂ ._E-n L
» yTotalCDstsum Channel ® 1) e
Customers | N Customers O ® O
Demographics
Geography o  «
| | _»l_l - =
Apply Clear Defaults
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Tips for Responding to Prompts

Here are some tips for completing a prompt window for a report or a stored process.
0 You cannot use these characters in free-text prompts: < > ( ) & # \

0 Depending on how the prompt was created, the prompt value might be case
sensitive.

0 To reset the prompts to the default values, click Reset to Defaults.
Note: When a report is saved, the most recently specified prompt values are also

saved. If the prompts are associated with a stored process that has been inserted
into a report section, the saved prompt values might be different from the default
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prompt values that are stored with the stored process itself. To use the default
values that are stored with the stored process, you must click Reset to
Defaults. A

o If a prompt enables you to query a data source for values, then a Get Values
button is available. Depending on how the prompt was defined by the report
creator, the values will be loaded either into an Available values list box or into
a drop-down list. If the query does not return any values, then the prompts are
modified in these ways:

o If the original prompt displayed Available values/Selected values list
boxes, then the prompt becomes a multiple-value, text-entry field. Add, Remove,
and Remove All buttons will be available.

o If the original prompt was a drop-down list, then the prompt becomes a
text-entry field.
0 To obtain values for all prompts that enable you to query a data source, click Get
Values for All Prompts.

0 To cancel out of the prompt window, use the Report menu, click Edit Report, or
click Manage.

o To display the report after entering the required information, click view Report.

0 To change the prompt values after output is rendered, click Refresh in the upper
right corner of the user interface.

Tips for Searching for Reports and Stored Processes

Here are some tips for searching for reports and stored processes in the Open dialog
box or the Report Management page.

o The search is not case sensitive. For example, if you search for profit in the report
or stored process name, your search results will include reports and stored
processes such as Sports Equipment Profits as well as Company profits last year.

o If you search for a single word, then SAS Web Report Studio assumes a wildcard
character before and after the word. For example, if you perform a search with low
in the Search for field, then the search results will include reports and stored
processes with names like Low Activity, Regions with Lowered Sales, and Monthly
Allowance.

0 Searching does not include report or stored process content.
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Overview of Changing Data in a Viewed Report

In each report section that contains query results from a data source, you can use the
View Report view to make changes that affect what data is shown in tables, graphs,

and maps.

Note: With the exception of entering new prompt values, you cannot change the

output of a stored process. A

Here are some of the changes that you can make:
show or hide totals in tables

add a percent of total column to tables

filter and rank tables, graphs, and maps

drill and expand tables, graphs, and maps
enter different prompt values

O oo oood

change the measure used for a map

Note: If the report was saved as manually refreshed, then you must refresh the

report in order to make changes. A

Note: For more information about the View Report view, see “About the View Report

View” on page 27. A

Note: Only authorized users can save changes to reports. If you have questions
about your authorization, contact your system administrator. A

Change the Current Prompt Values

Some report sections and stored processes require that you answer prompts before
their output is rendered. To change the prompt values after output is rendered, click
Refresh in the upper right corner of the user interface. The prompt window will

reappear.

For more information about completing a prompt window, see “Tips for Responding to

Prompts” on page 45.

reassign individual data items to different functions in a table or graph
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Working with Tables

Specifying How Data Items Are Used in Tables

Assign Data Items to Functions in a Crosstabulation Table

To assign data items to specific functions in a crosstabulation table, complete these
steps:

1 On the crosstabulation table toolbar, click & to open the Table Data dialog box.

Note: For crosstabulation tables that use relational data, some data items are not
supported and will not appear in the Table Data dialog box. The data items that
will not appear include measures that use the distinct aggregation type. In
general, if a data item is not shown in the Table Data dialog box, then you can
assume that it is not supported. A

2 Use the Move Items drop-down list to assign each data item to one of these
functions.

Columns and Rows

Data items that are assigned to Columns appear on the columns and data items
that are assigned to Rows appear on the rows. By default, if multiple categories
or hierarchies have been selected from the data source, the first category or
hierarchy and all of the measures are assigned to the Columns function. If only
one category or hierarchy is selected from the data source, then the category or
hierarchy is assigned to the Rows function and the measures are assigned to the
Columns function.

Note: Measures that are not assigned to Hidden must be either all on the
rows or all on the columns. A

Hidden
Data items that are assigned to Hidden do not appear in the table but can be
used in filtering. For more information about working with hidden data items,
see “Tips for Working with Hidden Data Items” on page 78.

3 When you are done, click OK.

4 (Optional) Save the report.

Here are some filtering consequences of moving data items to different functions in a
crosstabulation table:

o If you add or hide a category or hierarchy column, then any row filters and
rankings that are based on a column measure are removed. Filters are not
affected by adding or hiding measures.

o If you add or hide a category or hierarchy row, then any column filters and
rankings that are based on a row measure are removed. Filters are not affected by
adding or hiding measures.

O Filters are retained if you move all the data items that are currently on rows to
the columns and move all the data items that are currently on the columns to the
rows. In this case, any existing filters will remain and be evaluated based on the
new positions.

Assign Data Items to Functions in a List Tabhle

To assign data items to specific functions in a list table, complete these steps:
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1 On the list table toolbar, click B to open the Table Data dialog box.
2 Use the Move Items drop-down list to assign each data item to one of these
functions.

Columns
By default, all data items are assigned to the columns function.

Hidden
Data items that are assigned to Hidden do not appear in the table but can be
used in filtering. For more information about working with hidden data items,
see “Tips for Working with Hidden Data Items” on page 78.
3 When you are done, click oK.

4 (Optional) Save the report.

Drill or Expand Hierarchies in a Crosstabulation Table
You can perform these tasks on a crosstabulation table that is based on
multidimensional data:

o Click [#] to expand a member of a hierarchy level. You will see the values for the
current member and the values for the next hierarchy level down for that member.

Display 6.1 In the Hierarchy Level "Year,” the Member 2000’ Has Been Expanded to Display Values for the
"Quarter’ Hierarchy Level

Product Line Clothes & Shoes

Order Channel | Retail Sale |Catalog Sale |Internet Sale

Revenue Revenue Revenue

Year | Cuarter

(+]3] 1998 $2,037 58647 | $296,578.85| $132.932.50
[+ 3] 1999 $2,317 BBG.GG | §24275067 | $166.880.63
[+]] 200001 | gagr7oozs| $374%063|  $42755.20
=13 2000 [+][3] 200002 | gros33471| $s546711| $59.624.49
[+][3] 200003 | gaz023050| $r408977| 36046983
[+][3] 200004 | gesacez7s| $esoesri|  $47.51066
[+] 3] 2001 $2245 R0 7Y | §245.557.14| 321695083
(+][3] 2002 $2676535.35 | $19572762| $257.546.53

o0 Click [+l to drill a member of a hierarchy level. You will see only the values for the
next hierarchy level down for that member.

Display 6.2 In the Hierarchy Level "Year,” the Member '2000’ Has Been Drilled to Display Values for the
"Quarter’ Hierarchy Level

Product Line Clothes & Shoes

Order Channel |Retail Sale |Catalog Sale |Internet Sale

Revenue Revenue Revenue

Cluarter

(+]3] 200001 |ga5770006| $3713063)  $42755.20
(+]3] 200002 |g78833471| go5.497.11 $50 624 49
(+]3] 200003 |gs2023289| 3$7408077| 36045988
[+]31 200004 |gessg6278| 3eage671|  §47.31068
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o Click a hierarchy level heading, and then select Expand All. (In Display 6.1 on
page 50, you would click on the hierarchy level Year.)
o Click a hierarchy level heading, and then select Collapse All.

Managing Filtering and Ranking in a List Table

Create a Filter or Ranking for a List Table

To create a filter for a list table, complete these steps:

1 On the table toolbar, click %, and then select Filter and Rank to open the Filter
and Rank dialog box.

2 In the Item, Filter list, select the data item that you want to filter. This field
displays the data items that are used in the list table along with any currently
active filters.

Note: You cannot create measure filters or rankings if the table is part of a
synchronized group. If the table is in a synchronized group, then measures are not
included in the list. The list also does not include categories that are assigned to
group breaks, or percent of total columns. A

Note: Data item names might wrap multiple lines. A

3 Select a Filter type.

4 (Optional) If the selected data item is classified as a character data type and it is
not using the default format, then you can select the Filter on formatted
values option. In this case, formatted values will be used in all parts of the
current filter query.

Note: If the selected data item is using the default format and this option is
selected (which might be the true for reports that were created with a previous
version of SAS Web Report Studio), then clear this option to improve query
performance. Leave the option selected, however, if you cannot produce the desired
results by using unformatted values. A

5 Depending on your filter type selection, take the appropriate action.

Table 6.1 Data Item Types, Filter Types, and Available Actions

Data Item Filter Type Action

any type No filter None. No filter will be applied to the selected data item.

alphanumeric category Select category Select one or more items from the Available
values' values list and move them to the Selected

values list.

Type in category Type a value and click Add to add it to the Multiple

values’ values box. Repeat this procedure for each value that
you want to filter for. To remove a value, select it in the
Multiple values box and click Remove.

date category Filter on this date Use one of these methods:

O Select an Operator and enter a Day, Month,
and Year.

O Select an Operator, and then select a relative
time period. Options include Today, Previous
. . 3
quarter, and a user-specified number of periods.
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Data Item Filter Type Action

timestamp category Filter on this date Use one of these methods:

O Select an Operator and enter a Day, Month,
Year, Hour, Minute, and Second.

O Select an Operator, and then select a relative
time period. Options include Today, Previous
quarter, Current hour, and a user-specified
number of periods.3

time category Filter on this time Use one of these methods:

O Select an Operator and enter a Hour, Minute,
and Second.

O Select an Operator, and then select a relative
time period. The options are Current hour,
Previous hour, and a user-specified number of

periods.3
measure * Filter on this Select an Operator and enter a Value. For the
measure BETWEEN operators, type a Minimum and Maximum

value. You do not type a value for the Is missing
and Is not missing operators.

Rank on this measure Select Top or Bottom from the Show field. Then, type a
value next to the option that you choose (up to 999). The
percent check box is not available for relational data.

To exclude tied rankings, select the Exclude ties
option. For example, by default, if you request the top
five products and there are three products tied for fifth
place, then seven products are returned. If you select
the Exclude ties option, then only five products are
returned.

1 The data source administrator controls whether you can select category values.

2 If you are filtering on unformatted values, then you must enter values that match the casing of the values
in the data source. If you select the Filter on formatted values option, then you must enter the
formatted values. If the filter does not return any results, then try using a different casing.

3 The filter is relative to the time that the section query is generated, not the time that the filter is imposed
on the table.

4 Enter values in the number format that is appropriate for the locale that is set for the browser.

6 When you are done, click OK.
7 (Optional) Save the report.

Note: For a summary of filtering tips, see “Tips for Filtering and Ranking Tables,
Graphs, and Maps” on page 77. A

Note: For a filtering example, see “Example 1: Filtering an Alphanumeric Category
in a List Table” on page 203. A

Remove a Filter or Ranking from a List Table

To remove a filter or ranking from a list table, complete these steps:

1 On the list table toolbar, click £, and then select Filter and Rank to open the
Filter and Rank dialog box.
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In the Item, Filter list, for each data item that should not be filtered, select No
filter as the Filter type.

When you are done, click oK.
(Optional) Save the report.

Managing Filtering and Ranking in a Crosstabulation Table

Create a Category or Hierarchy Filter for a Crosstabulation Table

To
1

6

Table 6.2 Data ltem

create a category or hierarchy filter, complete these steps:

On the table toolbar, click &%, and then select Filter and Rank to open the Filter
and Rank dialog box.

Click the category Filters tab.

In the Item, Filter list, select a category or hierarchy. This field displays the
categories and hierarchies that are used in the table along with any currently
active filters.

Note: The list does not include categories and hierarchies that are assigned to
group breaks, or percent of total columns. A

Note: Data item names might wrap multiple lines. A

Select a Filter type.

(Optional) For relational data sources, if the selected data item is classified as a
character data type and it is not using the default format, then you can select the
Filter on formatted values option. In this case, formatted values will be used
in all parts of the current filter query.

Note: If the selected data item is using the default format and this option is
selected (which might be the true for reports that were created with a previous
version of SAS Web Report Studio), then clear this option to improve query
performance. Leave the option selected, however, if you cannot produce the desired
results by using unformatted values. A

Depending on your filter type selection, take the appropriate action.

Types, Filter Types, and Available Actions

Data Item

Filter Type Action

any type

categories from
relational data
sources

any category or
hierarchy

hierarchies in the
time dimension of a
multidimensional
data source (for
example, a Year
hierarchy)

No filter None. No filter will be applied to the selected data item.

Type a value and click Add to add it to the Multiple
values box. Repeat this procedure for each value that you

Type in category
values'
want to filter for. To remove a value, select it in the Multiple
values box and click Remove.

Select one or more items in the Select filter values
list. You can select and deselect items individually, or you can
use the Select All or Deselect All buttons.

Select category
values ’

Select a Period type and enter Show and Select criteria.
In the Date Range section, specify your starting and ending
period information.

Create filter
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Data Item Filter Type Action

date categories from Create filter Use one of these methods:

relational data O Select an Operator and enter a Day, Month, and Year.

sources C .

O Select an Operator, and then select a relative time
period. Options include Today, Previous quarter,
and a user-specified number of periods.3

time categories from Create filter Select an Operator and enter a Hour, Minute, and Second.
relational data

sources

timestamp Create filter Use one of these methods:

categories from

O Select an Operator and enter a Day, Month, Year,
relational data

Hour, Minute, and Second.
sources . .
O Select an Operator, and then select a relative time

period. Options include Today, Previous quarter,
Current hour, and a user-specified number of periods.3

1 If you are filtering on unformatted values, then you must enter values that match the casing of the values
in the data source. If you select the Filter on formatted values option, then you must enter the
formatted values. If the filter does not return any results, then try using a different casing.

2 For relational data sources, your data source administrator controls whether you can select category values.

3 The filter is relative to the time that the section query is generated, not the time that the filter is imposed
on the table.

7 When you are done, click OK.
8 (Optional) Save the report.

Note: For a summary of filtering tips, see “Tips for Filtering and Ranking Tables,
Graphs, and Maps” on page 77. A

Create a Measure Filter for a Crosstabulation Table

Note: The Measure Filter or Rank tab is not available if the table is part of a
synchronized group. A
To create a measure filter, complete these steps:
1 Perform one of these tasks to open the Filter and Rank dialog box:
0 On the table toolbar, click %, and then select Filter and Rank.
o Click a measure heading in a row or column, and then select Filter by this
Row or Filter by this Column.
Note: You cannot filter on percent of total values. A

Click the Measure Filter or Rank tab,
Select the Filter a measure option.

In the show values of drop-down list, select an option.

[ B — N JU R

Depending on your Show values of selection, specify the criteria for the filter.
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Table 6.3 Filter Criteria Options for Crosstabulation Tables

Show Value Selection Criteria

(rows)'

Select a value for each category or hierarchy level on the columns. Then, select a
Measure and an Operator, and type a Value®.

(columns)’® Select a value for each category or hierarchy level on the rows. Then, select a
Measure and an Operator, and type a Value.
Outermost category or Select a Measure and an Operator, and type a Value.

hierarchy on the rows

Outermost category or

hierarchy on the columns

1 If the measures are on the columns, then a (rows) option is available.

2 If the measures are on the rows, then a (columns) option is available.

3 Do not include a currency symbol in the Value field. In addition, enter values in the number format that is
appropriate for the locale that is set for the browser.

6 When you are done, click OK.
7 (Optional) Save the report.

Note: For a filtering example, see “Example 2: Filtering Measures in a
Crosstabulation Table” on page 205. A

Note: If the current filtering choices are not acceptable, you can use the Table Data
dialog box to assign data items to different functions (see “Assign Data Items to
Functions in a Crosstabulation Table” on page 49). A

Note: For a summary of filtering tips, see “Tips for Filtering and Ranking Tables,
Graphs, and Maps” on page 77. A

Create a Ranking for a Crosstabulation Table

Note: The Measure Filter or Rank tab is not available if the table is part of a
synchronized group. A

To create a ranking for a measure in a crosstabulation table, complete these steps:
1 Perform one of these tasks to open the Filter and Rank dialog box:

0 On the table toolbar, click %, and then select Filter and Rank.

0 Click a measure heading in a row or column, and then select Rank by this

Row or Rank by this Column.
Note: You cannot filter on percent of total values. A

Click the Measure Filter or Rank tab.
Select the Rank a measure option.

4 In the show field, select Top or Bottom, and then type a value next to the option
that you chose.

5 (Optional) Choose one of these options:

o To evaluate the data as a percentage, select the percent (%) option, and then
enter a value.

Note: This option is not available for relational data sources. A

0 To exclude tied rankings, select the Exclude ties option. For example, by
default, if you request the top five products and there are three products tied for
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fifth place, then seven products are returned. If you select the Exclude ties
option, then only five products are returned.

6 In the show values of drop-down list, select an option.
7 Depending on your Show values of selection, specify the criteria for the ranking.

Table 6.4 Ranking Criteria Options for Crosstabulation Tables

Show values of Selection Based on Values of Criteria

1

(rows) Select a value for each category or hierarchy level on the columns, and then select
a Measure.

(columns) * Select a value for each category or hierarchy level on the rows, and then select a
Measure.

Outermost category or Select a Measure.

hierarchy on the rows

Outermost category or

hierarchy on the columns

1 If the measures are on the columns, then a (rows) option is available.
2 If the measures are on the rows, then a (columns) option is available.

8 When you are done, click OK.
9 (Optional) Save the report.
Note: If the current ranking choices are not acceptable, you can use the Table Data

dialog box to assign data items to different functions (see “Assign Data Items to
Functions in a Crosstabulation Table” on page 49). A

Note: For a summary of ranking tips, see “Tips for Filtering and Ranking Tables,
Graphs, and Maps” on page 77. A

Remove a Filter or Ranking from a Crosstabulation Tahle

To remove a filter or ranking from a crosstabulation table, complete these steps:

1 On the table toolbar, click &, and then select Filter and Rank to open the Filter
and Rank dialog box.

2 Remove category and hierarchy filters, measure filter, or ranking as described next:

0O On the category Filters tab, for each data item that should not be filtered,
select No filter as the Filter type.

O On the Measure Filter or Rank tab, select No measure filter or rank.
3 When you are done, click OK.
4 (Optional) Save the report.

Managing Percent of Total Columns in a Tahle

Add a Percent of Total Column to a Table

To add percentage calculations, totals, and comparisons to summary values to a
table, complete these steps:
1 On the table toolbar, click £%, and then select Percent of Total to open the
Percent of Total dialog box.



Changing Data in a Viewed Report /\ Managing Percent of Total Columns in a Table 57

Note: This menu item is not available if the table does not contain any measures
that can be used in a grand total; if the table is in a synchronized group; or if the
table uses multidimensional data. A

2 In the For measure drop-down list, select a measure for the comparison. This list
contains one item for each measure in the current table. The first measure in the
table (reading left to right or top to bottom) is selected by default.

Note: This list does not contain measures that are added by using this dialog
box. A

Note: You cannot create a percent of total calculation that is based on a hidden
data item. A

Note: Only those measures that make sense for a grand total calculation are
available. A

3 In the Sshow percent of drop-down list, select an option, depending on the type of
table:

0 For list tables, the Column Total option is the only type of percent of total that
is supported.

Note: If you change a crosstabulation table to a list table, any percent of total
value column will be discarded unless it is a Column Total. A

0 For crosstabulation tables, for the selected measure, select the value that you
want to calculate the measure as a percentage of. Your predefined choices are
Grand Total, Column Total, and Row Total. The drop-down list also contains
these options:

O one option for the subtotal of each category in the columns of the table. The
options are listed in order from the top down.

O one option for the subtotal of each category in the rows of the table. The
options are listed in order from the outside inward.

4 Type a Label for the calculation that you are creating. You can use a maximum of
30 characters. By default, the Label field is blank. The Add button is not available
until you enter a value into this field.

5 Click Add to add your For measure, Show percent of, and Label selections to
the box.

6 When you are done, click oK.

When the measure that is used in the calculation appears in a column, the new
calculation appears immediately to the right of the measure. When the measure
that is used in the calculation appears in a row, the new calculation appears
immediately below the measure.

7 (Optional) Save the report.

Note: If you add a percent of total value column to a crosstabulation table, then any
row filters and rankings that are based on a column measure are removed. A
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Display 6.3 List Table with a Percent of Total Column (Third Column) Calculated for Revenue

Product Group Revenue Revenue as % of Total|Units Sold | Total Cost
Eclip=e Clothing F1978 355819 13.92% 34 674 Fa94 623
Eclipze Shoes F3510,107 .25 2682% 35119 1,921,362
Green Tomato $92,930 47 0.65% 1962 537 678
Knitwear F641 551 .03 4.52% 7154 F274 266
L=F F350,736.38 268% 3,555 F183,769
Leisure F305 666 .51 215% 3,690 F136,952
Maszzit F129016.10 0.91% 439 BE61,421
Orion F802,731.M S 65% G,704 $383574
Crian Clothing F264 09516 1.86% 4,106 %126 605
Ozprey F1586,114 .30 1.31% 3,236 F76, 797
Shoes §1 654 6539.07 11 86% 17157 F77E.04
Shorts Far Be2.y7 0.27% 1,445 F16,785
Stockings & Socks $45,392 15 032% 2,946 18,624
Street Viear F374 21389 263% 5,279 157,829
T-Shit=z F100138.22 0.70% 35,450 44 o264
Tracker Clathes §1 54005359 10.54% 30,566 F7OT7 282
Tracker Shoes §1,625 26205 11 .44% 21,232 Fra5.702
Twwain F209,35513 1.47% 788 $101 8395
Total 514,208,470 .64 100.00% 190148 | 56,769,263

Remove a Percent of Total Column from a Table

To remove a percent of total column from a table, complete these steps:

1 On the table toolbar, click &%, and then select Percent of Total to open the
Percent of Total dialog box.

2 Select a calculation.

3 Click Remove.

4 When you are done, click OK.
5 (Optional) Save the report.

Note: If you remove a percent of total value column from a crosstabulation table,
then any row filters and rankings that are based on a column measure are removed. A

Show or Hide Totals in a Table

To show or hide totals, complete these steps:
1 On the table toolbar, click &%, and then select Total to open the Total dialog box.

2 Select one or more of these options:

Rows: Subtotals
Select this option to display row subtotals. This option is available only if the
table is a crosstabulation table and if there are at least two hierarchies or
categories assigned as columns.

Note: 1If a table contains row filters that are based on row subtotal values,
then those filters are removed when you turn off subtotals for the table. A

Rows: Totals
Select this option to display row totals. This option is available only if the table
is a crosstabulation table and if there is at least one hierarchy or category
assigned as a column.

Note: If a table contains row filters that are based on row total values, then
those filters are removed when you turn off totals for the table.
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Subtotals

Select this option to display column subtotals. This option is available only if
the table is a crosstabulation table and if there are at least two hierarchies or
categories assigned as rows.

Note: If a table contains column filters that are based on column subtotal
values, then those filters are removed when you turn off subtotals for the table.
A
Columns: Totals

Select this option to display column totals. This option is available for both list
and crosstabulation tables.

Note:

then those filters are removed when you turn off totals for the table.

3 When you are done, click oK.

If a table contains column filters that are based on column total values,
JAN

By default, total and subtotal values are displayed in boldface type. In addition, their
table cells have a light blue background. For information about how to change the
properties for displaying totals, see “Set Properties for a Table” on page 86.

Display 6.4 List Table With Formatted Column Total Values

Product Group |Units Sold Revenue

Eclipse Clathing 34660| $1,977,589.79
Eclipze Shoes 35109| $3,809,184 BS
Green Tomato 1,962 F92,.990.47
Massif 439 F12901610
Drion Clothing 5,106 F264 09516
Tracker Clothes 30542 $1,539593.49
Tracker Shoes 21,222 1,624 450 65
Twwain Fag F20935913
Total 133128 |59,646,082.43

Display 6.5 Crosstabulation Table With Formatted Row Totals and Column Subtotals

Year | F[3]1908 | #13] 19090 | [ZI3] 2000 | [+ 2001 | *I 3] 2002 Total

Product Category [Order Channel

Retail Sale  |Profit| §533,04027 | $605356.44 | $740479.20| $516,254.20| §595325.64 |$3,200,485.94
3 Clothes Catalog Sale |Profit| §5117075| §6208629| §74600.44| §7030322| §5411935| 5$312,288.05

Internet Sale |Profit| $2793930| $4094005| $52.41366| §$5873825| 7200836 $253,030.78

Subtotal Profit|$612,150.32 |$709,383.71 |$876,501.59 [$745,325.79 |5822,443.35 |53,765,804.77

Retail Sale Profit| §53572760| $605130.24| $701,050.00| $558,57557| §705.781.56|53,106,244.97
[ @ Shoes Catalog Sale |Profit| $5740030| §6467653| 6492675 $58,090377| fa4oi24.52| 5304,032.20

Internet Sale |Profit| §4459335| §4650070| 5764047 5500045 §e22oi 45| 5263,125.45

Subtotal Profit|$644,721.25($716,316.77 |$823,597.25 [5672,569.79 |5816,197.56 |53,673,402.62

View Detail Data in a Crosstabulation Table

When a crosstabulation report that is based on multidimensional data is displayed,
complete these steps to view the detail data:

1 Perform one of these tasks to open the View Detail dialog box:

O To see the detail data behind a value in the crosstabulation table, click the
value (which will be underlined).
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O To see the detail data behind a row or a column in the crosstabulation table,
click the row or column heading in the innermost level of the innermost
hierarchy in the row or column, and then select view Detail.

Display 6.6 View Detail Option for the Revenue Column

Product Line Clothes & Shoes
Order Channel | Retail Sale |Catalog Sale |Internet Sale
Revenue Revenue Revenue

Yeal Sort Ascending

[+1311998  |go037Ee642| $2o6s7acns| |Sort Descending

(1311999  |gom7eesse| §24225287

2] 2000 —— Move Measures to Rows

(+13]12001  |3224576077 | 24585714

[+1312002  |go6ves3535| pesraves|
Filter by this Column
Ranlk: by this Column
View Detail h
Rotate Table

Note: If report linking has been enabled for the values in the crosstabulation

table, then, when you click on a value, you will be prompted to either view detail
data or follow the report link. A

2 (Optional) To export the data into a Microsoft Excel spreadsheet, click Export.
3 To exit the View Detail dialog box, click Close Window.

Note: You cannot view detail in a crosstabulation table if the data source has not
been set up to support this feature by your data source administrator. In addition,
whether the columns show the column label or the column name is controlled by an
administrator. A

View Tahle Information

To display information about a table, click L on a table toolbar. The Table
Information dialog box contains the following information:

Data source
This section contains the following information:

Name
This field displays the name of the data source that is being used for this
table.

Type
This field displays the type of data source (Relational or
Multidimensional). The data source type determines which options are
available for building and viewing reports.

Description
This field displays a description of the data source, if one is available.
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Applied filters
This field displays the following information:

o The filters that are applied to the current report section. These filters affect
all of the tables in this section.

o The filters and the rankings that are applied just to this table.

0 The expression that specifies how the filters and rankings are applied.

Data item, Physical name, Description/expression
For each data item in this table, this box lists the name of the data item as it
appears in the data source that was prepared by the data source administrator,
the name of the data item in the original data source, and either a description
(standard data items) or an expression (calculated data items).

Note: You can modify report properties so that filter information is displayed along
with the report. For more information, see “Set or Modify Properties for a Viewed
Report” on page 99. A

Working with Graphs

Specifying How Data Items Are Used in Graphs

Assign Data Items to Functions in a Bar Chart

To assign data items to specific functions in a bar chart, complete these steps:
1 On the bar chart toolbar, click & to open the Graph Data dialog box.

2 Use the Move Items drop-down list to assign each data item to one of these
functions.

Bar Height
Specify the measure that will be used to determine the height of each bar. Bar
Height is required. By default, if data has been selected, then the first measure
in the data source is assigned to Bar Height.

Note: If you assign a category or hierarchy to the Bar Subgroup, then you
can only assign one measure to Bar Height. A

Bars (Limit 1)
Select a category or hierarchy, each value of which will be represented by a bar.
Bars is required. By default, if data has been selected, then the first category or
hierarchy in the data source is assigned to Bars.

Bar Subgroup (Limit 1)
You can subdivide each bar across the values of the category or hierarchy that
you assign to this function.

Note: If you assign more than one measure to Bar Height, then you cannot
add a category or hierarchy to the Bar Subgroup. A

Horizontal Matrix
You can create separate bar charts for each value of a selected category or
hierarchy. The charts appear side by side. For example, if you select a Gender
category for the horizontal matrix, a chart for each value of Gender is displayed
side by side along a horizontal line.
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Vertical Matrix
You can create separate bar charts for each value of a selected category or
hierarchy. The charts appear stacked one on top of the other. For example, if
you select a Gender category for the vertical matrix, a chart for each value of
Gender is stacked along a vertical line.

Hidden
By default, if data has been selected, then all the data items that have not been
assigned to Bar Height or Bars are assigned to Hidden.
For tips related to hiding data items, see “Tips for Working with Hidden Data
Items” on page 78.

3 When you are done, click oK.
4 (Optional) Save the report.

Assign Data Items to Functions in a Bar-Line Chart

To assign data items to specific functions in a bar-line chart, complete these steps:
1 On the bar-line chart toolbar, click & to open the Graph Data dialog box.

2 Use the Move Items drop-down list to assign each data item to one of these
functions.

Bar Height (Limit 1)
Specify the measure that will be used to determine the height of each bar. Bar
Height is required. By default, if data has been selected, then the first measure
in the data source is assigned to Bar Height.

Line Height (Limit 1)
Select the measure that will be used to determine the height of the line at each
bar. Line Height is required. By default, if data has been selected, then the
second measure in the data source is assigned to Line Height.

Bars (Limit 1)
Select a category or hierarchy, each value of which will be represented by a bar.
Bars is required. By default, if data has been selected, then the first category or
hierarchy in the data source is assigned to Bars.

Horizontal Matrix
You can create separate bar-line charts for each value of a selected category or
hierarchy. The charts appear side by side. For example, if you select a Gender
category for the horizontal matrix, a chart for each value of Gender is displayed
side by side along a horizontal line.

Vertical Matrix
You can create separate bar-line charts for each value of a selected category or
hierarchy. The charts appear stacked one on top of the other. For example, if
you select a Gender category for the vertical matrix, a chart for each value of
Gender is stacked along a vertical line.

Hidden
By default, if data has been selected, then all the data items that have not been
assigned to Bar Height, Line Height, or Bars are assigned to Hidden.
For tips related to hiding data items, see “Tips for Working with Hidden Data
Items” on page 78.

3 When you are done, click OK.
4 (Optional) Save the report.
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Assign Data Items to Functions in a Line Graph

To assign data items to specific functions in a line graph, complete these steps:
1 On the line graph toolbar, click & to open the Graph Data dialog box.

2 Use the Move Items drop-down list to assign each data item to one of these
functions.

Measure Axis
Select the measures that will determine the height of each plot point along the
line. Measure Axis is required. By default, if data has been selected, then the
first measure in the data source is assigned to Measure Axis.

Note: If you assign a category or hierarchy to the Multiple Lines, then
you can only assign one measure to Measure Axis. A

Line (Limit 1)
Select a category or hierarchy, each value of which will be represented by a plot
point on the lines shown in this graph. Line is required. By default, if data has
been selected, then the first category or hierarchy in the data source is assigned
to Line.

Multiple Lines (Limit 1)
You can subdivide the line into several lines, one for each value of the category
or hierarchy that you assign to this function.

Note: If you assign more than one measure to the Measure Axis, then you
cannot add a category or hierarchy to Multiple Lines. A

Horizontal Matrix
You can create separate line graphs for each value of a selected category or
hierarchy. The charts appear side by side. For example, if you select a Gender
category for the horizontal matrix, a chart for each value of Gender is displayed
side by side along a horizontal line.

Vertical Matrix
You can create separate line graphs for each value of a selected category or
hierarchy. The charts appear stacked one on top of the other. For example, if
you select a Gender category for the vertical matrix, a chart for each value of
Gender is stacked along a vertical line.

Hidden
By default, if data has been selected, then all the data items that have not been
assigned to Measure Axis or Line are assigned to Hidden.
For tips related to hiding data items, see “Tips for Working with Hidden Data
Items” on page 78.
3 When you are done, click oK.

4 (Optional) Save the report.

Assign Data Items to Functions in a Pie Chart

To assign data items to specific functions in a pie chart, complete these steps:
1 On the pie chart toolbar, click & to open the Graph Data dialog box.

2 Use the Move Items drop-down list to assign each data item to one of these
functions.

Segment Size
Select the measures that will determine the size of each segment. Segment
Size is required. By default, if data has been selected, then the first measure in
the data source is assigned to Segment Size.
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Note: If you assign a category or hierarchy to the Pie Stacks, then you can
only assign one measure to Segment Size. A

Segments (Limit 1)
Select a category or hierarchy, each value of which will be represented by a
segment. Segments is required. By default, if data has been selected, then the
first category or hierarchy in the data source is assigned to Segments.

Pie Stacks (Limit 1)
You can subdivide the pie chart into a stack of pie charts, one for each value of
the category or hierarchy that you assign to this function.

Note: If you assign more than one measure to the Segment Size, then you
cannot add a category or hierarchy to Pie Stacks. A

Horizontal Matrix
You can create separate pie charts for each value of a selected category or
hierarchy. The charts appear side by side. For example, if you select a Gender
category for the horizontal matrix, a chart for each value of Gender is displayed
side by side along a horizontal line.

Vertical Matrix
You can create separate pie charts for each value of a selected category or
hierarchy. The charts appear stacked one on top of the other. For example, if
you select a Gender category for the vertical matrix, a chart for each value of
Gender is stacked along a vertical line.

Hidden
By default, if data has been selected, then all the data items that have not been
assigned to Segment Size or Segments are assigned to Hidden.
For tips related to hiding data items, see “Tips for Working with Hidden Data
Items” on page 78.

Note: If you hide a category or hierarchy that is being used in a report
linking prompt, then the prompt association is removed. A

3 When you are done, click oK.

4 (Optional) Save the report.

Assign Data Items to Functions in a Progressive Bar Chart

To assign data items to specific functions in a progressive bar chart, complete these
steps:

1 On the progressive bar chart toolbar, click & to open the Graph Data dialog box.

2 Use the Move Items drop-down list to assign each data item to one of these
functions.

Bar Height (Limit 1)
Specify the measure that will be used to determine the height of each bar. Bar
Height is required. By default, if data has been selected, then the first measure
in the data source is assigned to Bar Height.

Bars (Limit 1)
Select a category or hierarchy, each value of which will be represented by a bar.
Bars is required. By default, if data has been selected, then the first category or
hierarchy in the data source is assigned to Bars.
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Horizontal Matrix
You can create separate progressive bar charts for each value of a selected
category or hierarchy. The charts appear side by side. For example, if you select
a Gender category for the horizontal matrix, a chart for each value of Gender is
displayed side by side along a horizontal line.

Vertical Matrix
You can create separate progressive bar charts for each value of a selected
category or hierarchy. The charts appear stacked one on top of the other. For
example, if you select a Gender category for the vertical matrix, a chart for each
value of Gender is stacked along a vertical line.

Hidden
By default, if data has been selected, then all the data items that have not been
assigned to Bar Height or Bars are assigned to Hidden.
For tips related to hiding data items, see “Tips for Working with Hidden Data
Items” on page 78.

3 When you are done, click oK.

4 (Optional) Save the report.

Assign Data Items to Functions in a Scatter Plot

To assign data items to specific functions in a scatter plot, complete these steps:
1 On the scatter plot toolbar, click & to open the Graph Data dialog box.

2 Use the Move Items drop-down list to assign each data item to one of these
functions.

Vertical Axis (Limit 1)
Specify the measure that will be used to determine the height of each marker.
Vertical Axis is required. By default, if data has been selected, then the
second measure in the data source is assigned to Vertical Axis.

Horizontal Axis (Limit 1)
Select the measure that will be used to determine the height of each marker.
Horizontal Axis is required. By default, if data has been selected, then the
first measure in the data source is assigned to Horizontal Axis.

Marker Groups (Limit 1)
Select a category or hierarchy, each value of which will be a set of markers.
Marker Groups is required for multidimensional data sources. If detail data is
being used, then this function groups and colors the data points. If aggregated
data is used, there will be one point for each data value in the category or
hierarchy.

Note: By default, data is aggregated. For information about how to use
detail data, see “Use Detail Data Instead of Grouped and Aggregated Data” on
page 118. A

Marker Size (Limit 1)
Select the measure that will be used to determine the size of each marker.

Note: Users who are authorized to create reports can also use the Markers
tab in the Graph Properties dialog box to specify a marker size that will be
constant for all markers in the graph. A
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Horizontal Matrix
You can create separate scatter plots for each value of a selected category or
hierarchy. The charts appear side by side. For example, if you select a Gender
category for the horizontal matrix, a chart for each value of gender is displayed
side by side along a horizontal line.

Vertical Matrix
You can create separate scatter plots for each value of a selected category or
hierarchy. The charts appear stacked one on top of the other. For example, if
you select a Gender category for the vertical matrix, a chart for each value of
gender is stacked along a vertical line.

Hidden
By default, if data has been selected, then all the data items that have not been
assigned to Vertical Axis or Horizontal Axis are assigned to Hidden.
For tips related to hiding data items, see “Tips for Working with Hidden Data
Items” on page 78.

3 When you are done, click oK.

4 (Optional) Save the report.

Drill or Expand Hierarchies in a Graph

You can perform these tasks on a graph that is based on multidimensional data:

o Click the name of a member at the bottom of the graph, and then select Expand
<member>. You will see the current member and the values for the next hierarchy
level down for that member.

Display 6.7 In the Hierarchy Level 'Catalog,” the Member 'Pets’ Has Been Expanded to Display Values for
the 'Type’ Hierarchy Level

Quantity Ordered
1,200

1,000 4

800

GO0

400

200
0
Catalog| Colectibles

[ Eird [ Cat [ Dog [ Fish ]
Gardening| Pets | Sports

In this example, to undo the expansion, you select Pets and then Collapse
Pets.

o0 Click the name of a member at the bottom of the graph, and then select brill
down on <member>. You will see only the values for the next hierarchy level down
for that member.
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Display 6.8 In the Hierarchy Level *Catalog,” the Member 'Pets’ Has Been Drilled to Display Values for the
‘Type’ Hierarchy Level

Quantity Ordered
300

IYPE| Bird | Cat | Dog | Fish |

In this example, to undo the drilling, you select TYPE, which is the current
hierarchy level, and then Up to Catalog, which is the next hierarchy level up.

Note: You cannot drill or expand an independent progressive bar chart that is based
on a multidimensional data source if the chart includes an initial and final bar. To
enable the functionality, edit the graph properties so that the chart does not include an
initial and final bar. If the progressive bar chart is in a synchronized section and you
drill or expand another report object, then the drilling or expansion also will be applied
to the progressive bar chart. A

Managing Filtering and Ranking in a Graph

Create a Category or Hierarchy Filter for a Graph

To create a category or hierarchy filter, complete these steps:

1 On the graph toolbar, click &%, and then select Filter and Rank to open the
Filter and Rank dialog box.

2 Click the category Filters tab.

3 Select a category or hierarchy in the Item, Filter list. This field displays the
categories and hierarchies that are used in the graph along with any currently
active filters.

Note: The list does not include categories and hierarchies that are assigned to
group breaks. A

Note: Data item names might wrap multiple lines. A

4 Select a Filter type.

5 (Optional) If the selected data item is classified as a character data type and it is
not using the default format, then you can select the Filter on formatted
values option. In this case, formatted values will be used in all parts of the
current filter query.
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Note: If the selected data item is using the default format and this option is
selected (which might be the true for reports that were created with a previous
version of SAS Web Report Studio), then clear this option to improve query
performance. Leave the option selected, however, if you cannot produce the desired
results by using unformatted values. A

6 Depending on your filter type selection, take the appropriate action as described in
Table 6.2 on page 53.

7 When you are done, click OK.

8 (Optional) Save the report.

Note: For a summary of filtering tips, see “Tips for Filtering and Ranking Tables,
Graphs, and Maps” on page 77. A

Create a Measure Filter for a Graph

Note: The Measure Filter or Rank tab is not available if the graph is part of a
synchronized group. A
To create a measure filter, complete these steps:

1 On the graph toolbar, click &%, and then select Filter and Rank to open the
Filter and Rank dialog box.

Click the Measure Filter or Rank tab.
Select the Filter a measure option.
In the show values of drop-down list, select an option.

ol B N

Depending on your Show values of selection, specify the criteria for the filter.

Table 6.5 Filter Criteria Options for Each Graph Type

Graph Type

Show Value Selection

Criteria

Bar chart or
progressive bar
chart

Bar-line chart

Line graph

Pie chart

Scatter plot

The category or hierarchy
that is assigned to the
bars function.

The category or hierarchy
that is assigned to the
bars function

The category or hierarchy
that is assigned to the
lines function

The category or hierarchy
that is assigned to the
segments function.

The category or hierarchy
that is assigned to the
optional marker group
function.”

Select the measure that is assigned to the bar height
function. Then, select an Operator and type a Value.

Select the measure that is assigned to the bar height function
or the measure that is assigned to the line height function.
Then, select an Operator and type a Value.

Select the measure that is assigned to the measure axis
function. Then, select an Operator and type a Value.

Select the measure that is assigned to the segment size
function. Then, select an Operator and type a Value.

Select the measure that is assigned to the vertical axis
function or the measure that is assigned to the horizontal
axis function. Then, select an Operator and type a Value.

1 Do not include a currency symbol in the Value field. In addition, enter values in the number format that is
appropriate for the locale that is set for the browser.
2 If no category or hierarchy is assigned to the marker group function, then you cannot create the filter.

6 When you are done, click oK.

7 (Optional) Save the report.
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Note:

If the current filtering choices are not acceptable, you can use the Graph Data

dialog box to assign data items to different functions. A

Note:
Graphs, and Maps” on page 77. A

Create a Ranking for a Graph

Note:
synchronized group. A

For a summary of filtering tips, see “Tips for Filtering and Ranking Tables,

The Measure Filter or Rank tab is not available if the graph is part of a

To create a ranking for a measure in a graph, complete these steps:
1 On the graph toolbar, click &%, and then select Filter and Rank to open the

Filter and Rank dialog box.

Click the Measure Filter or Rank tab.

Select the Rank a measure option.

In the show field, select Top or Bottom, and then type a value next to the option

that you chose.

5 (Optional) Choose one of these options:

0 To evaluate the data as a percentage, select the percent (%) option, and then

enter a value.

Note:

This option is not available for relational data sources. A

o0 To exclude tied rankings, select the Exclude ties option. For example, by
default, if you request the top five products and there are three products tied for
fifth place, then seven products are returned. If you select the Exclude ties
option, then only five products are returned.

In the show values of drop-down list, select an option.

7 Depending on your Show values of selection, specify the criteria for the ranking.

Table 6.6 Ranking Criteria Options for Each Graph Type

Graph Type Show values of Selection

Based on Values of Criteria

Bar chart or The category or hierarchy that
progressive bar

chart

is assigned to the bars
function.

Bar-line chart The category or hierarchy that

is assigned to the bars

function

Line graph The category or hierarchy that
is assigned to the lines
function

Pie chart The category or hierarchy that

is assigned to the segments
function.

Scatter plot The category or hierarchy that
is assigned to the optional

. 1
marker group function.

Select a measure that is assigned to the bar height
function.

Select a measure that is assigned to the bar height
function or the measure that is assigned to the line
height function.

Select a measure that is assigned to the measure axis
function.

Select a measure that is assigned to the segment size
function.

Select a measure that is assigned to the vertical axis
function or the measure that is assigned to the
horizontal axis function.

1 If no category or hierarchy is assigned to the marker group function, then you cannot create the ranking.

8 When you are done, click OK.
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9 (Optional) Save the report.

Note: For a ranking example, see “Example 3: Ranking a Bar Chart Based on
Multidimensional Data” on page 210. A

Note: If the current ranking choices are not acceptable, you can use the Graph Data
dialog box to assign data items to different functions. A

Note: For a summary of ranking tips, see “Tips for Filtering and Ranking Tables,
Graphs, and Maps” on page 77. A

Remove a Filter or Ranking from Graph

To remove a filter or ranking from a graph, complete these steps:

1 On the graph toolbar, click &%, and then select Filter and Rank to open the
Filter and Rank dialog box.

2 Remove category and hierarchy filters, measure filter, or ranking as described next:

0 On the category Filters tab, for each data item that should not be filtered,
select No filter as the Filter type.

O On the Measure Filter or Rank tab, select No measure filter or rank.
3 When you are done, click oK.
4 (Optional) Save the report.

View Graph Information

To display information about a graph, click [ ona graph toolbar. The Graph
Information dialog box contains the following information:

Data source
This section contains the following information:

Name
This field displays the name of the data source that is being used for this
graph.

Type
This field displays the type of data source (Relational or
Multidimensional). The data source type determines which options are
available for building and viewing reports.

Description
This field displays a description of the data source, if one is available.

Applied filters
This field displays the following information:

o0 The filters that are applied to the current report section. These filters affect
all of the graphs in this section.
o The filters and the rankings that are applied just to this graph.

0 The expression that specifies how the filters and rankings are applied.

Data item, Physical Name, Description/Expression
For each data item in this graph, this box lists the name of the data item as it
appears in the data source that was prepared by the data source administrator,
the name of the data item in the original data source, and either a description
(standard data items) or an expression (calculated data items).
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Note: You can modify report properties so that filter information is displayed along
with the report. For more information, see “Set or Modify Properties for a Viewed
Report” on page 99. A

Working with Maps

Drill or Expand the Geography Hierarchy in a Map
You can perform these tasks on a map to drill or expand the geography hierarchy:

o Click *] and then click a colored map region (which is a member in the currently
displayed geography hierarchy level). The map will be redrawn to display the
regions (members) for the next hierarchy level down while keeping the context of
the current hierarchy level. The legend on the right side of the map changes to
display the values for the expanded region.

Display 6.9 In the Hierarchy Level 'US Regions,” the Member 'West N. Central’ Has Been Expanded to
Display Values for the 'State’ Hierarchy Level

Sum Of Sales |

[[s0 - $60,000

[ $60,000 - $120 000
[ #120,000 - 180,000
[ 180,000 - g24n,000
[ $240,000 - y300,000

0 Click [=] and then click an expanded region in order to collapse the expanded
region.

o Click and then click a colored map region (which is a member in the currently
displayed geography hierarchy level). The map will be redrawn to display the
regions (members) for the next hierarchy level down. The legend on the right side
of the map will change to display the values for drilled region.

Display 6.10 In the Hierarchy Level "US Regions,” the Member 'West N. Central’ Has Been Drilled to Display
Values for the ’State’ Hierarchy Level

8 |Sum Of Sales B

' Mo 50,000

L8| [ so0000 - 9120000
= 120,000 $180,000
[ %150,000 - $240,000
| [D3¥290,000 - $300,000

o Click Ll to remove the last drill-down action that you performed.
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Managing Filtering and Ranking in a Map

Create a Filter for the Geography Hierarchy in a Map
To create a filter for the geography hierarchy in a map, complete these steps:

1

On the map toolbar, click &%, and then select Filter and Rank to open the Filter
and Rank dialog box.

2 Click the category Filters tab.
3 In the Item, Filter list, select the geography hierarchy. This field displays the

geography hierarchy along with any currently active filters.
In the Filter type drop-down list, select Select category values.

Select items in the Select filter values list. You can select and deselect items
individually, or you can use the Select All or Deselect All buttons.

When you are done, click OK.
(Optional) Save the report.

Create a Measure Filter for a Map

Note: The Measure Filter or Rank tab is not available if the map is part of a
synchronized group. A

To create a measure filter, complete these steps:

1

O 00 N o o A N

On the map toolbar, click %, and then select Filter and Rank to open the Filter
and Rank dialog box.

Click the Measure Filter or Rank tab.

Select the Filter a measure option.

In the show values of drop-down list, select the geography hierarchy.
Select the Measure that is being used in the map.

Select an Operator.

Type a value. (Do not include the currency symbol.)

When you are done, click OK.

(Optional) Save the report.

Note: For a summary of filtering tips, see “Tips for Filtering and Ranking Tables,
Graphs, and Maps” on page 77. A

Create a Ranking for a Map

Note: The Measure Filter or Rank tab is not available if the map is part of a
synchronized group. A

To create a ranking for the measure used in a map, complete these steps:

1

On the map toolbar, click &%, and then select Filter and Rank to open the Filter
and Rank dialog box.

2 Click the Measure Filter or Rank tab.

3 Select the Rank a measure option.

4 In the show field, select Top or Bottom, and then type a value next to the option

that you chose.

(Optional) Choose one of these options:
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o To evaluate the data as a percentage, select the percent (%) option, and then
enter a value.

0 To exclude tied rankings, select the Exclude ties option. For example, by
default, if you request the top five geographic areas for total revenue and there
are three areas tied for fifth place, then seven geographic areas are shown on
the map. If you select the Exclude ties option, then only five geographic areas
are shown on the map.

In the show values of drop-down list, select the geography hierarchy.
Select the Measure that is being used in the map.

When you are done, click oK.

O 00 N o

(Optional) Save the report.

Note: For a summary of ranking tips, see “Tips for Filtering and Ranking Tables,
Graphs, and Maps” on page 77. A

Remove a Filter or Ranking from a Map

To remove a filter or ranking from a map, complete these steps:

1 On the map toolbar, click 3%, and then select Filter and Rank to open the Filter
and Rank dialog box.

2 Remove the geography hierarchy filter, measure filter, or ranking as described next:

0 On the category Filters tab, select the geography hierarchy, and then select
No filter.

O On the Measure Filter or Rank tab, select No measure filter or rank.

3 When you are done, click OK.
4 (Optional) Save the report.

Change the Measure Used in a Map

To change the measure used for a viewed map, select the new measure in the
drop-down list located in the map legend.

View Information ahout a Selected Region

To view information about a selected region on a map, complete these steps:
1 On the map toolbar, click k' and then click a map region.
2 In the Region Information dialog box, view the details.

In addition to details about the underlying data, such as field names and
values, this dialog box displays the name and aggregated value for the measure
currently being used.

3 When you are done, click Close.

Zoom and Pan a Map

In order to focus in on a specific map area or zoom in or out on a selected region,
click these buttons on the map toolbar.
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Button Action

&k zooms in on a selected area. Click and drag the mouse pointer to select the area that
you want to zoom in on.

zooms out from a point. Click a point on the map to zoom out and center on that point.

Q?TF' moves the map content within the viewing area. Click and drag the map until the
viewer shows the area that you want to see.

-
i

(]

resets the zoom level to undo any zooming or panning that has been done.

r
“a

Managing the Data Used for Synchronized Report Sections

About Synchronized Reports

For report sections that use data items from a data source, report objects can be
synchronized. Synchronized tables and graphs will share category or hierarchy filters,
sorting (but not prioritizing), drilling, and expanding. Tables, graphs, and maps will
share filters, drilling, and expanding.

Synchronized objects are grouped within a shaded box, and the report is displayed
with a data pane that can be used to modify the data selections.

Display 6.11 Example of a Synchronized Report

¥ Dataselected from:  OrionGoldCube

B f | i
Order Channel Retail Sale Catalog Sale Internet Sale
Total Costsum Total Costsum Total Costsum
Customer Type
Orion Club Gold members high activity $4,036,120.65 $358,242.85 $301,705.15
Orion Club Gold members low activity §1,705,037.50 $201 537 60 $166,619.50
B & | £
Customer Type Total Costsum
$5,000,000.00 -
$4,000,000.00
Crion Cluly Goled members high activity $3,000,000.00
$2,000,000.00 -
$1,000,000.00
$0.00
$5,000,000.00
$4,000,000.00 -
Crion Cluly Gold members low activity $3,000,000.00
$2,000,000.00
$1,000,000.00
$0.00 .

Order Channel | Retail Sale |Catalog Sale|Internet Sale
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Display 6.12 Expanded Data Pane for the Synchronized Report Showing the Default Data Item Assignments

# Data selected from:  OrfonGoldCube

Available data items: Selected data items: Category headers:

g’ Total Costsum = BiChannel — Columns Rows Hidden =

--§9Total Salessum Ecustomers )
Channel » | | Total Castsum Channel ® L] 3]
-Customers = Customers @] @® ]

- Demographics

Apply Clear Defaults

Change Which Data Items Are Used for the Section Query

You can use the data pane to change which data items are used in the section query.
To change which data items are used, use the arrow buttons to move data items into
and out of the Selected data items list box.

Here are some consequences of removing data items:

o If you remove a custom data item, then that data item will no longer be available

to use in the report.

0 If you remove a time hierarchy, then any custom data items that are based on time
functions are removed from all objects in the report section.

o If you remove the geography hierarchy, then any map in the section will become
invalid.

o If you remove a category or hierarchy that is being used in a report linking
prompt, then the prompt association is removed.

0 If you remove a measure that is being used with a group break or in a text object,
then the measure information is removed from the report section. For example, if
you included Profit with a group break for Product, then the Profit
information would be removed.

After you make a change, click Apply to see the change reflected in the report. To
undo changes before you click Apply, click Clear.

Note: To expand the data pane, click ¥ . To collapse the data pane, click #. A

Change How Data Items Are Used in Tables and Graphs

You can use the data pane to change how categories and hierarchies are used in tables
and graphs. The only assignment change that you can make that affects maps is to hide
the geography hierarchy; however, if you do that, then the map will become invalid.

To change how categories and hierarchies are used in tables and graphs, select an
option next to the category or hierarchy name. Here are some guidelines:

Option Table Function Graph Functions

Columns Columns Bars, pie segments, lines, and markers, and also
as the horizontal matrix

Rows' Rows in crosstabulation tables Vertical matrix

Hidden None None

1 If the report contains only list tables, then the Rows option is disabled.
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For tips related to hiding data items, see “Tips for Working with Hidden Data Items”

on page 78.
To use default assignments as determined by SAS Web Report Studio, click befaults.

After you make a change, click Apply to see the change reflected in the report. To
undo changes before you click Apply, click Clear.

Note: To expand the data pane, click ¥ . To collapse the data pane, click #. A

About Mixed States for Categories and Hierarchies

If all tables, graphs, and maps in the report are using a category or hierarchy in the
same way, then the radio button for the assigned option is green. If a category or
hierarchy has one assignment in a table, graph, or map and a different assignment in
another table, graph, or map, then the options in the data pane reflect a mixed state. In
a mixed state, all assignments for the category or hierarchy are indicated but the radio

buttons contain a gray dash.
As an example, assume that a synchronized report contains one crosstabulation table

and one bar chart, and that the following data assignments exist:

0 In the crosstabulation table, the categories State and Product Category are
assigned to the columns, and the categories Country and Year are assigned to the
TOws.

O In the bar chart, the category State is assigned to the bars function, and the
categories Country, Product Category, and Year are hidden.

The data pane would appear like this:

Display 6.13 A Data Pane in a Synchronized Report That Reflectsa Mixed State

% Dataselected from:  JrionStar

Available data items: Selected data items: Category headers:

Columns Rows Hidde

E |4 Geography = B State

B Country
B Product Category State
B vear

Country

yﬁm\g Quantity Ordered
@ﬁ?Tntal Quantity Orderec

4

1+

Product Category
Year

ceo®fl

Apply

Clear

Defaults

A mixed state can occur when you use individual data dialog boxes to set category or
hierarchy assignments for a table or graph. However, you cannot create a mixed state by
selecting radio buttons in the data pane. In the previous example, if you select the Rows
option for Product Category, the Hidden option is cleared and the Rows option becomes
green. If you click Apply, the bar chart will use Product Category as the vertical matrix.
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Tips for Filtering and Ranking Tables, Graphs, and Maps

Here are some tips for filtering and ranking tables, graphs, and maps:

Filter Creation

o If you are filtering on unformatted values, then you must enter values that match
the casing of the values in the data source. If you select the Filter on
formatted values option, then you must enter the formatted values. If the filter
does not return any results, then try using a different casing.

0 When filtering dates, times, and timestamps in tables and graphs, you have the
option to specify time periods such as days, weeks, months, and years. When SAS
Web Report Studio counts by these time periods, it treats each period as a unit
and begins counting from the beginning of the specified period type in which the
current date falls. For example, if you use Months as the period type, SAS Web
Report Studio counts the specified number of whole months from the current
month, regardless of where the current date falls within the current month.

Here are two examples that illustrate how time periods are counted in this type
of filter.

0 Today is December 20, 2005, and you want to filter a table so that it includes
sales that were posted before three months ago. If you use Months as the period
type, the table will include data from sales that were posted prior to September
1, 2005. This is because SAS Web Report Studio counts back three whole months
from the current month and returns data before the first day of that month. In
order to filter the table so that it includes sales that were posted prior to 90
days before December 20, 2005, use Days as the period type. If you specify 90
days, the table will include sales that were posted prior to September 21, 2005.

o Today is December 20, 2005, and you want to filter a graph so that it includes
employees who were born before 10 years ago. If you use Years as the period
type, the graph will include employees who were born prior to January 1, 1995.
This is because SAS Web Report Studio counts back 10 whole years from the
current year and returns data before the first day of that year. In order to filter
the graph so that it includes employees who were born prior to 3650 days (365 *
10) before December 20, 2005, use Days as the period type. If you specify 3650
days, the graph will include employees who were born prior to December 23,
1995.

Filter Application

o Category and hierarchy filters are applied before rankings and measure filters.

0 When you are creating time or date filters, the filter is relative to the time that the
section query is generated, not to the time that the filter is imposed on the table or
graph.
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Filter Restrictions

You cannot create measure filters or rankings if the report section is synchronized.

You cannot create filters that use categories and hierarchies that are assigned to
group breaks.

You cannot filter on percent of total values.
You cannot create a percentage ranking for relational data.

For relational data sources, the availability of the Select category values filter
type is controlled by your data administrator.

For scatter plots, you cannot create a measure filter or ranking if there is no
category or hierarchy assigned to the optional marker group function.

Consequences of Changing Data

0 Here are some filtering consequences of moving data items to different functions in

a crosstabulation table:

o If you add or hide a category or hierarchy column, then any row filters and
rankings that are based on a column measure are removed. Filters are not
affected by adding or hiding measures.

o If you add or hide a category or hierarchy row, then any column filters and
rankings that are based on a row measure are removed. Filters are not affected
by adding or hiding measures.

O Filters are retained if you move all the data items that are currently on rows to
the columns and move all the data items that are currently on the columns to
the rows. In this case, any existing filters will remain and be evaluated based
on the new positions.

For crosstabulation tables, if you add a percent of total column or remove a
percent of total column, then any row filters and rankings that are based on a
column measure are removed.

Tips for Working with Hidden Data Items

Here are some tips related to assigning data items to the Hidden function in the
Table Data dialog box, the Graph Data dialog box, the Map Data dialog box, and in the
data pane of a synchronized report.

0 Most data items that are hidden can be used in filters and rankings. However, a

crosstabulation table measure filter or ranking that is based on a category or
hierarchy that is located on the outermost column or the outermost row is removed
if the category or hierarchy is hidden. This is because the filter or ranking is tied
to the location of the data item. If the data item is removed from that location,
then the filter or ranking is also removed.

Data items that are selected for group breaks are automatically hidden. You
cannot assign the data items to different functions.

If you hide the geography hierarchy in a report section that contains a map, then
the map will become invalid.
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If you hide a category that is being used in a report linking prompt, then the
prompt association is removed.

If you hide a data item that is being used in a conditional highlighting rule, then
the conditional highlighting rule is removed from the table or graph.

If you hide a time hierarchy, then any custom data items that are based on
relative time are also hidden.

If you hide a data item that is being used in a sort, then the list table or graph is
resorted but the sorting information is saved with the data item. Here are some
additional details:

o If the hidden data item was the only sorted column, then the list table or graph
is resorted to use its defaults as determined by the underlying data source. If
you reassign the hidden data item to a function in the table or graph, the sort
will be restored.

o For list tables, if the hidden data item is, for example, the first out of three
sorted columns, then the table is resorted so that the second sorted data item
becomes the first priority and the third sorted data item becomes the second
priority. If you reassign the first sorted data item to the Columns function, then
the reassigned data item becomes the third priority in the sort.

You cannot hide a category that is being used in a percent of total calculation.
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Overview of Changing the Presentation of a Viewed Report

In each report section that contains query results from a data source, you can use the
View Report view to make changes to the default presentation. Here are some of the
changes that you can make:

0 add or modify conditional highlighting
O sort
move columns and rows in tables

O

change table, graph, and map properties such as size and colors

O o

hide or display filter information
O change the report style

Note: 1If the report was saved as manually refreshed, then you must refresh the
report in order to make changes. A

Note: For more information about the View Report view, see “About the View Report
View” on page 27. A

Note: Only authorized users can save changes to reports. If you have questions
about your authorization, contact your system administrator. A

Working with Tables

Managing Conditional Highlighting for Table Values

About Conditional Highlighting for Multidimensional Data

In general, there are two types of rules that you can create:

0 Rules that compare a measure to a fixed value. For example, you might create a
rule for Sales > 1000.

0 Rules that compare one measure value relative to another measure value. For
example, you might create a rule for Sales > Budget.
SAS Web Report Studio processes these rules in the following ways:

o For the first type of rule, the condition is applied at the current level of the data
source. For example, if you drill down into the data and then specify conditional
highlighting, then the condition applies to the level that is currently displayed.

o0 For the second type of rule, the condition is applied at all levels of the data source,
regardless of the current level.

Add Conditional Highlighting to Table Values

To specify conditional highlighting for values in a table, complete these steps:

1 On the table toolbar, click £%, and then select Conditional Highlighting to
open the Conditional Highlighting dialog box.
2 Click New.

Three tabs appear in the Conditional Highlighting dialog box: Rules, Color
and Font, and Image and Text.
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3 On the Rules tab, complete these steps:

a Select a Measure.

/A Managing Conditional Highlighting for Table Values

b Select the Condition that you want the selected measure to match.

¢ In the value field, type in a value or select a measure in the drop-down list. If
you selected Is between as the condition, then type a Min value and Max
value. If you select Is missing value as the condition, then this field is
unavailable.

Note:

values above 50%, enter .5 as the conditional value.

83

If you are creating a condition for percentages, you must enter the
conditional value as a decimal number. For example, if you want to filter for

A

4 (Optional) On the Color and Font tab, complete these steps to change the default

settings:

a Select a Fill color that you want to use to highlight values that meet the
specified condition.
b Select the Font, including the font size and font color, that you want to use to
highlight values that meet the specified condition.
¢ Select the Font style that you want to use to highlight values that meet the
specified condition.

5 (Optional) On the Image and Text tab, complete these steps:

a Select the Highlight by adding an image or text option.
b Indicate whether you want to Add an Image or Text when the specified
conditions are met.
¢ Specify a Position for the image or text. Indicate whether you want the image
or text to appear to the right or left of each cell that contains a value that meets
the condition, or in place of the value.
d If you are using an image, select the Image that you want to use to highlight
values that meet the specified condition.
e If you are using text, type the text into the Text field, and then enter Font and
font style information.

6 To hide the tabs, click OK.
7 To close the Conditional Highlighting dialog box, click OK.

8 (Optional) Save the report.

Display 7.1 Revenue Values That Are Greater Than $12,000 Are Highlighted

Gender Female Male
Revenue Units Sold | Total Cost Revenue Units Sold | Total Cost
Product Group | (rder Channel
Retail Sale $118,570.46 ¥ 1422 | $53175 | $143,480.87 ¥ 1,733 | §84,235
Leisure Catalog Sale $10,522 .08 132 §4,735 | $12,846.90 v 155 §5,752
Internet Sale | §10975.30 132 $4,909 |  $9,254.90 16 F4.143
Retail Sale $142,186.92 ¥ | 1956 | $59.989 | $177,626.03 ¥ 253 | §74026
Street Wear | Catalog Sale $12,563.95 v 154 $5,534 | $18,396.01 v 257 7 756
Internet Sale | 10 794 28 150 4563 | $12.646.70 ¥ 198 $5,292
Note: Highlighting conditions are evaluated based on raw values. The use of raw

values affects how conditions are applied to rounded values. For example, in your table,
you have formatted product prices so that they are rounded up or down. The actual cost
of a pair of Eclipse running shoes is $49.65. In the table, the $49.65 price is rounded up
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to $50. If you specify that you want to highlight all products that cost less than $50, the
Eclipse running shoes are highlighted because their actual price is less than $50. 2

Modify Conditional Highlighting for Tahle Values

To modify conditional highlighting for values in a table, complete these steps:

1 On the table toolbar, click £%, and then select Conditional Highlighting to
open the Conditional Highlighting dialog box.

2 In the Rules list, select a rule.
3 Click Edit.

4 Make your changes on the Rule tab, the Color and Font tab, and the Image and
Text tab, and then click OK.

Note: For information about using the tabs, see “Add Conditional Highlighting to
Table Values” on page 82. A

5 To hide the tabs, click oK.
6 To close the Conditional Highlighting dialog box, click OK.
7 (Optional) Save the report.

Remove Conditional Highlighting from Table Values

To remove conditional highlighting from table values, complete these steps:

1 On the table toolbar, click &%, and then select Conditional Highlighting to
open the Conditional Highlighting dialog box.

In the Rules list, select a rule.
Click pelete.
In the confirmation message box that appears, click ok to delete the rule.

When you are done, click oK.

S O AW N

(Optional) Save the report.

Managing Sorting for Tables

Sort Data in a Table

To sort individual columns in a table, complete these steps:

1 Click the heading of the column that you want to sort, and then select Sort
Ascending or Sort Descending.

2 (Optional) Save the report.
For list tables, when you use this method to sort columns, the sort priority is in
reverse selection order. For example, if you select Order Year descending, then Product

Name ascending, and then Couniry ascending, the priority will be Country, then
Product Name, then Order Year.

Specify a Sort and a Sorting Priority in a List Table

Another way to specify a sort and a sorting priority for columns a list table is to use
the Sort dialog box. Complete these steps:

1 On the list table toolbar, click %, and then select Sort to open the Sort dialog box.
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Note: The Sort option is not available for list tables that are in a synchronized
group. A

2 Select a column in the drop-down list to specify the initial sort, and then choose to
sort in Ascending or Descending order.

3 To sort additional columns in order of priority, select each column in the Then by
field. There will be one Then by field for each column in the table.

4 When you are done, click oK.
5 (Optional) Save the report.

Moving Columns and Rows in Tables

Move a Category or Hierarchy Level from a Column to a Row or from a Row
to a Column

In a crosstabulation table, to move a category or hierarchy level column to a row or a
row to a column, complete these steps:

1 Click a category or hierarchy level heading in the table, and then select Move
<column name> to Rows Or Move <row name> to Columns.

The table is redisplayed with the row or column moved into its new position.
2 (Optional) Save the report.

Note: You also can use the Table Data dialog box to move data items (see
“Specifying How Data Items Are Used in Tables” on page 49). A

Move a Table Column to the Left or Right

To move a table column to the left or right, complete these steps:

1 Click the heading of the column that you want to move, and then select Move
<column name> Left or Move <column name> Right.

The table is redisplayed with the column moved into the position that you
specified.

Note: Sometimes a move to the left or right is not valid, depending on the current
location of the column. A

2 (Optional) Save the report.

Move Measures from Rows to Golumns or from Columns to Rows

In a crosstabulation table, measures that are not hidden must be either all on the
rows or all on the columns. To move measures from rows to columns or from columns to
rows, complete these steps:

1 Click a measure heading in the table, and then select Move Measures to Rows or
Move Measures to Columns.

The table is redisplayed with the measures moved into their new position.

2 (Optional) Save the report.

Note: You also can use the Table Data dialog box to move data items (see
“Specifying How Data Items Are Used in Tables” on page 49). A
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Move a Row Up or Down

In a crosstabulation table that has more than one row, to move a specific row up or
down, complete these steps:

1 Click a row heading in the table, and select Move <row name> Up or Move <row

name> Down.

The table is redisplayed with the row moved into its new position.

2 (Optional) Save the report.

Rotate a Crosstahulation Table

To rotate a crosstabulation table so that the columns are moved to the rows and the
rows are moved to the columns, complete these steps:

1 Click a row or column heading in the table, and then select Rotate Table.

2 (Optional) Save the report.

Note:

“Specifying How Data Items Are Used in Tables” on page 49). A

Display 7.2 Before Rotation: The Measures and the Category Gender Are on the Columns

You also can use the Table Data dialog box to move data items (see

Gender Female Male
Revenue (Units Sold|Total Cost| Revenue (Units Sold [Total Cost
Product Group |Order Channel
Retail Sale  |§115574.45 1422|  $53,175 |$143 46987 1733 364235
Leisure Catalog Sale $10,522.08 132 $4.738 | $12,54690 155 $5,752
Internet Sale | 31097530 132 $4909| $9,254490 115 4,143
Retail Sale $142 186 .92 1,956  $59,959 |$177 526.03 2536  §74.926
Street Wear  |Catalog Sale | §12563.495 154 $5,334 | $15,396.01 257 §7 756
Internet Sale | 310794 28 150 $4,563 | 1264670 195 §5,202
Display 7.3 After Rotation: The Measures and the Category Gender Are on the Rows
Product Group Leisure Street Wear
Order Channel |Retail Sale | Catalog Sale |Internet Sale [Retail Sale [Catalog Sale |Internet Sale
Gender
Revenue |(§11557446| $1052208| $10975.30|$14218692| $12,56395| §10,794.28
Female |Units Sold 1,422 132 132 1,956 154 150
Total Cost| 353175 $4,735 4,909 $59,959 5,334 4 563
Revenue |(§14343987| $12,846.90 $9,254 90 [F177 62603 | $153965 01 §12 54670
Male |Units Sold 1,733 155 116 2 536 257 196
Total Cost $54,235 5,752 $4,143 §74 926 §7 756 5,292

Set Properties for a Tahle

To set the properties for a table, complete these steps:
1 On the table toolbar, click & to open the Table Properties dialog box.

2 Confirm or select the Table type. Your choices are List or Crosstab. If your
data source is multidimensional, then you must choose Crosstab.
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Note: A crosstabulation table requires at least one category or hierarchy and one
measure. A

Note: Not all data items are supported in crosstabulation tables that are based
on relational data. For example, if you change a list table to a crosstabulation
table, then any measures that use the distinct aggregation type are removed. That
is, they will not appear in the Table Data dialog box. A

3 On the General tab, complete these steps:

a If you want a Title to appear above the table, type the text, and then set the
font, font size, font style, alignment, and color. You cannot use these characters:
<>¢& #

b Select one of these options for displaying columns in the table:

Show all columns (up to system limit)
Select this option to display all columns in the table, up to the system limit
(which is managed by your system administrator). If necessary, the table will
scroll to the right.

Limit the number of columns displayed at once
Select this option and type a value in the box to specify the number of
columns that you want to view before scrolling is enabled.

Note: If you type a value that is the same as the current system limit,
then, when you reopen this dialog box, the Show all columns (up to
system limit) option will still be selected. A

Set a fixed table width
Select this option to specify a minimum fixed size in pixels for the table.

Note: In the View Report view, you also can use your mouse to manually resize
table columns. A

¢ Select one of these options for displaying rows in the table:

Show all rows (up to system limit)
Select this option to display all rows in the table, up to the system limit
(which is managed by your system administrator). If necessary, the table will
scroll down.

Limit the number of rows displayed at once
Select this option and type a value in the box to specify the number of rows
that you want to view before scrolling is enabled.

Note: If you type a value that is the same as the current system limit,
then, when you reopen this dialog box, the Show all rows (up to system
limit) option will still be selected. A

d Select a Border color for the table.

4 On the Text tab, complete these steps:

a Select style properties for the Headings in the table. (Headings are the
category, hierarchy level, and measure labels, for example, Year, Sales.) You can
set font, font size, color, and alignment. You also can select a Background f£ill
for the heading cell.

b Select style properties for the Subheadings in the table. (Subheadings are the
values, for example, 2000, 2001 might be values for a Year category.) You can
set font, font size, color, and alignment. You also can select a Background f£ill
for the subheading cell.

Note: This option is not available for list tables. A
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5

¢ Select style properties for the cells in the table. You can set font, font size, and
color. You also can select a Background £ill for the cells.

On the Total tab, complete these steps:
a Select a font, font size, style, and color for Totals. You also can select a
Background £ill color for the cells that contain the total values.

b Select a font, font size, style, and color for Subtotals. You also can select a
Background £ill color for the cells that contain the subtotal values.

Note: This option is not available for list tables. A

Note: Any user can choose to show or hide totals (see “Show or Hide Totals in a
Table” on page 58). A

(Optional) If the report section has more than one table, select the Apply
formatting to existing tables in the section option to apply the following
settings to all of the tables:

O total and subtotal style settings
0 heading, subheading, and cell style settings
O title style settings and border color

7 When you are done, click OK.

8 (Optional) Save the report.

Working with Graphs

Managing Conditional Highlighting for Graph Values

Add Conditional Highlighting to Graph Values
To specify conditional highlighting for values in a graph, complete these steps:

1

On the graph toolbar, click (%, and then select conditional Highlighting to
open the Conditional Highlighting dialog box.

2 Select a Measure.

3 Select the Condition that you want the selected measure to match.

4 In the value field, type in a value or select a measure in the drop-down list. If you

selected Is between as the condition, then type a Min value and Max value. If
you select Is missing value as the condition, then this field is unavailable.

Note: If you are creating a condition for percentages, you must enter the
conditional value as a decimal number. For example, if you want to filter for
values above 50%, enter .5 as the conditional value. A

5 When you are done, click oK.

6 (Optional) Save the report.
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Display 7.4 Product Groups with Revenues That Are Greater Than $1 Million Are Highlighted

Revenue
$2,000,000.00

$1,500,000.00

$1,000,000.00

$500,000.00

$i0.00

Eclipse Shoes Tracker Shoes
Product Group

Gender

OF [COwm

Note: Highlighting conditions are evaluated based on raw values. The use of raw
values affects how conditions are applied to rounded values. For example, in your graph,
you have formatted product prices so that they are rounded up or down. The actual cost
of a pair of Eclipse running shoes is $49.65. In the graph, the $49.65 price is rounded
up to $50. If you specify that you want to highlight all products that cost less than $50,
the Eclipse running shoes are highlighted because their actual price is less than $50. 2

Modify Conditional Highlighting for Graph Values

To modify conditional highlighting for values in a graph, complete these steps:

1 On the graph toolbar, click (%, and then select Conditional Highlighting to
open the Conditional Highlighting dialog box.

2 Make your changes.

Note: For information about using the Conditional Highlighting dialog box, see
“Add Conditional Highlighting to Graph Values” on page 88 A

3 When you are done, click oK.

4 (Optional) Save the report.

Remove Conditional Highlighting from Graph Values

To remove conditional highlighting from graph values, complete these steps:

1 On the graph toolbar, click (%, and then select Conditional Highlighting to
open the Conditional Highlighting dialog box.

2 Click clear.
3 When you are done, click oK.

4 (Optional) Save the report.
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Managing Sorting for Graphs

Sort Ascending or Descending

Click the name of a category or hierarchy level in a graph, and then select either
Sort Ascending or Sort Descending.
If you are authorized, you can save the sort.

Sort by Measure Values

Click the name of a category or hierarchy level in the graph in order to sort the
category or hierarchy level by the values of the measure used in the graph. If the graph
has more than one measure, you can choose which one to sort by.

For scatter plots, you also can sort the measure that is assigned to the horizontal
axis by the values of the measure that is assigned to the vertical axis.

If you are authorized, you can save the sort.

Display 7.5 Before Sorting: A Bar Chart with the Sort Menu Expanded for the Continent Category

Revenue
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Display 7.6 After Sorting: The Same Bar Chart with the Continent Category Sorted Descending by Revenue
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Managing Properties for Graphs

Set Properties for a Bar Chart

To set the properties for a bar chart, complete these steps:
1 On the bar chart toolbar, click & to open the Graph Properties dialog box.
2 On the General tab, complete these steps:

a If you want a Title to appear above the bar chart, type the text, and then set
the font, font size, font style, alignment, and color. You cannot use these
characters: < > & #

b For Graph size, select one of these options:

Automatic (Adjust to fit data)
Select this option to produce a graph that best fits the size of the current
window.
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¢
d
e

Fixed size
Select this option if you want to specify a fixed size for the graph. From the
drop-down list, choose Small, Medium, Large, or Custom. If you select
Custom, type the width and Height pixel values. The maximum width is
1600 pixels. The maximum height is 1200 pixels.

Note: You also can resize the graph by using your mouse. Point to the
bottom right corner or to the bottom or right border. When the pointer
becomes a diagonal or horizontal bar, drag the graph to the new size and
then release the mouse button. A

Select a Background color for the graph.
Select a Border color for the graph.
Select a color for the Grid lines.

3 On the Bar tab, complete these steps:

a

b

For the orientation, specify whether you want to use Vertical bars or
Horizontal bars.

For the subgroup (if applicable), specify whether you want to display Stacked
bars or Clustered bars. Clustered bars are grouped next to each other.
Select a shape for the bars in the graph. Your choices are Two-dimensional
bar, Three-dimensional bar, or Three-dimensional cylinder.

(Optional) Select Show data values to display a value above each vertical bar
or to the right of each horizontal bar.

4 On the axis tab, complete these steps

a

Indicate your preference for displaying Tick marks. Your options are Show
measure axis tick marks and Show category axis tick marks (relational
data sources only). Tick marks are displayed next to each value of the data item.
Select a font, font size, style, and color for Labels.

Select a font, font size, style, and color for Values.

Select the Measure axis label orientation.

Note: This option is not available when horizontal orientation is selected on
the Bar tab. A

If the graph includes a second measure, indicate whether you want to Display
an additional axis for the second measure. (You select the second
measure in the Graph Data dialog box for the graph.)

5 On the Legend tab, complete these steps:

Note: In order to set legend properties, a category must be assigned to the bar
subgroup function or the bar chart must use more than one measure. A

Select a Position for the legend. Your choices are Left, Above, Below, and
Right.

Note: To leave more room for the chart, position the legend above or below the
chart. A

Select a font, font size, style, and color for Labels.
Select a Background color for the legend.

Note: If you are using multidimensional data, you cannot set a background
color. A\

6 (Optional) If the report section has more than one graph, select the Apply
formatting to existing graphs in the section option.

7 When you are done, click oK.

8 (Optional) Save the report.
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Set Properties for a Bar-Line Chart

To set the properties for a bar-line chart, complete these steps:

1 On the bar-line chart toolbar, click & to open the Graph Properties dialog box.

2 On the General tab, complete these steps:

¢
d
e

If you want a Title to appear above the bar-line chart, type the text, and then
set the font, font size, font style, alignment, and color. You cannot use these
characters: < > & #

For Graph size, select one of these options:

Automatic (Adjusts to fit data)
Select this option to produce a graph that best fits the size of the current
window.

Fixed size
Select this option if you want to specify a fixed size for the graph. From the
drop-down list, choose Small, Medium, Large, or Custom. If you select
Custom, type the width and Height pixel values. The maximum width is
1200 pixels. The maximum height is 900 pixels.

Note: You also can resize the graph by using your mouse. Point to the
bottom right corner or to the bottom or right border. When the pointer
becomes a diagonal or horizontal bar, drag the graph to the new size and
then release the mouse button. A

Select a Background color for the graph.
Select a Border color for the graph.
Select a color for the Grid lines.

3 On the Bar-Line tab, complete these steps:

a

d
e

Select a Bar shape. Your choices are Two-dimensional bar,
Three-dimensional bar, or Three-dimensional cylinder.

Select a Line thickness. Sizes range from 1 to 5 points.

Select a Marker size. On the line graph, there is one marker for each tick on
the horizontal axis. The default marker is a small square. You can also select
No marker, Medium, or Large.

Select a Bar color and a Line color.

(Optional) Select show data values to display a value above each marker.

4 On the Axis tab, complete these steps

a

b
¢
d

Indicate your preference for displaying Tick marks. Your options are Show
measure axis tick marks and Show category axis tick marks (relational
data sources only). Tick marks are displayed next to each value of the data item.
Select a font, font size, style, and color for Labels.

Select a font, font size, style, and color for values.

If the graph includes a second measure, indicate whether you want to bisplay
an additional axis for the second measure. (You select the second
measure in the Graph Data dialog box for the graph.)

5 On the Legend tab, complete these steps:

b

Select a Position for the legend. Your choices are Left, Above, Below, and
Right.

Note: 'To leave more room for the graph, position the legend above or below the
graph. A

Select a font, font size, style, and color for Labels.

Note: If you are using multidimensional data, you cannot format labels. A
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H

Select a Background color for the legend.

6 (Optional) If the report section has more than one graph, select the Apply
formatting to existing graphs in the section option.

7 When you are done, click oK.

8 (Optional) Save the report.

Set Properties for a Line Graph

To set the properties for a line graph, complete these steps:

1 On the line graph toolbar, click & to open the Graph Properties dialog box.

2 On the General tab, complete these steps:

c
d
e

If you want a Title to appear above the line graph, type the text, and then set
the font, font size, font style, alignment, and color. You cannot use these
characters: < > & #

For Graph size, select one of these options:

Automatic (Adjusts to fit data)
Select this option to produce a graph that best fits the size of the current
window.

Fixed size
Select this option if you want to specify a fixed size for the graph. From the
drop-down list, choose Small, Medium, Large, or Custom. If you select
Custom, type the width and Height pixel values. The maximum width is
1200 pixels. The maximum height is 900 pixels.

Note: You also can resize the graph by using your mouse. Point to the
bottom right corner or to the bottom or right border. When the pointer
becomes a diagonal or horizontal bar, drag the graph to the new size and
then release the mouse button. A

Select a Background color for the graph.
Select a Border color for the graph.
Select a color for the Grid lines.

3 On the Line tab, complete these steps:

a
b

H

Select a Line thickness. Sizes range from 1 to 5 points.

Select a Marker size. On each line in the graph, there is a marker for each
tick on the horizontal axis. The default marker is Small. You can also select No
marker, Medium, or Large.

(Optional) Select show data values to display above each point of the line.

4 On the axis tab, complete these steps

[T — T I —

Indicate your preference for displaying Tick marks. Your options are Show
measure axis tick marks and Show category axis tick marks (relational
data sources only). Tick marks are displayed next to each value of the data item.
Select a font, font size, style, and color for Labels.

Select a font, font size, style, and color for values.

Select the Measure axis label orientation.

If the graph includes a second measure, indicate whether you want to Display
an additional axis for the second measure. (You select the second
measure in the Graph Data dialog box for the graph.)

5 On the Legend tab, complete these steps:

Note: In order to set legend properties, a category must be assigned to the
multiple lines function or the line graph must use more than one measure. A
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a Select a Position for the legend. Your choices are Left, Above, Below, and
Right.

Note: 'To leave more room for the graph, position the legend above or below the
graph. A

b Select a font, font size, style, and color for Labels.
¢ Select a Background color for the legend.

Note: If you are using multidimensional data, you cannot set a background
color. A\

6 (Optional) If the report section has more than one graph, select the Apply
formatting to existing graphs in the section option.

7 When you are done, click OK.
8 (Optional) Save the report.

Set Properties for a Pie Chart

To set the properties for a pie chart, complete these steps:
1 On the pie chart toolbar, click & to open the Graph Properties dialog box.
2 On the General tab, complete these steps:

a If you want a Title to appear above the pie chart, type the text, and then set
the font, font size, font style, alignment, and color. You cannot use these
characters: < > & #

b For Graph size, select one of these options:

Automatic (Adjusts to fit data)
Select this option to produce a graph that best fits the size of the current
window.

Fixed size
Select this option if you want to specify a fixed size for the graph. From the
drop-down list, choose Small, Medium, Large, or Custom. If you select
Custom, type the Width and Height pixel values. The maximum width is
1200 pixels. The maximum height is 900 pixels.

Note: You also can resize the graph by using your mouse. Point to the
bottom right corner or to the bottom or right border. When the pointer
becomes a diagonal or horizontal bar, drag the graph to the new size and
then release the mouse button. A

¢ Select a Background color for the graph.
d Select a Border color for the graph.

3 On the pie tab, complete these steps:

a Select a shape for the pie. Your choices are Two-dimensional or
Three-dimensional.

b If your graph includes more than one measure, you can specify whether to
display stacked pies or Multiple pies.

Note: If you assigned a category or hierarchy to Pie Stacks in the Graph
Data dialog box, then this option is not available. A

¢ Select a font, font size, style, and color for Labels.
Select a font, font size, style, and color for values.

e (Optional) Select show data values if you want to display a value on top of
each segment.

4 On the Legend tab, complete these steps:
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Select a Position for the legend. Your choices are Left, Above, Below, and
Right.

Note: To leave more room for the graph, position the legend above or below the
graph. A

Select a font, font size, style, and color for Labels.
Select a Background color for the legend.

Note: If you are using multidimensional data, you cannot set a background
color. A\

5 (Optional) If the report section has more than one graph, select the Apply
formatting to existing graphs in the section option.

6 When you are done, click oK.

7 (Optional) Save the report.

Set Properties for a Progressive Bar Chart

To set the properties for a progressive bar chart, complete these steps:

1 On the progressive bar char toolbar, click 4 to open the Graph Properties dialog
box.

2 On the General tab, complete these steps:

a

c
d
e

If you want a Title to appear above the progressive bar char, type the text, and
then set the font, font size, font style, alignment, and color. You cannot use
these characters: < > & #

For cGraph size, select one of these options:

Automatic (Adjusts to fit data)
Select this option to produce a graph that best fits the size of the current
window.

Fixed size
Select this option if you want to specify a fixed size for the graph. From the
drop-down list, choose Small, Medium, Large, or Custom. If you select
Custom, type the width and Height pixel values. The maximum width is
1200 pixels. The maximum height is 900 pixels.

Note: You also can resize the graph by using your mouse. Point to the
bottom right corner or to the bottom or right border. When the pointer
becomes a diagonal or horizontal bar, drag the graph to the new size and
then release the mouse button. A

Select a Background color for the graph.
Select a Border color for the graph.
Select a color for the Grid lines.

3 On the Progressive Bar tab, complete these steps:

a

b

-0 o O

(Optional) Select set an initial value to specify an initial value for the first
bar in the chart. If you select this option, then you can create a label for it.
(Optional) Select Show the final (cumulative) value to display the value
for the final bar. If you select this option, then you can create a label for it.
Select colors for Positive bars and Negative bars.

If you have selected the Initial bar option, then select a color for it.

If you have selected the Final bar option, then select a color for it.

(Optional) Select Show trend line to overlay a trend line on the progressive
bar chart.
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g (Optional) Select show data values if you want to display a value above each
bar.

4 On the Axis tab, complete these steps

a Indicate your preference for displaying Tick marks. Your options are Show
measure axis tick marks and Show category axis tick marks (relational
data sources only). Tick marks are displayed next to each value of the data item.
Select a font, font size, style, and color for Labels.

Select a font, font size, style, and color for values.

Select the Measure axis label orientation.

If the graph includes a second measure, indicate whether you want to Display
an additional axis for the second measure. (You select the second
measure in the Graph Data dialog box for the graph.)

[T — T B —

5 (Optional) If the report section has more than one graph, select the Apply
formatting to existing graphs in the section option.

6 When you are done, click OK.
7 (Optional) Save the report.

Set Properties for a Scatter Plot

To set the properties for a scatter plot, complete these steps:
1 On the scatter plot toolbar, click  to open the Graph Properties dialog box.
2 On the General tab, complete these steps:

a If you want a Title to appear above the scatter plot, type the text, and then set
the font, font size, font style, alignment, and color. You cannot use these
characters: < > & #

b For Graph size, select one of these options:

Automatic (Adjusts to fit data)
Select this option to produce a graph that best fits the size of the current
window.

Fixed size
Select this option if you want to specify a fixed size for the graph. From the
drop-down list, choose Small, Medium, Large, or Custom. If you select
Custom, type the width and Height pixel values. The maximum width is
1200 pixels. The maximum height is 900 pixels.

Note: You also can resize the graph by using your mouse. Point to the
bottom right corner or to the bottom or right border. When the pointer
becomes a diagonal or horizontal bar, drag the graph to the new size and
then release the mouse button. A

¢ Select a Background color for the graph.
d Select a Border color for the graph.
e Select a color for the Grid lines.

3 On the Markers tab, complete these steps:

a Select a marker size. The default marker is small. You can also select No
marker, Medium, or Large.

Note: If you use the Graph Data dialog box to assign a measure to the Marker
Size function, your Size selection is ignored (see “Assign Data Items to
Functions in a Scatter Plot” on page 65). A
b (Optional) Select Show data values to display a value above each marker.
4 On the Axis tab, complete these steps
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Indicate your preference for displaying Tick marks. Your options are Show
measure axis tick marks and Show category axis tick marks (relational
data sources only). Tick marks are displayed next to each value of the data item.
Select a font, font size, style, and color for Labels.

Select a font, font size, style, and color for values.

Select the Measure axis label orientation.

If the graph includes a second measure, indicate whether you want to Display
an additional axis for the second measure. (You select the second
measure in the Graph Data dialog box for the graph.)

5 On the Legend tab, complete these steps:

Note: In order to set legend properties, a category must be assigned to the
marker group function or the scatter plot must use more than one measure. A

b
c

Select a Position for the legend. Your choices are Left, Above, Below, and
Right.

Note: To leave more room for the graph, position the legend above or below the
graph. A

Select a font, font size, style, and color for Labels.
Select a Background color for the legend.

6 (Optional) If the report section has more than one graph, select the Apply
formatting to existing graphs in the section option.

7 When you are done, click OK.

8 (Optional) Save the report.

Set Properties for a Map

To set the properties for a map, complete these steps:

1 On the map toolbar, click & to open the Map Properties dialog box.
2 On the Map tab, complete these steps:

If you want a Title to appear above the map, type the text, and then set the
font, font size, font style, alignment, and color. You cannot use these characters:
<>& #

From the size drop-down list, choose Small, Medium, Large, or Custom. If you
select Custom, type the width and Height pixel values.

Note: You also can resize the map by using your mouse. Point to the bottom
right corner or to the bottom or right border. When the pointer becomes a
diagonal or horizontal bar, drag the map to the new size and then release the
mouse button. A

Choose the method that will be used to color the regions of the map:

Equivalent intervals
Each color in the map will be defined by the range of the data divided by the
number of colors.

Natural breaks
Each color in the map will be defined by natural breaks (or interruptions) in
the data. The breaks are based on a histogram of data distribution.

Quantiles
The measure values are sorted and an equal number (data points) are
assigned to each color according to their sorted value.
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Standard deviations
The mean and the standard deviation values for the measure are calculated.
The number of regions on the map is determined by adding plus or minus the
standard deviation to the mean value.

Select the Number of colors to use for the coloration method that you chose.
The default is 5. The maximum is 12. Regardless of your selection, the map
legend will not contain more colors than there are members in the currently
displayed hierarchy level.

The colors used depend on the currently applied style sheet (Festival,
Seaside, or Meadow).
Select a Border color for the map.

3 On the Layers tab, select the layers that you want to include in the map. The
Layers tab lists which, if any, information layers have been created by your data
administrator. Examples include Major roads, Schools, Lakes and reservoirs, and
Elevation.

4 When you are done, click OK.

5 (Optional) Save the report.

Set or Modify Properties for a Viewed Report

To set or change the style, filter display, keywords, and description for a viewed
report, complete these steps:

1
2

Select Report » Report Properties to open the Report Properties dialog box.

On the General tab, set or modify keywords and the description. You cannot use
these characters: < > & #

On the Format tab, perform any of these tasks:

O

Select one of three styles to use for the current report: Meadow, Seaside, or
Festival. Styles affect the color and font style used in graphs, tables, and
maps. Style changes do not affect text formatted in group breaks, headers, and
footers.

Note: Existing reports might be using a Custom style. If you change the
Custom style to one of the SAS Web Report Studio styles, then you will not be
able to reset the report back to the Custom style. A

Specify whether you want to display filter information with the report.

If the report section contains independent objects, a filter text box appears
above each object. If the report section contains synchronized objects, then one
filter text box is displayed above the synchronized set. You can select a Text
and Border color for the filter text and its surrounding box. The filter
information is included in printed reports.

4 When you are done, click OK.

5 (Optional) Save the report.
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Overview of Creating and Editing Reports

Basically, creating reports involves performing these tasks for each report section:
o0 selecting the query method or methods that will be used to obtain the data

O selecting and placing the report objects that will contain the data such as tables
and graphs

0 adding optional group breaks, headers, footers, images, and text

SAS Web Report Studio also enables authorized users to save a variety of changes to
saved reports (see “About Saved Reports” on page 34). Some changes can be made in
both report views, and some changes can be made only in the View Report view or the
Edit Report view.

For example, these modifications can be made in both the View Report view and the
Edit Report view:

o0 show or hide totals in tables
0 add percent of total columns to tables
o filter or rank list tables, graphs, and maps

0 add or modify conditional highlighting

These are some of the modifications that can be made only in the View Report view:
O drill and expand tables, graphs, and maps

O create a measure filter or ranking for a crosstabulation table

These are some of the modifications that can be made only in the Edit Report view:
0 modify the query method and layout for a report section

O add new sections

0 add report links
o

synchronize report objects
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This chapter provides the following information for users who are authorized to
create reports and to save changes to existing reports:

0 an overview of the tools that you will use to create and edit reports
O the main steps that are required to create a new report
0 the main steps that are required to edit a report

About the Tools Used to Create and Edit Reports

Abhout the Report Views

SAS Web Report Studio displays reports in two different views: the View Report view
and the Edit Report view. If you are authorized to create and edit reports, you can use
both views to make modifications to existing reports. Modifications that can be made in
both views include filtering, applying conditional highlighting, and sorting.

You also use the Edit Report view to create new reports and to make changes such as
modifying the query method and layout for a report section, adding new sections,
adding report links, and synchronizing report objects.

For more information about the report views, see Chapter 3, “Understanding the
Report Views,” on page 27.

About Report Templates

SAS Web Report Studio comes with a selection of templates. You also can create your
own multiple-section templates that you can share or keep private. Report templates
can contain the following content:

O tables and their properties (but not linking information)
o0 graphs and their properties (but not linking information)
maps and their properties

images, their properties, and linking information

text objects, their properties, and linking information
headers

footers

O 0o oo g o

stored process objects (without the stored process selected)
O positioning information

Templates cannot contain data items or group breaks (group breaks require that you
select data items from a data source).

To use a report template as the basis for a new report, select Report » New From
Template.

You also can apply a template to a report section in the Edit Report view. However,
when you apply a template to a report section, only the first section in the template is
used.

About the Report Wizard

The Report Wizard guides you through five steps to create a one-section report that
uses standard data items. You can use the Report Wizard to perform these tasks:

O select standard data items from a data source
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filter and format the selected data items (depending on the type of data source)

specify group breaks

o
o
O select a table and a graph (a bar chart, a pie chart, or a line graph)
o

define a header and footer

To open the Report Wizard in order to create a new report, select Report » New

Using Wizard.

You cannot use the Report Wizard to edit a report.

Note: Information about using the Report Wizard is not included in this
documentation. For information about using the Report Wizard, click Help on any

wizard page. A

Create a Report

To create a new report, complete these main steps:

1 Choose a starting point and take the appropriate action in order to access the Edit

Report view.

Starting Point

Action

a blank report

Select Report » New.

a report template

Select Report » New from Template to select a report template from a
gallery and display it in the Edit Report view.

a saved report

From either the Open dialog box or the Report Management page,
navigate to the existing report that will be the basis of the new report.
Next to the name of the report, click ! in the Actions column, and
then select Edit.

When a report is displayed in the View Report view, click Edit Report.

stored process
output

When the output is displayed in the View Report view, click Edit
Report.

a quick report

When the quick report is displayed in the View Report view, click Edit
Report.

the Report Wizard

Select Report » New from Wizard to open the Report Wizard. After you
select at least one data item, you can click Finish to access the Edit
Report view.

2 If you started from a blank report or a report template, then define the query. If
you started from a saved report, the Report Wizard, or a quick report, then you
can modify the query.

For more information, see Chapter 9, “Obtaining Data for a Report Section,” on

page 107.

3 If you started from a blank report, then design the layout. If you started from a
report template, a saved report, a quick report, or the Report Wizard, then you can
modify the existing layout.

For more information, see Chapter 10, “Designing the Layout of a Report
Section,” on page 127.
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Note: If you started from stored process output, you can add images, headers,
footers, and text, which will be independent of the stored process output. A

4 (Optional) Add one or more sections. For more information, see “Add a New

Section to a Report” on page 157.
5 Save the report.

Edit a Saved Report

To edit a saved report, you must first display it in the View Report view or the Edit
Report view, depending on the changes that you want to make.

Edit Location  Access Instructions

Editing Instructions

View Report “View a Saved Report” on page 39 Chapter 6, “Changing Data
view! in a Viewed Report,” on
page 47
Chapter 7, “Changing the
Presentation of a Viewed
Report,” on page 81
Edit Report O From the Open dialog box or the Report Chapter 9, “Obtaining
view Management page, next to the name of the Data for a Report Section,”

report that you want to edit, click =l in the
Actions column, and then select EAit.

O When a saved report is displayed in the
View Report view, click EAit Report.

on page 107

Chapter 10, “Designing the
Layout of a Report
Section,” on page 127

Chapter 11, “Managing
Report Sections,” on page
157

1 Most of the tasks that can be done in the View Report view can also be done in the Edit Report

view.

When you are done making changes, remember to save the report.
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Overview of Obtaining Data for a Report Section

The data in a report section is the result of a query sent to a source of data such as a
relational table or a cube. For each report section, you can submit the query in either of
these two ways, or you can use both methods:

O You can select data items from a relational or multidimensional data source
(including creating custom data items).

For information about data items and data sources, see “About Relational and
Multidimensional Data Sources” on page 14.

O You can select one or more stored processes.
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For information about what a stored process is, see “About Stored Processes” on
page 17.

In addition to explaining how to define a query for a report section, this chapter also
explains how to use the Edit Report view in order to modify the query in the ways
listed in this table.

Note: For general information about the Edit Report view, see “About the Edit
Report View” on page 30.

A
Query Method
Modification Data Items from a Data Stored Processes
Source
select or create filters relational data sources You cannot modify the query
from within SAS Web Report
change the default filter relational data sources Studio. However, the query
combination might already include
modify the aggregation of a relational data sources refinements such as filtering,
measure formatting, and sorting.
use detail data instead of relational data sources
grouped and aggregated data
modify the format of a data relational and
item multidimensional data sources

Note: Only authorized users can save reports. If you have questions about your
authorization, contact your system administrator. A

Note: For information about viewing quick reports, which also use data items, see
“View a Quick Report” on page 44. A

Managing Standard Data Items

Use Standard Data Items

To use standard data items in the query for the current report section, complete
these steps:

1 In the data pane, click Select data to open the Select Data dialog box.
2 Click the standard tab.
3 A data source is selected by default. If you want to use a different data source,

complete these steps:

a Click change Source.

b In the Select Data Source dialog box, select a new data source. Each data
source appears with an icon that indicates its type (for more information, see
“About Relational and Multidimensional Data Sources” on page 14).
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Icon Type of Data Source

j relational

= multidimensional

o |

=n multidimensional (enabled for geographic mapping)
= |

¢ Click ok.

4 (Optional) To search for a data item in the selected data source, complete these
steps:

a Click 2] on the standard tab.

b Type your search term.

¢ Click Find Next to locate each instance of the data item.
d When you are done, click cancel.

5 In the Available data items list box, select a data item, and then click the right
arrow button to add the data item to the query. To move all items into the
Selected data items box, click the double right arrow. The data items that you
select are listed in the Selected data items list box.

Display 9.1 Select Data Dialog Box Showing Four Categories and Two Measures Selected from a Relational
Data Source

Note: To view information about a data item, select it in the Available data
items list box, and then click . A
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Note: For relational data sources, you can select the same measure multiple

times, rename each instance of the measure (see step 7), and apply a different
aggregation to each instance of the measure (see “Modify the Aggregation of a
Measure” on page 117). A

6 (Optional) Reorder the data items in the Selected data items box. To move a
selected data item up or down in the list, use the up and down arrow keys. The
order in which the data items appear in this box is used to assign the data items
to default functions in graphs and tables.

Note: Existing tables and graphs are not affected by reordering data items. A

7 (Optional) To rename a data item, select it in the Selected data items, and then
click .

Note: This button is not available for hierarchies. A

8 (Optional) If you do not want new data items automatically added to existing
tables, then clear the Add new data items to existing tables
automatically option. (Adding new data items to tables might affect existing
filters, percent of total columns, and conditional highlighting.) If this option is not
selected, then new data items will be hidden in tables. This option is not available
if there are no existing tables.

Note: For existing crosstabulation tables that have at least one category assigned
to Columns, additional data items are assigned to the Rows function. If you add
measures, the additional measures are assigned to whatever function the current
measures are assigned to. That is, if measures are currently assigned to Rows,
then the additional measures are also assigned to Rows.

For list tables, if this option is selected, new data items are added to the
Columns function. A

9 When you are done, click OK.
10 Save the report.

Display 9.2 Data Pane in the Edit Report View Showing the Standard Data Items Selected for the Query

Select data | Options

Y

% Data selected from:  Gold Custormers Order Information

Data item: Filter: Format:

@ Country ﬁ [Mofiter El Define —
B Product Category ﬁ IND filter j

@ Order Yr ﬁ |Ma fiiter =l

B fge Group ﬁ IND filter j

y Revenue Define B

o

Note: To collapse the data pane, click
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Managing Filters

Select a Predefined Category Filter

If a category in a relational data source has a predefined filter, you can select it in
the Filter drop-down list. (The data source administrator determines whether a
category has a predefined filter.)

Note: Match all filters is the default filter combination. For information about

how to change the combination, see “Modify the Default Filter Combination” on page
115. a

Display 9.3 The Predefined Filter ‘Countries with Stores’ Is Selected for the Country Category

Select data | Options =

% Data selected from:  Gold Customers Order Information

Data item: Filter: Format:

B Country ﬁ Countries with Stares Drefine —
B Product Category ?‘ IND filter d

@ Order Yr ﬁ | Ma fiter =l

B fze Group ﬁ IND filter d

y Revenue Define B

Create an Alphanumeric Category Filter

To create a filter for an alphanumeric category in a relational data source, complete
these steps:

Note: Each category can have only one section filter. If a category already has an
associated filter, then creating another filter will replace it. A

1 In the data pane, click ¥J next to a category to open the Create New Filter dialog
box.

2 Type a Filter name. You can accept the default name or provide a different
name. For example, if you want to filter a report of your customers to show only
those customers who are in Japan or Germany, you could use a name like Country
is Japan or Germany. You cannot use these characters: < > ( ) & # \

3 Select an Operator.

4 Depending on which operator you selected, select a method of specifying values.
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Table 9.1 Operator Selections and the Methods That Can Be Used to Specify Values

Operator

Available Methods

Typing values'

Selecting values
from a list’

Prompting users to
type values

Prompting users to
select values from
a list

Equal
to or
Not
equal
to

Between
values
or Not

between
values’

Type a value and click
Add. Repeat this
procedure to use
multiple values for
this filter. To remove a
value, select it in the
Multiple values
box and click Remove.

Type a Minimum
value and a
Maximum value
such as numerals,
character strings, or
letters of the alphabet.

Select a value from the
Available values
list and click the right
arrow button. Repeat
this procedure to use
multiple values for this
filter.

Select a Minimum
value and a
Maximum value from
the drop-down lists.

Type a Message for
user and Specify
a default value.

Type a Message for
user and specify
defaults for the
minimum and
maximum values.

Type a Message
for user and
specify how you want
to create the list.

Your choices are to
type the values,
select the values from
a list,? or to allow
users to query for
values®*. If you type
the values or select
values from a list,
then the first item in
the list is used as the
default value (as
shown in Display 9.5
on page 116). If you
allow users to query
for values, then you
must choose a default
value. The default
value is used if the
user’s query returns
no results.

Type a Message
for user and
specify how you want
to create the list.

Your choices are to
type the values,
select the values from
a list,” or to allow
users to query for
values®*. If you type
the values or select
values from a list,
then the first item in
the list is used as the
default value (as
shown in Display 9.5
on page 116). If you
allow users to query
for values, then you
must choose a default
value. The default
value is used if the
user’s query returns
no results.
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Available Methods

Typing values’ Selecting values Prompting users to Prompting users to
from a list’ type values select values from
Operator a list
Contains Type a value to define  not available Type a Message for not available
or Does your filter. For user and Specify
not example, you are a default value.

contain creating a filter on the
Job_Title category, and
you select Contains
as the Operator and
then type Assist in the
Value field. This
results in a report
that includes values
such as Concession
Assistant I and

Marketing Assistant I.
Match Type a value to define  not available Type a Message for not available
pattern your filter. Use % to user and Specify
or Does represent multiple a default value.
not characters or use _ to
match represent any single

pattern character.

For example, you
create a filter on the
Job_Title category, and
you select Matches
pattern as the
Operator and then
type Sales% in the
Value field. This
results in a report
that includes values
such as Sales Manager
and Sales Rep. I. The
report excludes values
such as Chief Sales

Officer.
Is No further action is necessary.
missing
or Is
not
missing

1 Ifyouselect the Filter on formatted values option (step 5), then you must enter the formatted values.

2 The data source administrator can turn off the Select values from list option.

3 Filters are evaluated based on the data type (character or numeric) of the selected data item and the locale
that is currently active for the browser. For example, as a character string, the number 23 is considered
higher than 1345 in the U. S. English locale.

4 Ifthe Select values from list option is available, then the Allow users to query for values
option is also available.
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5 (Optional) If the selected data item is classified as a character data type and it is
not using the default format, then you can select the Filter on formatted
values option. In this case, formatted values will be used in all parts of the
current filter query.

Note: If the selected data item is using the default format and this option is
selected (which might be the true for reports that were created with a previous
version of SAS Web Report Studio), then clear this option to improve query
performance. Leave the option selected, however, if you cannot produce the desired
results by using unformatted values. A

6 When you are done, click OK.
7 Save the report.

Note: Match all filters is the default filter combination. For information about
how to change the combination, see “Modify the Default Filter Combination” on page
115. A

Display 9.4 This Filter Will Prompt the User for Order Year by Displaying a List of Values

4} Create New Filter - Microsoft Inter . -0l x|
Filter name: [Promptfar order vear
Data item: Order r
(perator: I Enual ta j
Specify values by: |Pr0mpting uszers to selectvalues fram a list j
-
~Prompting users to select values from a list
Message for user: Flease select a year: =l
[
Create user's list by: Selecting values from a list j
Available values: Selected values:
1998
19949
2000
2001
2002
Ok ‘ Cancel | Help ‘

Create a Date, Time, or Timestamp Category Filter

To create a filter for a date, time, or timestamp category in a relational data source,
complete these steps:
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Each category can have only one section filter. If a category already has an

associated filter, then creating another filter will replace it. A

1 In the data pane, click ¥J next to the category to open the Create New Filter

dialog box.

2 Type a Filter name. You can accept the default name or provide a different
name. You cannot use these characters: < > ( ) & # \

3 Select an Operator.

Depending on which operator you selected, select a method of specifying values.

Table 9.2 Operator Selections and the Methods That Can Be Used to Specify Values

Operator

Available Methods

Entering a value

Prompting the user for a value’

Equal to, Not equal to,
Greater than, Greater than
or equal to, Less than, and
Less than or equal to

For dates, specify a Day, Month,
and Year.

Type a Message for user and
specify a Day, Month, and Year
as the default.

For times, specify a Hour,
Minute, and Second.

not available

For timestamps, specify a Day,
Month, Year, Hour, Minute, and
Second.

not available

Between values and Not
between values

For dates, specify the Minimum
and Maximum for the Day, Month,
and Year.

Type a Message for user and
specify the Minimum and
Maximum for the Day, Month, and
Year as the default.

For times, specify the Minimum
and Maximum for the Hour,
Minute, and Second.

not available

For times, specify the Minimum
and Maximum for the Day, Month,
Year, Hour, Minute, and
Second.

not available

Is missing and Is not
missing

No further action is necessary.

1 Prompted filters are only available for dates (not for times or timestamps).

5 When you are done, click OK.
6 Save the report.
Note: Match all filters is the default filter combination. For information about

how to change the combination, see “Modify the Default Filter Combination” on page
115. A

Modify the Default Filter Combination

The default filter combination is Match all filters. To modify the default
combination, complete these steps:

1 In the data pane, select Options » Filter Combination to open the Filter
Combination dialog box.

2 Select one of these options:
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Match all filters
Select this option if you want to see only observations that match all filters.
If there are no observations that match all filters, then no data is returned.
This option is the default.

Match any filters
Select this option if you want to see any observation that matches any of the
filters. Data is returned if at least one observation matches at least one filter.

Advanced combination
If you choose Advanced combination, then you can write a simple,
conditional expression that combines your selected filters. In the text field,
you can type an expression that includes these items:

O the names of filters, enclosed in square brackets ([ 1)
O parentheses
O the words AND and OR to join the names of the filters or items inside
parentheses
3 When you are done, click OK.
4 Save the report.

View a Filter Summary

To display a summary of category filters that are active in the report section,
complete these steps:

1 Select Options » Filter Summary.

2 View the information in the Filter Summary dialog box.

Display 9.5 How the Filters Shown in Displays 9.3 and 9.4 Will Be Applied ('1998’ Is the Default Value for
the Prompted Filter for Order Year)

%) Filter Summary - Micro -10] x|

Applied filters:

-

Country equal to AU, BE, OE, DK, ES, FR, GB, IT,
ML, US &MD Order ¥r equal to 1998

Help

3 When you are done, click oK.

Remove a Filter

To remove a filter from the query that obtains relational data for a report section,
complete these steps:
1 In the data pane, select No filter in the Filter drop-down list for the category.

Note: If you remove a user-defined filter, the filter will still be available to select
in the Filter drop-down list. A
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Note: If you remove a filter that is part of a filter combination expression, the
filter combination will reset to the default of Match all filters. This also
occurs if you remove all filters except one. A

2 Save the report.

Tips for Creating Filters

Here are some tips for creating section filters:

o If you are filtering on unformatted values, then you must enter values that match
the casing of the values in the data source. If you select the Filter on
formatted values option, then you must enter the formatted values. If the filter
does not return any results, then try using a different casing.

o For relational data sources, the availability of the Select values from list
filter type is controlled by your data administrator.

O If the select values from list filter type is available, then the Allow users
to query for values option is also available.

0 When you are creating a section filter that uses the Between values or Not
between values operator, keep in mind that filters are evaluated based on the
data type (character or numeric) of the selected data item and the locale that is
currently active for the browser. For example, as a character string, the number
23 is considered higher than 1345 in the U. S. English locale.

0O Match all filters is the default filter combination. For information about how
to change the combination, see “Modify the Default Filter Combination” on page
115.

O You cannot create a prompted filter for times or timestamps.

Modify the Aggregation of a Measure

You might want a measure in a relational data source to use a different aggregation
method than the default method. For example, your data source includes a measure
called Unit Cost, and it is aggregated by using the Sum method; you might decide that
you want to use the Maximum method instead.

Note: For multidimensional data sources, records are always grouped and the
aggregation method of a measure cannot be changed. A

To change the aggregation method of a measure in a relational data source, complete
these steps:

1 In the data pane, select Options » Aggregate or Detail to open the Aggregate or
Detail dialog box.

2 In the Aggregation drop-down list that is next to the name of the measure that
you want to change, select a new aggregation method.

Note: Your data source administrator can turn off the ability to change the
aggregation method. A

3 When you are done, click oK.
4 Save the report.

5 (Optional) Change the name of the measure to better reflect the new aggregation
method (see “Rename a Standard Data Item” on page 119).
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Use Detail Data Instead of Grouped and Aggregated Data

By default, the records in the selected data source are grouped and aggregated. For
each distinct combination of values across all categories in this report section, there will
be a single record.

For multidimensional data, you cannot change the grouping or aggregation. For
relational data, the option to use detail data is not available if the report section
contains any of these items:

O a crosstabulation table or a graph, with the exception of scatter plots that use

relational data.

O one or more custom data items.

In all other circumstances, to use detail data, complete these steps:

In the data pane, select Options » Aggregate or Detail to open the Aggregate or
Detail dialog box.

Select one of these options:

Display detail data
Select this option to cause every record in the data source to be shown.

Note: 'To base a scatter plot on nonaggregated (raw) data, select this
option. A

Display detail data, excluding duplicates
Select this option to cause every record in the data source to be shown and to
exclude duplicate records (records where the value for every data item is
identical).

3 When you are done, click oK.
4 Save the report.

Modify the Format of a Standard Data Item

To change the default format of a data item, complete these steps:

1 In the data pane, click Define next to the data item to open the Define a Format

dialog box.

Note: The data source administrator controls whether you can change the format
of a standard data item. If you are not permitted to change the format, then
Define is not available. A

2 Select a Type of format.
3 Depending on which format type you selected, take the appropriate action:

Table 9.3 Format Selections and Available Actions

Format Data Item Type Action

Selected

Default ! all types No action necessary.

Currency numeric categories and Select the number of digits to be displayed after the decimal
measures point.

Date date, time, or timestamp Select the date format that you want to use for the data item.

categories
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Format Data Item Type Action

Selected

Number numeric categories and Select the number of decimal places to be displayed and choose
measures a format for negative numbers. You also can choose to either

Predefined *

Time

use a thousands separator or convert the value to a percentage.

alphanumeric categories * Select the predefined format that you want to apply to this
data item.

date, time, or timestamp Select the time format that you want to use for this data item.

categories

1 The Default format is the one that is used in the data source that contains the data item.

2 The Predefined format is available only if the data item is from a relational data source and only if the
data item has been prepared by the data source administrator to offer predefined formats.

3 If an alphanumeric category does not have any predefined formats available to choose from, then the Define
a Format dialog box is not available at all.

4
5

When you are done, click oK.
Save the report.

Rename a Standard Data Item

To change the name of a standard data item, complete these steps:

1

2
3
4

In the data pane, click select data to open the Select Data dialog box.
Click the standard tab.
Select a data item in the Selected data items list box.

Click /] .

Note: This button is not available for hierarchies. A

In the Rename Data Item dialog box, type the new name, and then click OK.
To close the Select Data dialog box, click OK.
Save the report.

Remove Standard Data Items

To remove a standard data item from a report section, complete these steps:

1
2
3
4

In the data pane, click select data to open the Select Data dialog box.

Click the standard tab.

Select a data item in the Selected data items list box.

Click the left arrow button to remove the data item from the Selected data

items list box. Here are some consequences of removing data items from a section

query:

o If you remove a time hierarchy, then any custom data items that are based on
time functions are removed from all objects in the report section.

o If you remove the geography hierarchy, then any map in the section will become
invalid.

o0 If you remove a category or hierarchy that is being used in a report linking
prompt, then the prompt association is removed.

o If you remove a data item that is being used in a percent of total calculation,
then the percent of total column is removed from the table.
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o If you remove a measure that is being used with a group break or in a text
object, then the measure information is removed from the report section. For
example, if you included Profit with a group break for Product, then the
Profit information would be removed.

5 When you are done, click oK.
6 Save the report.
Note: For information about removing data items while you are viewing a

synchronized report, see “Managing the Data Used for Synchronized Report Sections”
on page 74. A

Preview Data

To preview the results of the query that you defined using standard data items,
complete these steps:

1 In the data pane, select Options » Preview Data to open the Preview Data dialog
box. All columns and up to 100 rows are displayed at one time.

Display 9.6 Preview Data Dialog Box Showing the Results of the Unfiltered Query Shown in Display 9.2

; Preview Data - Microsoft In ;|g|5|
Export Close Window | Help |
Country [Product |Order [Age |Revenue |Units
Category | Yr Group Seld

15-30

Al Clothes 1995 |years [$25,554.30) 452
31-45

AL Clathes 19958 |years [$23113.60| 362
45-60

AL Clathes 1995 |years [§22,5333.40( 366
E1-75

AL Clothes 1998 |years |$13,736.90( 249
15-30

AL Clathes 1998 |years [§21,738.27| 336
3-45

AL Clothes 1999 |years [$23276.50) 379
45-60

AL Clothes 1999 |vears |$15914.49( 275
B1-73

AL Clathes 1998 (years (§$11.31000( 195
15-30

Al Clothes 2000 |years [$25,6593.89) 450
31-45

AL Clathes 2000 |years [$1770510( 261
45-60

AL Clathes 2000 (wears (F17010.45| 254
E1-75

Al Clothes 2000 |years [$1232018) 194
15-30

AL Clathes 2001 |years ($1781713| 306
I-43

AL Clathes 2001 |wears [$155931.46| 280
4660 =
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3 Preview Data - Microsol o ] |
Export || Close Window | Help |
Country  |[Product |[Order |Age |Revenue |Units

Category | Yr Group Sold
15-30
AU Clothes (1998 |yesrs | §28884.30| 452
31-45
Al Clothes 1998 | years F23 11560 362
46-60 [
Al Clothes 1995 |years $2233540| 366
51-75
Al Clothes (1998 |vesrs | $13,73690| 249
15-30
DE Clothes (1998 |yesrs | $46,69510) 810
31-45
DE Clothes (1998 |yesrs | $46,89570| 704
46-60
DE Clothes 1998 | years 3492190 537
E1-75
DE Clothes 1995 |years F30,392.06| 466
15-30
DE Shoes 1996 |vears | §71,2668.00| 762
31-45
DE Shoes 19968 |vears | $59,77570| K33
46-60
DE Shoes 1998 |vears | f48.24720| 922
61-75
DE Shoes 1998 |years | $39786.70) 393
15-30
Denmark Clothes 1995 |years 3 ,966.40 74
F1-45
Denmark Clothes 1998 |years 3,047 .20 47
46-60
Denmark Clothes 1998 | years $2.74218 47
61-75
Denmatk Clothes 1998 | yesrs ¥1,.71860 27
15-30
Drentmark Shoes 1998 | vears 6. 73210 il _‘l

2 (Optional) To export the data to a Microsoft Excel spreadsheet, click Export.
When prompted, choose to open the Microsoft Excel file or save it.

3 To close the Preview Data dialog box, click Close Window.

Note: Sometimes, instead of the data, you see the message No values were
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returned for this table. This means that the filters that you have applied to this

section have filtered out all the data from your data source. In this case, click Close

Window to go back to the Edit Report view and change the filters that you are using. A

Managing Custom Data Items

Create a Custom Data Item Based on Relative Time

If you are using data items from a multidimensional data source that contains a time

hierarchy, then you can create a custom data item that is based on relative time.

Complete these steps:

1 In the data pane, click Select data to open the Select Data dialog box.

2 Click the custom tab.

3 A data source is selected by default. If you want to use a different data source,

complete these steps:
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a Click change Source.
b In the Select Data Source dialog box, select a new data source.
¢ Click ok.

4 Type the Name of the custom data item. You cannot use these characters: < > ( )
& #\

5 Select a measure in the Available measures field.

Select one of the options in the Functions drop-down list. You can calculate the
difference in a selected measure over a previous period or previous year,
percentage change of a selected measure over a previous period or previous year,
and a selected measure’s cumulative value to the current period. (The cumulative
function starts over with each calendar year.) For example, you might create these
expressions: Percent change over previous year[Revenue] Or
Cumulative[COST N]

7 Click the arrow button to place your relative time expression in the Expression
field. The expression is evaluated based on the aggregated values of the measures
that you selected. (Within SAS Web Report Studio, it is not possible to produce a
detailed calculation.)

Click Add to add your custom data item to the New items box.

9 When you are done, click OK.

The custom data item that you created will be listed in the data pane with any
other selected or created data items.

10 Save the report.

Display 9.8 A Custom Data Item That Uses the 'Percent change over previous year Function

/3 Select Data - Microsoft Internet Explorer provided =lalx]
Data source: Orion Gald Enhanced Navigation Change Source ... |
Standard m
Hame: |F'ercent of Change Revenue
Available measures: Expression:
Profit Percent change over previous =

vear[Revenues]

]

Functions: -
- +| (=] |* ! () Clear
Fercent change over previous year j

Hew items:

Percent of Change Revenue Add

Change

Remove

M Cancel

Create a Custom Data Item by Entering an Expression

To create a custom data item by entering an expression, complete these steps:
1 In the data pane, click Select data to open the Select Data dialog box.
2 Click the custom tab.
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Modify a Manually Entered Expression

3 A data source is selected by default. If you want to use a different data source,

complete these steps:

a Click change Source.

b In the Select Data Source dialog box, select a new data source.

¢ Click ok.
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4 Type the Name of the custom data item. You cannot use these characters: < > ( )

& # \

5 Type an arithmetic expression into the Expression field. The expression is
evaluated based on the aggregated values of the measures that you selected.
(Within SAS Web Report Studio, it is not possible to produce a detailed calculation.)

Here are some items that you can include in an expression:

Table 9.4 Items That Can Be Included in a Custom Data ltem Expression

Items Examples

Notes

measure names, enclosed in square [Profit]

brackets [Cost of Goods Sold]

parentheses 2 * ([COST_N] +
[Sales_Cost])

the following symbols: + (plus sign), [Retail Price] - [Cost]
- (minus sign), * (multiplication
sign), and /(division sign)

numeric constants [Total_Retail Price] /
1000000

If you select a measure from the
Available measures list box
and click the arrow button to move
it to the Expression field, then
the brackets are automatically
included.

Use parentheses when you need to
perform a calculation outside of the
normal order of operations.’

You can type the parentheses or use
the button (1=1).

You can type the symbols or use the

symbol buttons ( B ).

You cannot create a data item that
is a constant value such as 500 or
500+300.

1 In the normal order of operations, working from left to right, multiplication and division is done first, followed

by addition and subtraction.

6 After you have written the expression, click Add to add your custom data item to

the New items box.
7 When you are done, click oK.

The custom data item that you created will be listed in the data pane with any

other selected or created data items.
8 Save the report.

Modify a Manually Entered Expression

To modify a custom data item, complete these steps:

1 In the data pane, click Select data to open the Select Data dialog box.

2 Click the custom tab.
3 Select a custom data item in the New items box.
4 Make your changes.
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Note: For information about writing expressions, see “Create a Custom Data
Item by Entering an Expression” on page 122. A

Note: You cannot modify an expression that uses a relative time function. You
can click Clear to clear it from the Expression field. A

5 Click change.
6 When you are done, click OK.

7 Save the report.

Modify the Format of a Custom Data Item

To change the format of a data item, complete these steps:

1

In the data pane, click Define next to the data item to open the Define a Format
dialog box.

Select a Type of format. For custom data items, the options are Default,
Currency, and Number.

Depending on which format type you selected, take the appropriate action:

Table 9.5 Format Selections and Available Actions

Format Selected Action

Default *

Currency

Number

No action necessary.

Select the number of digits to be displayed after the decimal point and specify a currency
symbol.

Select the number of decimal places to be displayed and choose a format for negative
numbers. You also can choose to either use a thousands separator or convert the value to
a percentage.

1 The Default format is Number.

4 When you are done, click OK.

5

Save the report.

Remove a Custom Data Item

To remove a custom data item from a report section, complete these steps:

1
2
3

4
5
6

In the data pane, click select data to open the Select Data dialog box.

Click the Custom tab.

Select a custom data item in the New items box.

Note: If you remove a custom data item, then that custom data item will no
longer be available to use in the report. If you change your mind, you will have to
recreate the custom data item. A

Click Remove.

When you are done, click OK.

Save the report.

Note: For information about removing custom data items when you are viewing a
synchronized report, see “Managing the Data Used for Synchronized Report Sections”
on page 74. A
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Preview Data

To preview the results of the query that you defined using custom data items,
complete these steps:

1 In the data pane, select Options » Preview Data to open the Preview Data dialog
box.

2 (Optional) To export the data to a Microsoft Excel spreadsheet, click Export.
When prompted, choose to open the Microsoft Excel file or save it.

3 To close the Preview Data dialog box, click Close Window.

Managing Stored Processes

Use Stored Processes
To use a stored process in the current report section, complete these steps:

1 Click on the horizontal toolbar.

2 On the stored process toolbar, click (&, and then select Edit Stored Process to
open the Insert a Stored Process dialog box.

3 Select a folder Location, either Shared folders or My folders (your private
folder area).

(Optional) To sort the list of stored processes, click Name, Date, or Description.
Select the stored process that you want to use.

When you are done, click OK.

(Optional) To insert another stored process, repeat steps 1 through 6.

0 N oo O &~

(Optional) Add a header, footer, images, or text that are independent of the
inserted stored processes.

9 Save the report.
Display 9.9 How a Stored Process Object Appears in the Body of the Report

E E | o & = B Lk @ IIndependentObjects -l

mE x
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Remove a Stored Process

To remove a stored process from the current report section, complete these steps:
1 Select the stored process object.
2 Click # on the vertical toolbar.

3 In the confirmation message box that appears, click OK.
4 Save the report.
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Overview of Layout Design

The layout of a report section can consist of a header and footer, group breaks, and a
body that contains report objects such as tables, graphs, images, maps, and text. How
you add those elements to a layout depends on what method you are using to submit
the query to the relational table or cube (see Chapter 9, “Obtaining Data for a Report
Section,” on page 107).

This table lists your options for designing a layout depending on which query method
you are using.

Table 10.1 Options for Designing a Layout

Query Method Ways to Design a Layout

standard and custom' data items selected from Use the Report Wizard to specify group breaks, add a table, a
a data source graph, a header, and a footer.”

Use a report template that contains preinserted content such as
tables, graphs, headers, footers, and maps, but not group breaks.
See “Use a Report Template to Design a Layout” on page 130.

Use the Edit Report view. Design tasks include manually inserting
headers, footers, group breaks, table, graphs, and maps. See this
chapter for information about these tasks.

one or more stored processes ° Do nothing. The stored process code includes layout elements,
usually tables and graphs. (In fact, the stored process output can
include any element that can be programmed by using SAS.)

Use a report template to add images, headers, footers, and text,
which will be independent of the stored process output.

Use the Edit Report view to add images, headers, footers, and text,
which will be independent of the stored process output.

1 You cannot create custom data items from within the Report Wizard.

2 For Help on using the Report Wizard, click Help in any wizard page.

3 Stored process reports that were created by using SAS Enterprise Guide do not support any layout design.
However, you can rename and delete sections.

This chapter explains how to use report templates and the Edit Report view in order
to design the layout of a report section.

Note: For general information about the Edit Report view, see “About the Edit
Report View” on page 30. A

Note: For general information about report templates, see “About Report Templates”
on page 104 A

Note: Only authorized users can save reports. If you have questions about your
authorization, contact your system administrator. A
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Use a Report Template to Design a Layout

To use a report template to design a layout, complete these steps:
1 Perform one of these tasks to open the Select a Template dialog box:

o0 Select Report » New from Template. If you use this method to start building a
new report, then all sections in the template are used.

0 Click Apply a template in the report section that is currently open in the Edit
Report view. Only the first section of the template is used, even if the template
has multiple sections.

2 Click one of these tabs: General templates, Shared templates, or My
templates.

3 Select a template.

4 Click oK.

5 (Optional) Edit the default layout by completing the tasks described in this
chapter, including adding group breaks.

Note: If the report section is using only stored processes as the query method, keep
in mind that the report template that you select might include elements, such as
graphs, that do not apply to stored process output. 2

Managing Headers

Insert a Header
To insert a header that includes an image, text, or both into a layout, complete these
steps:
1 Click Header to open the Edit Header dialog box.
2 Select the name of an image in the Banner drop-down list and specify an
alignment.
Note: The images in this list are provided by your system administrator. A
3 Enter text into the Text field. You can type the text, you can select from the
Dynamic Text drop-down list, or you can use a combination of both methods.
If you use the Dynamic Text drop-down list, click Insert to insert the selected
text.

Note: After inserting a dynamic text item, type at least one character or space
before inserting another dynamic text item. A

Note: If you type a Web address (such as www.mycompany.com) or an e-mail
address (such as myname@mycompany.com), the text will automatically be
converted into a hyperlink. A

4 (Optional) Use the formatting tools to change the default font, font size, font style,
background color, foreground color, and alignment.

Note: Press ENTER between each paragraph. Text alignment is applied to the
currently selected paragraph. A
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5 (Optional) Select Include a horizontal line between the header and
report content.

6 When you are done, click OK.
7 Save the report.

Note: 'To collapse the Header section, click #. A

Modify a Header

To modify a header in a report, complete these steps:

1 Click Header to open the Edit Header dialog box.

2 Make your changes.
Note: For information about using the Edit Header dialog box, see “Insert a
Header” on page 130. A

3 When you are done, click oK.

4 Save the report.

Remove a Header

To remove a header from a report, complete these steps:
1 Click Header to open the Edit Header dialog box.

2 Clear the selections.

3 When you are done, click OK.

4 Save the report.

Managing Footers

Insert a Footer

To insert a footer into a layout, complete these steps:

1 Click Footer to open the Edit Footer dialog box.

2 Select the name of an image in the Banner drop-down list and specify an
alignment.
Note: The images in this list are provided by your system administrator. A

3 Enter text into the Text field. You can type the text, you can select from the
Dynamic Text drop-down list, or you can use a combination of both methods.

If you use the Dynamic Text drop-down list, click Insert to insert the selected

text.

Note: After inserting a dynamic text item, type at least one character or space
before inserting another dynamic text item. A

Note: If you type a Web address (such as www.mycompany.com) or an e-mail
address (such as myname@mycompany.com), the text will automatically be
converted into a hyperlink. A
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(Optional) Use the formatting tools to change the default font, font size, font style,
background color, foreground color, and alignment.

Note: Press ENTER between each paragraph. Text alignment is applied to the
currently selected paragraph. A

(Optional) Select Include a horizontal line between the footer and
report content.

When you are done, click oK.

Save the report.

Note: 'To collapse the Footer section, click #. A

Modify a Footer

To modify a footer in a report, complete these steps:

1
2

Click Footer to open the Edit Footer dialog box.
Make your changes.

Note: For information about using the Edit Footer dialog box, see “Insert a
Footer” on page 131. A

3 When you are done, click oK.

4 Save the report.

Remove a Footer

To remove a footer from a report, complete these steps:

1
2
3
4

Click Footer to open the Edit Footer dialog box.
Clear the selections.

When you are done, click OK.

Save the report.

Managing Group Breaks

Add Group Breaks

The number of group break levels that you can create depends on how many
categories or hierarchies there are in the report section. For example, if you have three
categories and two hierarchies, then you can specify four breaks, which means that you
will see one drop-down list for Break by values of and three drop-down lists for Then
by values of.

To specify group breaks, complete these steps:

1
2

Select Group Breaks » Edit Group Breaks to open the Group Breaks dialog box.
On the Group Breaks tab, complete these steps:
a Select the first group break level in the Break by values of list. The Break

by values of list contains all the categories and hierarchy levels in the report
section.
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b (Optional) Select additional group break levels from any available Then by
values of list.

¢ (Optional) Select a page break to go with each group break level. If you select
the page break option, the report displays a table of contents for navigation.

d Select a sort option for the category or hierarchy level values. The default is
Ascending.

e (Optional) Use the formatting tools to change the default font, font size, font
style, background color, and foreground color.

f (Optional) Select the Label each value option in order to label each group
break with its category or hierarchy name. If you include a dynamic measure
with one or more group breaks, then this option also applies to labeling
measures.

3 (Optional) On the Measure values tab, complete these steps:

a Select a group break in the For group break level drop-down list. The list
contains the group breaks that you selected on the Group Breaks tab.

b In the Show measure value list, select the measure value that you want
display for each group break level. For example, if you select Country as the
group break level, you might select Total Profit as the data item value. The
profit aggregated across each country will be displayed at each group break
level.

Note: If you remove the selected measure from the report, then the
measure value is removed from the group break. A

¢ Click Add to add your For group break level and Show measure value
selections to the Group break level/value box.
4 When you are done, click OK.

For reports that contain tables, graphs, or maps that have been filtered, drilled,
or expanded, these actions will be taken:

o Filters that are dependent on a data item that you have selected as a group
break will be removed from the filtered table, graph, or map.

0 Navigation (drilling or expanding) that has been performed on a data item that
you have selected as a group break will be removed from the drilled or
expanded table, graph, or map.

In addition, if you create a group break that is based on any level in a
geography hierarchy, then any map in the report section will become invalid.

5 (Optional) Link group breaks to another report or to a Web page (see “Managing
Report Linking for Group Break Values” on page 133).

6 Save the report.

Note: To collapse the Group Breaks section, click #. A

Managing Report Linking for Group Break Values

Add a Report Link to Group Break Values

To add a link to group break values, complete these steps:
1 Select Group Breaks » Report Linking to open the Report Linking dialog box.

2 In the Assign links to field, select the group breaks that you want to assign the
link to.

3 Select one of these Link destination options.
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An existing report
Navigate the folder tree to select the report that you want to link to. The
target report will be opened in the primary SAS Web Report Studio window.
A Return to previous report link will be available.

If the target report has prompts, you can click befine Prompts in order to
assign group break levels in the current report to prompts in the target
report. In the Define Prompts dialog box, for each group break listed in the
Data Items column, select a prompt in the Destination report prompts
drop-down list to assign that data item value to the selected prompt. When
the user clicks on the report link in the report, the selected data item value
will be used for the associated prompt. When you are done, click 0K to return
to the Report Linking dialog box.

Note: See “Tips for Defining Prompts in Report Linking” on page 155. A

A Web page
Type the URL for the Web page that you want to link to. The Web page will
be opened in a separate browser window.

4 (Optional) Type Tool-tip text for the link. You cannot use these characters: < >
& #

5 When you are done, click oK.
6 Save the report.

Note: For a report linking example, see Chapter 15, “Example: Linking a
High-Level Report to a Detailed Report,” on page 197. A

Remove a Report Link from Group Break Values

To remove a link from group break values, complete these steps:

-

Select Group Breaks » Report Linking to open the Report Linking dialog box.
In the Assign links to box, clear the options for one or more group breaks.

2
3 In the confirmation message box that appears, click ok.
4 When you are done, click OK.

5

Save the report.

Modify Group Breaks

To modify group breaks in a report, complete these steps:
1 Select Group Breaks » Edit Group Breaks to open the Group Breaks dialog box.
2 Make your changes.
Note: For information about using the Group Breaks dialog box, see “Add Group
Breaks” on page 132. A
3 When you are done, click oK.
4 Save the report.

Remove Measure Values from Group Breaks

To remove measure values from group breaks, complete these steps:
1 Select Group Breaks » Edit Group Breaks to open the Group Breaks dialog box.
2 Click the Measure values tab.
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3 Select an item in the Group break level/value box.
4 Click Remove.

5 When you are done, click oK.

6 Save the report.

Remove Group Breaks

To remove group breaks, complete these steps:
1 Select Group Breaks » Edit Group Breaks to open the Group Breaks dialog box.

2 Select None for the first level of group breaks that you want to remove. All
subsequent breaks will also be removed. For example, if four group break levels
are available, you can remove the second, third, and fourth group breaks by
selecting None as the second break.

3 When you are done, click oK.

4 Save the report.

Managing the Body Grid of a Layout

About the Body Grid

The Edit Report view contains a grid for placing and arranging objects in the body of
the report section. The grid consists of cells into which you place tables, graphs, maps,
stored processes, text, and images. By default, the body grid has these features:

O

It does not contain any report objects.

o It contains four cells.

0 Cell alignment is set to the upper left corner.
o

The drop-down list for making objects independent or synchronized is not available.

Display 10.1 A Body Grid That Does Not Contain Any Objects

il & B & L ks @ IIndependentObjects 'l

mg

Drag and drop a report object
here
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Before you add objects, you can add cells, merge cells, and delete empty cells. After
you add objects, you also can realign cell content, reposition objects, and synchronize
objects or make them independent.

Add Cells to the Body of a Report Section

To add more cells to the body grid, click these buttons on the vertical toolbar.

Button Action

Eﬂ splits a selected cell vertically
splits a selected cell horizontally

adds a row to the bottom of the grid

adds a column to the right side of the grid

= [0 E

Align Cell Content in the Body of a Report Section

To change the alignment of an object in a cell, select the object and then click one of
the alignment buttons on the vertical toolbar.

Button Action

------- aligns the content of the object to the top of the cell

aligns the content of the object to the bottom of the cell

aligns the content of the object to the left of the cell’

io
—
= aligns the content of the object to the right of the cell’

—:
T, aligns the content of the object to the middle of the cell
ul—l

i aligns the content of the object to the center of the cell
o |

1 This alignment setting does not apply to text objects, which instead use the alignment settings
in the Edit Text dialog box.

Delete an Empty Column or Row from the Body of a Report Section

You can delete empty columns and rows from the body grid. You cannot delete
individual empty cells or rows and columns that contain objects.
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To select the empty cells in a row or column, press CTRL while clicking on each cell.
To delete the selected cells, click #< on the vertical toolbar.

Delete Objects in the Body of a Report Section

To delete one or more objects from the body grid, complete these steps:
1 In the body grid, select the object or objects that you want to delete.
2 Click X on the vertical toolbar.

3 In the confirmation message box that appears, click OK.

Merge Cells in the Body of a Report Section

To merge two or more selected cells in the same row or column in the body grid, click
= on the vertical toolbar. You can merge empty cells or empty cells and one cell with
content.

Place Objects in the Body of a Report Section

These are the objects that you can place in the body of a report section. To place an
object, you can click on its button on the horizontal toolbar, or you can drag and drop
the object from the toolbar into a cell.

Toolbar Object Related Discussion
Button

list table “Insert a Table” on page 139

crosstabulation table

bar chart “Insert a Graph” on page 145

pie chart

line graph

bar-line chart

progressive bar
chart

FERN®E

2 ﬂg scatter plot

o

II.-_3 map “Insert a Map” on page 149

]

= text “Insert a Text Object” on page 151
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Toolbar Object Related Discussion
Button
image “Insert an Image” on page 153
@ stored process “Use Stored Processes” on page 125

Reposition Objects in the Body of a Report Section

You can drag and drop objects from one body grid cell to another.

If you attempt to drop new object into a cell that already contains an object, then a
warning message appears. If you click ok, then the current object will be replaced by
the moved object.

If you attempt to move an existing object into a cell that already contains an object,
then a warning message appears. If you click OK, then the current object will switch
places with the moved object.

Use Independent Objects in the Body of a Report Section

By default, report sections that are based on relational data sources contain
independent objects. The report section is set to contain independent objects as soon as
you select data items from the data source. If you change the data source to
multidimensional, then the objects in the report section automatically become
synchronized (unless the report section contains a stored process).

To make synchronized objects independent, select Independent Objects in the
drop-down list on the horizontal toolbar.

When you switch objects from synchronized to independent, the following actions are
taken on the individual tables, graphs, and maps:

o All filters and rankings are removed.

o All sorting is removed.

o Tables, graphs, and map are reset to the highest level drill state.

Use Synchronized Objects in the Body of a Report Section

For report sections that use data items from a data source, you can synchronize the
objects that you insert into the body. Synchronized tables and graphs will share
category or hierarchy filters, sorting (but not prioritizing), drilling, and expanding.
Tables, graphs, and maps will share filters, drilling, and expanding.

By default, report sections that are based on multidimensional data sources contain
synchronized objects. The report section is synchronized as soon as you select data
items from the data source. If you change the data source to relational, then the objects
in the report section automatically become independent.

To synchronize objects that are currently independent, select Synchronized
Objects in the drop-down list on the horizontal toolbar.

Note: This menu option is not available if the body of your report section contains a
stored process. A

When you switch objects from independent to synchronized, the following actions are
taken on any tables, graphs, and maps:
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All filters and rankings are removed.

All sorting is removed.

Tables, graphs, and maps are reset to the highest level drill state.
Any percent of total columns are removed.

In both the Edit Report view and the View Report view, synchronized objects are
grouped within a shaded box. In the View Report view, the report is displayed with a
data pane that can be used to modify the data selections (see “Managing the Data Used
for Synchronized Report Sections” on page 74).

Managing Tables

Insert a Tabhle

To insert a table into your report, complete these steps:
1 Depending on which type of table you want to insert, perform one of these tasks:

O

O

To insert a list table for a relational data source, click == on the horizontal
toolbar.

To insert a crosstabulation table for a relational or multidimensional data
source, click [ on the horizontal toolbar.

2 (Optional) Perform one or more of these tasks:

Note: With the exception of report linking, these tasks also can be performed in
the View Report view. A

O

O

Change the default data item assignments (see “Specifying How Data Items Are
Used in Tables” on page 49).

Change the default properties (see “Set Properties for a Table” on page 86).
Add conditional highlighting to table values (see “Managing Conditional
Highlighting for Table Values” on page 82).

Filter or rank table values (see “Managing Filtering and Ranking in a List
Table” on page 51 or “Managing Filtering and Ranking in a Crosstabulation
Table” on page 53).

Add a percent of total column to the table (see “Managing Percent of Total
Columns in a Table” on page 56).

Link table values to another report or to a Web page (see “Managing Report
Linking in Tables” on page 143).

Show or hide totals (see “Show or Hide Totals in a Table” on page 58).

3 Save the report.

Specify How Data Items Are Used in Tables

To assign data items to specific functions in a table, such as columns and rows, you
use the Table Data dialog box. To open the Table Data dialog box, click @ on a table

toolbar.

For information about how to use the Table Data dialog box for the type of table that
you selected, see these topics:

O “Assign Data Items to Functions in a Crosstabulation Table” on page 49
0 “Assign Data Items to Functions in a List Table” on page 49
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Managing Conditional Highlighting for Tables

About Conditional Highlighting for Multidimensional Data

In general, there are two types of rules that you can create:

0 Rules that compare a measure to a fixed value. For example, you might create a
rule for Sales > 1000.

O Rules that compare one measure value relative to another measure value. For
example, you might create a rule for Sales > Budget.
SAS Web Report Studio processes these rules in the following ways:

o For the first type of rule, the condition is applied at the current level of the data
source. For example, if you drill down into the data and then specify conditional
highlighting, then the condition applies to the level that is currently displayed.

o0 For the second type of rule, the condition is applied at all levels of the data source,
regardless of the current level.

Add Conditional Highlighting to Table Values

You specify conditional highlighting in the Conditional Highlighting dialog box. To
open the dialog box, click on the table toolbar, and then select Conditional
Highlighting.

For information about how to use the Conditional Highlighting dialog box, see “Add
Conditional Highlighting to Table Values” on page 82.

Modify Conditional Highlighting for Tahle Values

To modify conditional highlighting for values in a table, complete these steps:

1 On the table toolbar, click £, and then select Conditional Highlighting to
open the Conditional Highlighting dialog box.

2 In the Rules list, select a rule.

3 Click Edit.

4 Make your changes on the Rule tab, the Color and Font tab, and the Image and
Text tab, and then click OK.

Note: For information about how to use the tabs, see “Add Conditional
Highlighting to Table Values” on page 82. A

5 To hide the tabs, click oK.

6 To close the Conditional Highlighting dialog box, click OK.

7 Save the report.

Remove Conditional Highlighting from Table Values

To remove conditional highlighting from table values, complete these steps:

1 On the table toolbar, click £, and then select Conditional Highlighting to
open the Conditional Highlighting dialog box.

In the Rules list, select a rule.

Click Delete.

In the confirmation message box that appears, click oK to delete the rule.
When you are done, click OK.

S Ol A W N

Save the report.
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Managing Filtering and Ranking in Crosstabulation Tables

Create a Category or Hierarchy Filter for a Crosstabulation Table

You create category and hierarchy filters on the Category Filters tab in the Filter
and Rank dialog box. To open the dialog box, click &+ on the table toolbar, and then
select Filter and Rank.

For information about how to complete the tab, see “Create a Category or Hierarchy
Filter for a Crosstabulation Table” on page 53.

Create a Measure Filter or Ranking for a Crosstabulation Table

You cannot create measure filters or rankings for crosstabulation tables in the Edit
Report view. If there are existing measure filters or rankings (which might be true if
you are editing an existing report), then the Measure Filter or Rank tab lists the
filters or rankings.

For information about how to remove existing filters or rankings, see “Remove
Existing Measure Filters or Rankings from a Crosstabulation Table” on page 141

Remove a Category or Hierarchy Filter from a Crosstabulation Table

To remove a category or hierarchy filter from a crosstabulation table, complete these
steps:
1 On the table toolbar, click &%, and then select Filter and Rank to open the Filter
and Rank dialog box.

2 Click the category Filters tab.

3 For each data item that should not be filtered, select No filter as the Filter
Type.

4 When you are done, click OK.

5 Save the report.

Remove Existing Measure Filters or Rankings from a Crosstabulation Table

To remove existing filters or rankings, complete these steps:

1 On the table toolbar, click %, and then select Filter and Rank to open the Filter
and Rank dialog box.

Click the Measure Filter or Rank tab.

2
3 Select the Delete Filters or Rankings option.
4 When you are done, click OK.

5

Save the report.

Managing Filtering and Ranking in List Tables

Create a Filter or Ranking for a List Tahle

You create filters and rankings in the Filter and Rank dialog box. To open the dialog
box, click on the table toolbar, and then select Filter and Rank:

For information about how to create specific types of filters, see “Create a Filter or
Ranking for a List Table” on page 51.
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Note: For a filter example, see “Example 1: Filtering an Alphanumeric Category in
a List Table” on page 203. A

Remove a Filter or Ranking from a List Table

To remove a filter or ranking from a list table, complete these steps:
1 On the list table toolbar, click &%, and then select Filter and Rank.

2 For each data item that should not be filtered, select No filter as the Filter
type.

3 When you are done, click oK.

4 Save the report.

Managing Percent of Total Columns

Add a Percent of Total Column to a Table

You specify percent of total value criteria in the Percent of Total Value dialog box. To
open the dialog box, click =+ on the table toolbar, and then select Percent of Total.

Note: This menu item is not available if the table does not contain any measures
that can be used in a grand total; if the table is in a synchronized group; or if the table
uses multidimensional data. A

For information about how to use the Percent of Total dialog box, see “Add a Percent of
Total Column to a Table” on page 56.

Remove a Percent of Total Column from a Table

To remove a percent of total column from a table, complete these steps:
1 On the table toolbar, click &%, and then select Percent of Total.
2 In the Percent of Total dialog box, select a calculation.

3 Click Remove.

4 When you are done, click OK.

5 (Optional) Save the report.

Note: 1If you remove a percent of total value column from a crosstabulation table,
then any row filters and rankings that are based on a column measure are removed. A
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Managing Report Linking in Tables

Add a Report Link to Table Values

To add a link to values in a table, complete these steps:

1

On the table toolbar, click £+, and then select Report Linking to open the Report
Linking dialog box.

Select the Include report links in the table option to enable the rest of the
items in the dialog box.

Select one of these Link destination options.

An existing report

Navigate the folder tree to select the report that you want to link to. The
target report will be opened in the primary SAS Web Report Studio window.
A Return to previous report link will be available.

If the target report has prompts, you can click befine Prompts in order to
assign values in the table to prompts in the target report. In the Define
Prompts dialog box, for each category or hierarchy level that is listed in the
Data Items column, select a prompt in the Destination report prompts
drop-down list to assign that data item value to the selected prompt. When
the user clicks on the report link in the report, the selected data item value
will be used for the associated prompt. When you are done, click OK to return
to the Report Linking dialog box.

Note: See “Tips for Defining Prompts in Report Linking” on page 155. A

A Web page

If you are linking to a Web page, then type the URL for the Web page that you
want to link to. The Web page will be opened in a separate browser window.

4 (Optional) Type Tool-tip text for the link. You cannot use these characters: < >

5 When you are done, click OK.

6 Save the report.

Note:

For a report linking example, see Chapter 15, “Example: Linking a

High-Level Report to a Detailed Report,” on page 197. A
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Remove a Report Link from Table Values

To remove a link from values in a table, complete these steps:

1 On the table toolbar, click &%, and then select Report Linking to open the Report
Linking dialog box.

Clear the Include report links in the table option.
In the confirmation message box that appears, click OK.
When you are done, click OK.
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Save the report.

Set Properties for a Table

You set properties for a table in the Table Properties dialog box. To open the dialog
box, click & on the table toolbar.

For information about how to set properties for a table, see “Set Properties for a
Table” on page 86.

Show or Hide Totals

You specify total options in the Total dialog box. To open the dialog box, click on
the table toolbar, and then select Total.

For information about using the Total dialog box, see “Show or Hide Totals in a
Table” on page 58.

Remove a Table

To remove a table from a layout, complete these steps:

1 Select the table object.

2 Click # on the vertical toolbar.

3 In the confirmation message box that appears, click ok.
4 Save the report.
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Managing Graphs

Insert a Graph

To insert a graph into your report, complete these steps:

Note:

If you selected either of the detail data options in the Aggregate or Detail

dialog box (see “Use Detail Data Instead of Grouped and Aggregated Data” on page
118), then the only graph type available to insert is a scatter plot. A

1 Depending on the type of graph that you want to insert, perform one of these tasks:

O

o o o o o

To insert a bar chart, click kil on the horizontal toolbar.

To insert a bar-line chart, click ¥ on the horizontal toolbar.

To insert a pie chart, click @ on the horizontal toolbar.

To insert a line graph, click 2 on the horizontal toolbar.

To insert a scatter plot, click B on the horizontal toolbar.

To insert a progressive bar chart, click 2 on the horizontal toolbar.

(Optional) Perform one or more of these tasks:

Note: With the exception of report linking, these tasks also can be performed in
the View Report view. A

O

Change the default data item assignments (see “Specifying How Data Items Are
Used in Graphs” on page 61).

Change the default properties (see “Managing Properties for Graphs” on page
91).

Add conditional highlighting to graph values (see “Managing Conditional
Highlighting for Graph Values” on page 88).

Filter or rank graph values (see “Managing Filtering and Ranking in a Graph”
on page 67).

Link graph values to another report or to a Web page (see “Managing Report
Linking for Graphs” on page 147).

3 Save the report.

Specify How Data Items Are Used in Graphs

To assign data items to specific functions in a graph, such as bar height and marker
group, you use the Graph Data dialog box. To open the Graph Data dialog box, click &
on the graph toolbar.

For information about how to use the Graph Data dialog box for the type of graph
that you selected, see these topics:

O

Oo o o o d

“Assign Data Items to Functions in a Bar Chart” on page 61

“Assign Data Items to Functions in a Bar-Line Chart” on page 62

“Assign Data Items to Functions in a Line Graph” on page 63

“Assign Data Items to Functions in a Pie Chart” on page 63

“Assign Data Items to Functions in a Progressive Bar Chart” on page 64

“Assign Data Items to Functions in a Scatter Plot” on page 65
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Managing Conditional Highlighting for Graph Values

Add Conditional Highlighting to Graph Values

You specify conditional highlighting in the Conditional Highlighting dialog box. To
open the dialog box, click &+ on the graph toolbar, and then select Conditional
Highlighting.

For information about how to use the Conditional Highlighting dialog box, see “Add
Conditional Highlighting to Graph Values” on page 88.

Modify Conditional Highlighting for Graph Values

To modify conditional highlighting for values in a graph, complete these steps:

1 On the graph toolbar, click (%, and then select Conditional Highlighting to
open the Conditional Highlighting dialog box.

2 Make the changes.
Note: For information about how to use the Conditional Highlighting dialog box,
see “Add Conditional Highlighting to Graph Values” on page 88. A

3 When you are done, click OK.

4 Save the report.

Remove Conditional Highlighting from Graph Values

To remove conditional highlighting from graph values, complete these steps:

1 On the graph toolbar, click (%, and then select Conditional Highlighting to
open the Conditional Highlighting dialog box.

2 Click Clear.
3 When you are done, click OK.
4 Save the report.

Managing Filtering and Ranking for Graphs

Create a Category or Hierarchy Filter for a Graph

You create category or hierarchy filters on the Category Filters tab in the Filter
and Rank dialog box. To open the dialog box, click & on the graph toolbar, and then
select Filter and Rank.

For information about how to complete the category Filters tab, see “Create a
Category or Hierarchy Filter for a Graph” on page 67.

Create a Measure Filter for a Graph

Note: The Measure Filter or Rank tab is not available if the graph is part of a
synchronized group. A

You create measure filters on the Measure Filter or Rank tab in the Filter and
Rank dialog box. To open the dialog box, click &+ on the graph toolbar, and then select
Filter and Rank.

For information about how to complete the Measure Filter or Rank tab, see
“Create a Measure Filter for a Graph” on page 68.
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Create a Ranking for a Graph

Note: The Measure Filter or Rank tab is not available if the graph is part of a
synchronized group. A

You create rankings on the Measure Filter or Rank tab in the Filter and Rank
dialog box. To open the dialog box, click &+ on the graph toolbar, and then select
Filter and Rank.

For information about how to complete the Measure Filter or Rank tab, see
“Create a Ranking for a Graph” on page 69.

Remove a Category or Hierarchy Filter from a Graph

To remove a category or hierarchy filter from a graph, complete these steps:

1 On the graph toolbar, click £and select Filter and Rank to open the Filter and
Rank dialog box.

2 On the category Filters tab, for each data item that should not be filtered,
select No filter as the Filter Type.

3 When you are done, click OK.
4 Save the report.

Remove a Measure Filter or Ranking from a Graph

To remove a measure filter or ranking from a graph, complete these steps:

1 On the graph toolbar, click £and select Filter and Rank to open the Filter and
Rank dialog box.

2 On the Measure Filter or Rank tab, select No measure filter or rank.
3 When you are done, click OK.
4 Save the report.

Managing Report Linking for Graphs

Add a Report Link to Graph Values

To add a link to values in a graph, complete these steps:

1 On the graph toolbar, click (%, and then select Report Linking to open the
Report Linking dialog box.

2 Select the Include report links in the graph option to enable the rest of the
items in the dialog box.

3 Select one of these Link destination options.

An existing report
Navigate the folder tree to select the report that you want to link to. The
target report will be opened in the primary SAS Web Report Studio window.
A Return to previous report link will be available.

If the target report has prompts, you can click Define Prompts to assign
values in the graph to prompts in the target report. In the Define Prompts
dialog box, for each category or hierarchy level that is listed in the pata
Items column, select a prompt in the Destination report prompts
drop-down list to assign that data item value to the selected prompt. When
the user clicks on the report link in the report, the selected data item value
will be used for the associated prompt. When you are done, click OK to return
to the Report Linking dialog box.
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4

5
6

Note: See “Tips for Defining Prompts in Report Linking” on page 155. A

A Web page
If you are linking to a Web page, then type the URL for the Web page that you
want to link to. The Web page will be opened in a separate browser window.

(Optional) Type Tool-tip text for the link. You cannot use these characters: < >
& #

When you are done, click OK.

Save the report.

Note: For a report linking example, see Chapter 15, “Example: Linking a
High-Level Report to a Detailed Report,” on page 197. A

Remove a Report Link from Graph Values

To remove a link from values in a graph, complete these steps:

1
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On the graph toolbar, click (%, and then select Report Linking to open the
Report Linking dialog box.

Clear the Include report links in the graph option.
In the confirmation message box that appears, click OK.
When you are done, click OK.

Save the report.

Set Properties for a Graph

You set properties for a graph in the Graph Properties dialog box. To open the dialog
box, click ™ on the graph toolbar.

For information about how to set properties for each type of graph, see the following
topics:

O

“Set Properties for a Bar Chart” on page 91

0 “Set Properties for a Bar-Line Chart” on page 93

O 0o o o

“Set Properties for a Line Graph” on page 94

“Set, Properties for a Pie Chart” on page 95

“Set Properties for a Progressive Bar Chart” on page 96
“Set Properties for a Scatter Plot” on page 97
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Remove a Graph
To delete a graph, complete these steps:
1 Select the graph object.
2 Click # on the vertical toolbar.

3 In the confirmation message box that appears, click ok.
4 Save the report.

Managing Maps

Insert a Map

If the current report section is using data items from a multidimensional data source
that is enabled for geographic mapping and that contains a geography hierarchy, then
you can insert a map into the layout.

Note: For information about selecting data items from a data source, see “Overview
of Obtaining Data for a Report Section” on page 107. A

Complete these steps:
1 Click @ on the horizontal toolbar.
Note: Each report section can have only one map. A
2 (Optional) Perform one or more of these tasks:
Note: These tasks also can be performed in the View Report view. A

0 Change the default measure assigned to the map (see “Select a Measure for a
Map” on page 150).

0 Change the default properties (see “Set Properties for a Map” on page 98).

o Filter or rank map values (see “Managing Filtering and Ranking in a Map” on
page 72).

3 Save the report.

Managing Filtering and Ranking for Maps

Create a Filter for the Geography Hierarchy in a Map

You create the geography hierarchy filter on the Category Filters tab in the Filter
and Rank dialog box. To open the dialog box, click & on the map toolbar, and then
select Filter and Rank.

For information about how to complete the Category Filters tab, see “Create a
Filter for the Geography Hierarchy in a Map” on page 72.

Create a Measure Filter for a Map

Note: The Measure Filter or Rank tab is not available if the map is part of a
synchronized group. A
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You create measure filters on the Measure Filter or Rank tab in the Filter and
Rank dialog box. To open the dialog box, click on the map toolbar, and then select
Filter and Rank.

For information about how to complete the Measure Filter or Rank tab, see
“Create a Measure Filter for a Map” on page 72.

Create a Ranking for a Map

Note: The Measure Filter or Rank tab is not available if the map is part of a
synchronized group. A

You create rankings on the Measure Filter or Rank tab in the Filter and Rank
dialog box. To open the dialog box, click E+ on the map toolbar, and then select Filter
and Rank.

For information about how to complete the Measure Filter or Rank tab, see
“Create a Ranking for a Map” on page 72.

Remove a Geography Hierarchy Filter from a Map

To remove a category or hierarchy filter from a map, complete these steps:

1 Click on the map toolbar, and then select Filter and Rank to open the Filter
and Rank dialog box.

2 On the category Filters tab, select the geography hierarchy, and then select No
filter.

3 When you are done, click oK.
4 Save the report.

Remove a Measure Filter or Ranking from a Map

To remove a measure filter or ranking from a map, complete these steps:

1 Click &+ on the map toolbar, and then select Filter and Rank to open the Filter
and Rank dialog box.

2 On the Measure Filter or Rank tab, select No measure filter or rank.
3 When you are done, click OK.
4 Save the report.

Select a Measure for a Map

To specify the measure that you want to use for a map, complete these steps:

Note: This task can be performed in the View Report view by selecting a measure
from the drop-down list in the map legend. A

1 On the map toolbar, click =)

2 In the Map Data dialog box, select a measure in the drop-down list.

3 When you are done, click oK.

4 Save the report.

Set Properties for a Map

You set properties for a map in the Map Properties dialog box. To open the dialog
box, click ™ on the map toolbar.
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For information about how to set properties for a map, see “Set Properties for a Map”
on page 98.

Remove a Map

To delete a map, complete these steps:

1 Select the map object.

2 Click ¥ on the vertical toolbar.

3 In the confirmation message box that appears, click OK.
4 Save the report.

Managing Text Objects

Insert a Text Object

To insert a text object into your report, complete these steps:
1 Click [A] on the horizontal toolbar.

2 On the text object toolbar, click £, and then select Edit Text to open the Edit
Text dialog box.

3 Enter text into the text box. There are three methods that you can use, and you
can use a combination of all three methods.

o You can type the text.

Note: You can link selected text to another report or a Web page as explained
in “Add a Report Link to Text” on page 152. If you type a Web address (such as
www.mycompany .com) or an e-mail address (such as myname@mycompany . com),
the text will automatically be converted into a hyperlink. A

O You can insert a measure value.

Select the name of the measure in the Measure value drop-down list, and
then click Insert to place the measure name into the text box at the insertion
point. Type at least one character or one space before entering any additional
measure value. The text object in the rendered report will display the
aggregated value of the measure.

Note: If you remove the inserted measure from the report, then the measure is
also removed from the text object. A

0 You can insert a prompt value.

Select the name of the prompt in the Prompt value drop-down list, and then
click Insert to place the prompt name into the text box at the insertion point.
Type at least one character or one space before entering any additional prompt
value. The text object in the rendered report will display the value that you
enter for the prompt.

Note: You can always type text, but the availability of prompts and measures
depends on the data items that are selected for the report section. A

4 (Optional) Use the formatting tools to change the default font, font size, font style,
background color, foreground color, and alignment.
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Note: Press ENTER between each paragraph. Text alignment is applied to the
currently selected paragraph. A

5 (Optional) If the report section has group breaks, link selected text to another

report or to a Web page (see “Managing Report Linking for Text” on page 152).

6 When you are done, click oK.

7 Save the report.

Managing Report Linking for Text

Add a Report Link to Text
To add a link to selected text, complete these steps:

1

On the text object toolbar, click £, and then select Edit Text to open the Edit
Text dialog box.

Select the text that you want to convert into a hyperlink. The text must not
include measure or prompt values or any formatting. Also, do not select all the
text in the paragraph.

Click ® to open the Report Linking dialog box.
Select the Make text a link option to enable the rest of the items in the dialog

Select one of these Link destination options.

An existing report

Navigate the folder tree to select the report that you want to link to. The
target report will be opened in the primary SAS Web Report Studio window.
A Return to previous report link will be available.

If the target report has prompts, you can click befine Prompts to assign
group break levels in the current report to prompts in the target report. In
the Define Prompts dialog box, for each group break listed in the Data Items
column, select a prompt in the Destination report prompts drop-down list
to assign that data item value to the selected prompt. When the user clicks
on the report link in the report, the selected data item value will be used for
the associated prompt. When you are done, click Ok to return to the Report
Linking dialog box.

Note: See “Tips for Defining Prompts in Report Linking” on page 155. A

A Web page

If you are linking to a Web page, then type the URL for the Web page that
you want to link to. (SAS Web Report Studio does not validate the URL that
you enter.) The Web page will be opened in a separate browser window.

Note: If you type a Web address (such as www.mycompany.com) or an
e-mail address (such as myname@mycompany.com), the text will automatically
be converted into a hyperlink. A

6 (Optional) Type Tool-tip text for the link. You cannot use these characters: < >

7 When you are done, click OK.
8 To close the Edit Text dialog box, click oK.
9 Save the report.

Note:

For a report linking example, see Chapter 15, “Example: Linking a

High-Level Report to a Detailed Report,” on page 197. A
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Remove a Report Link from Text

To remove a link from text, complete these steps:

1
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On the text object toolbar, click &, and then select Edit Text to open the Edit
Text dialog box.

Click anywhere in the linked text.

Click ® to open the Report Linking dialog box.

Clear the Make text a link option.

In the confirmation message box that appears, click OK.
To close the Report Linking dialog box, click OK.

To close the Edit Text dialog box, click OK.

Save the report.

Modify a Text Object

To modify a text object in a report, complete these steps:

1

On the text object toolbar, click £, and then select Edit Text to open the Edit
Text dialog box.

Make your changes.

Note: For information about using the Edit Text dialog box, see “Insert a Text
Object” on page 151. A

When you are done, click OK.
Save the report.

Remove a Text Object
To delete a text object, complete these steps:

1

2
3
4

Select the text object.

Click # on the vertical toolbar.
In the confirmation message box that appears, click OK.
Save the report.

Managing Images

Insert an Image

To insert an image into your report, complete these steps:

1
2

Click on the horizontal toolbar.

On the image toolbar, click %, and then select Edit Image to open the Select
Image dialog box.

Select the image from one of the following locations:
Repository

Select this option to choose an image that is stored on the same server as the
reports. Select an image to see it displayed in the Selected image field.
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Local machine
Select this option to choose an image from your local machine. The path to the
selected image appears in the Image field. Choose a repository location for the
image by using the Store image in field. To create a new folder, click ¥l If
you select an image from your local machine, it is saved to the repository.

Note: If you are authorized to save reports, you should be able to save
images to the repository. If you cannot save images, contact your system
administrator. A

4 Specify a size for the selected image. The user-defined selections are Set height
(maintain scale), Set width (maintain scale), and Set width and
height.

5 (Optional) For Tool-tip text, type up to 60 characters that will appear when the
user places the pointer over the image. You cannot use these characters: < > & #

6 When you are done, click oK.

7 (Optional) If the report section has group breaks, link the image to another report
or to a Web page (see “Managing Report Linking for Images” on page 154).

8 Save the report.

Managing Report Linking for Images

Add a Report Link to an Image

To add a link to an image, complete these steps:

1 On the image toolbar, click (%, and then select Report Linking to open the
Report Linking dialog box.

2 Select the Assign link to this image option to enable the rest of the items in
the dialog box.

3 Select one of these Link destination options.

An existing report
Navigate the folder tree to select the report that you want to link to. The
target report will be opened in the primary SAS Web Report Studio window.
A Return to previous report link will be available.

If the target report has prompts, you can click Define Prompts to assign
group break levels in the current report to prompts in the target report. In
the Define Prompts dialog box, for each group break listed in the pata Items
column, select a prompt in the Destination report prompts drop-down list
to assign that data item value to the selected prompt. When the user clicks
on the report link in the report, the selected data item value will be used for
the associated prompt. When you are done, click oK to return to the Report
Linking dialog box.

Note: See “Tips for Defining Prompts in Report Linking” on page 155. A
A Web page

If you are linking to a Web page, then type the URL for the Web page that you
want to link to. The Web page will be opened in a separate browser window.

4 (Optional) Type Tool-tip text for the link. You cannot use these characters: < >
& #

5 When you are done, click oK.
6 Save the report.
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Note: For a report linking example, see Chapter 15, “Example: Linking a
High-Level Report to a Detailed Report,” on page 197. A

Remove a Report Link from an Image

To remove a link from an image, complete these steps:

1 On the image toolbar, click &%, and then select Report Linking to open the
Report Linking dialog box.

Clear the Assign link to this image option.
In the confirmation message box that appears, click OK.

When you are done, click OK.
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Save the report.

Remove an Image

To delete an image, complete these steps:

1 Select the image object.

2 Click # on the vertical toolbar.

3 In the confirmation message box that appears, click ok.
4 Save the report.

Replace an Image

To change an image in a report, complete these steps:

1 On the image toolbar, click %, and then select Edit Image to open the Select
Image dialog box.

2 Select a different image.

Note: For information about using the Select Image dialog box, see “Insert an
Image” on page 153. A

3 When you are done, click OK.
4 Save the report.

Tips for Defining Prompts in Report Linking

Here are some tips for defining prompts in report linking:
o0 You can define prompts only when the target report uses relational data.

o SAS Web Report Studio does not check that your associations make sense, so make
sure that you assign an appropriate data item value to each prompt. For example,
you might link a Product Name group break in the primary report to a prompt for
Product Name in the target report, but you would not link a Gender group break
to a prompt for Order Year.

0 If you assign a value to each prompt in the target report, then the prompt window
is bypassed when the user clicks the link in the primary report. If you do not
assign a value to each prompt in the target report, then the prompt window will
appear. The user can then confirm the current prompt values or enter new ones.
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o If you remove or hide a category or hierarchy that is being used in a report linking
prompt, then the prompt association is removed. The link to the target report will
still work but the user will have to answer the prompts in order to display the
target report.

o If you link to a report that is manually refreshed, the prompt values sent from the
primary report are not used for the target report. Instead, SAS Web Report Studio
will display the results of the last query run for the target report.
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Managing Report Sections

A report can be divided into one or more sections. Each section can use a different
query method and have a different layout.

This chapter explains how to add new sections to an existing report, rename sections,
delete sections, and reorder sections.

Add a New Section to a Report

To add a new section to a report, complete these steps:

1 Select Section » New to open the New Section dialog box.

2 Type a name for the new section.

3 Choose whether to Get new data or Copy data from an existing section.

Note: The option to copy data from an existing section only applies to data items
selected from a data source. A

4 Choose whether to Copy header from an existing section or to leave the header
blank.

5 Choose whether to Copy footer from an existing section or to leave the footer
blank.

6 When you are done, click OK.

7 If you chose the Get new data option, then select the data items for the new
section (see Chapter 9, “Obtaining Data for a Report Section,” on page 107).

8 Design the layout of the new section (see Chapter 10, “Designing the Layout of a
Report Section,” on page 127).

9 Save the report.
Note: New report sections that are added to reports that were originally created in

SAS Enterprise Guide do not include a static report creation date in the printed
output. A
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Rename a Report Section

To rename a report section, complete these steps:
1 Select the tab for the section that you want to rename.
Select Section » Rename.

2
3 In the Rename Section dialog box, type the new name.
4 When you are done, click OK.

5

Save the report.

Reorder Report Sections

To change the order in which the report sections appear, complete these steps:
1 Select Section » Reorder.

2 In the Reorder Sections dialog box, move the sections.

3 When you are done, click OK.

4 Save the report.

Delete a Report Section

To delete a section from a report, complete these steps:
1 Click the tab for the section that you want to delete.
2 Select Section » Delete.

Note: The Delete option is not available if the report has only one section. A

3 In the confirmation message box that appears, click oK to delete the section.

Navigate Report Sections

Reports have a tab for each section. To switch between report sections, click the tab
for the section that you want to see.
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Overview of Managing Reports

This chapter documents the following tasks that require authorization:
O save, copy, move, rename, organize, and delete reports

archive reports

publish reports to publication channels

share or hide reports

O o o o

schedule reports
0O distribute reports via e-mail as a PDF file attachment or embedded HTML

This chapter also documents these tasks, which can be performed by all users:
O export reports and report data
O print reports

Exporting Reports and Report Data

Export the Contents of an Entire Report

To export the entire contents of a viewed report, complete these steps:

1 To create the zipped file that contains all the necessary reporting elements, select
Report » Export.

2 When prompted, choose to open the zipped file directly or to save it to a location
such as your hard drive or a networked drive.

3 Extract the report files to a folder in a location such as your hard drive or a
networked drive.

After the extraction, the folder will contain the following contents:

O sasExport files contains the auxiliary files needed to display the report. You
do not interact with the files in this folder.

O sasExport.html enables you to open the report in a Web browser.
O sasExport.xls enables you to open the report in a Microsoft Excel spreadsheet.
Note: When opening files in Microsoft Excel, you might receive a warning that

the files are not in the expected location. Click Yes in the message box to
acknowledge the warning. A

Export Data from a Graph

In the View Report view, click [&” on the graph toolbar. When prompted, choose to
open the Microsoft Excel file or save it.

Export Data from a Map

In the View Report view, click [=" on the map toolbar. When prompted, choose to open
the Microsoft Excel file or save it.
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Export Data from a Report Section

To export data from a report section that uses data items from a data source,
complete these steps in the Edit Report view:

1 Select Options » Preview Data to display the Preview Data dialog box.

3 Preview Data - Microsoft Internet Explorer i ] 4]
Export | ‘ Close Window | Help |
Customer_Group Customer_Type Customer_Aze_Group | Customer Spend
Crion Club Gold Crrion Club Gold members high
mermbers activity 15-30 years 3,340,791 .76
Crion Club Gold Crrion Club Gold members high
mermbers activity 31-45 years 2 637 444 .50
Crion Club Goald Crrion Club Gold members high
mermbers activity 46-60 years $2,315,454 41
Crion Cluby Gald Crrion Club Gold members high
mermbers activity 51-75 years 1,944 ,285.92
Orion Club Gold Crion Club Gold members low
mermbers activity 15-30 years §1,454,534.04
Orion Club Gald Oian Cluby Gold members low
members activity 31-45 years $1,101,132.72
Orion Club Gold Crion Club Gold members low
mermbers activity 46-60 years 1,095,195 .48
Orion Club Gald Oian Cluby Gold members low
members activity 61-75 years $699,3525.99 =
;l

2 Click Export.
3 When prompted, choose to open the Microsoft Excel file or save it.
4 To close the dialog box, click Close Window.

Export Data from a Table

To export data from a table, complete these steps in the View Report view:
1 Click =" on the table toolbar to open the Export dialog box.
2 Select one of these export options:

Data with formats (Microsoft Excel file)

Select this option to export the table to a Microsoft Excel file that has
formatting applied (such as fonts and colors).

Data only (tab-delimited text)
Select this option to export the table to a Microsoft Excel file that has no
formatting applied.

3 To export the data, click OK.
4 When prompted, choose to open the Microsoft Excel file or save it.

Export Detail Data from a Crosstabulation Table

To export detail data from a crosstabulation table that is based on multidimensional
data, complete these steps in the View Report view:

1 Perform one of these tasks to open the View Detail dialog box:

O To see the detail data behind a value in the crosstabulation table, click the
value (which will be underlined).



164

Scheduling and Distributing Reports A Chapter 12

Note: If report linking has been enabled for the values in the crosstabulation
table, then, when you click on a value, you will be prompted to either view
detail data or follow the report link. A

O To see the detail data behind a row or a column in the crosstabulation table,
click the row or column heading in the innermost hierarchy level in the row or
column, and then select Vview Detail.

Display 12.1 View Detail Option for the Revenue Column

Product Line Clothes & Shoes
(rder Channel | Retail Sale |Catalog Sale |Internet Sale
Revenue Revenue Revenue
Year Sort Ascending

[+ 3] 1998 §2.057 fi56.42 | §22657665| |Yort Descending
(+/3] 1999 $2217 BEGEE | §242.252 67
& 2000 2770230 64 | $265.604.2 Move Measures to Rows
(]3] 2001 $2245 TROFT | $245857.14
[+ 3] 2002 $2E76.535.35 | §105727 62

Fitter by this Column
Ranlk by this Column

View Detail m

Rotate Table

2 In the View Detail dialog box, click Export.

3 When prompted, choose to open the Microsoft Excel file or save it.

4 To close the dialog box, click cClose Window.

Note: You cannot view detail in a crosstabulation table if the data source has not
been set up to support this feature by your data source administrator. In addition,

whether the columns show the column label or the column name is controlled by an
administrator. A

Scheduling and Distributing Reports

Schedule a Report, a Stored Process, or a Folder

For faster rendering, you can schedule a time for queries to be pre-generated for
selected reports and stored processes, including an entire folder of reports.

To schedule a selected report, stored process, or folder, you use the Schedule Report
Wizard. To launch the wizard, perform one of these tasks:

0 When a report or stored process is displayed in the View Report view, select
Report » Schedule.

0 In the Report Management page, next to the name of the report, stored process, or

folder that you want to schedule, click =l in the Actions column, and then select
Schedule.

Note: When you schedule a stored process, SAS Web Report Studio saves the results
in a report with the same name as the stored process. The report is saved in the same
folder as the stored process. A
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For information about how to use the Schedule Report Wizard, click Help on any
wizard page.

Note: The scheduling feature is not available if a scheduling server is not available
or if you do not have authorization to schedule reports. A

Distribute a Report

To distribute a report via e-mail as a PDF file attachment or embedded HTML, you
use the Distribute Report Wizard.

Note: The output is external only; it is not saved to the report repository. o

To launch the wizard, perform one of these tasks:
O When a report is displayed in the View Report view, select Report » Distribute.
0 From the Report Management page, next to the name of the report that you want

to distribute, click =l in the Actions column, and then select Distribute.

For information about how to use the Distribute Report Wizard, click Help on any
wizard page.

Note: The distribution feature is not available if a scheduling server is not available
or if you do not have authorization to distribute reports. A

View a List of Scheduled and Distributed Reports

To view a list of the reports that you have scheduled by using the Schedule Report
Wizard or distributed by using the Distribute Report Wizard, complete these steps:

1 Click Manage in the upper right corner of the user interface to access the Report
Management page.

2 Click view scheduled and distributed reports to open the List of Scheduled
Reports dialog box, which contains the following information:

Last updated
This field displays the date that the list of scheduled and distributed reports
was last updated.

| ﬂlRefresh lists
Select this option to update the list of reports.

Schedule, Actions, Schedule Definition
This field displays the name of each scheduled and distributed report and the
time that each report is scheduled to run or be distributed.
To see a menu of options for editing and deleting a specific scheduled or

distributed report, click 7| in the Actions column.

Occurrence, Status, Date/Time
This field displays the status of each occurrence of each scheduled and
distributed report, either Failed, Executed, or Running. The Date/Time
column displays the date and time for each successful or failed execution. Each
report can have up to three occurrences listed, not including occurrences with
the status of Running.
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If the status is Failed, you can take these actions to try to resolve the

problem:

0 rerun the schedule or distribution

O delete the schedule or distribution, recreate it, and then run it again

O contact your system administrator

3 When you are done viewing the information, click Close.

Display 12.2 A List of One Scheduled Report, One Distributed Report, and One Successful Execution

4} List of Scheduled Reports - Microsoft i ] P
Last updated: Jul 21, 2005 11:50:39 &M EOT [ é’ Refresh lists
Schedule: Actions: Schedule Definition:
Annual Revenue by 5 Runs now
Praduct Group
@Orion Standard = Runz on dav 21 of every month
Management Reports Page E effective 7/21/05 @ 11:20 Ay
Occurrence: Status: Date/Time:
[ 0rton Standard Executed FF21705 11:20 b
Management Reports Page
Close Help |

Note: The scheduling and distributing features are not available if a scheduling
server is not available or if you do not have authorization to schedule and distribute

reports. A

Edit a Report Schedule or Distribution

To edit a report schedule that you have scheduled by using the Schedule Report
Wizard or distributed by using the Distribute Report Wizard, complete these steps:

1 Click Manage in the upper right corner of the user interface to access the Report

Management page.

2 Click view scheduled and distributed reports to open the List of Scheduled

Reports dialog box.

3 Next to any scheduled occurrence of the report or folder of reports that you want
to edit, click | in the Actions column.
4 Depending on which wizard you used to schedule the report, select Schedule or

Distribute.
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Make your changes in the Schedule Report Wizard or the Distribute Report Wizard.
For information about how to use the wizards, click Help on any wizard page.
To close the List of Scheduled Reports dialog box, click Close.

Note: Only authorized users can edit reports that they have scheduled or
distributed. If you have questions about your authorization, contact your system
administrator. A

Delete a Report Schedule or Distribution

To delete a report that you have scheduled by using the Schedule Report Wizard or
distributed by using the Distribute Report Wizard, complete these steps:

1

5

Click Manage in the upper right corner of the user interface to access the Report
Management page.

Click view scheduled and distributed reports to open the List of Scheduled
Reports dialog box.

Next to any scheduled occurrence of the report or folder or reports that you want
to delete, click =l in the Actions column, and then select Delete Schedule.

In the confirmation message box that appears, click OK.

Note: When you delete a schedule or distribution, all references to executing the

schedule or distribution are also removed from the Occurrence, Status, Date/
Time box. A

To close the List of Scheduled Reports dialog box, click Close.

Note: Only authorized users can delete reports that they have scheduled or
distributed. If you have questions about your authorization, contact your system
administrator. A

Printing Reports

Specify Printing Preferences

To specify printing preferences such as margins, page size, page orientation, and
whether to print page numbers, complete these steps:

1
2

~N o o1 AW

Select Report » Page Setup to open the Page Setup dialog box.

Select a value from each drop-down list to specify Margins for the top, bottom, left,
right, headers, and footers. You can enter values as inches or centimeters.

For page orientation, specify Portrait or Landscape.
Select the Paper size.

(Optional) Select Fit content in page horizontally.
(Optional) Select Print page numbers.

When you are done, click OK.
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Print a Report

To print a report, complete these steps:

1 Depending on your location, perform one of these tasks to open the Print dialog
box:

o If you are in the View Edit view, select Report » Print.

o If you are in the Report Management page, next to the name of the report that
you want to print, click [#| in the Actions column, and then select Print.

Note: If this is a manually refreshed report, then you must refresh the data
before you can select printing options. However, you can click Preview and Print
to print the report with the existing printing options. A

2 Specify a Print range by using these options:

Current page (includes all table rows and columns)
Select this option if you want to print only the content that is currently
shown in the View Report view. This means that only the content within the
currently displayed group break value (if the report author chose to break a
new page for each value), and within the current section, will be printed.

All pages
Select this option if you want to print the entire report.

Page(s)
Select this option if you want to print a portion of the report. After you select
this option, you can then select where you want the printed portion to begin
and end by using the two drop-down lists.

3 (Optional) Select Page breaks to insert page breaks between report sections.
4 To display a PDF file that you can print or save, click Preview and Print.
5 In Adobe Acrobat, complete these steps:
Select File » Print to open the Print dialog box.
b To ensure that the correct paper size is used, select the Choose Paper Source
by PDF page size option.
¢ To send the report to the specified printer, click oK.
d To exit Adobe Acrobat, select File » Close.

6 To close the Print dialog box, click Close.
Note: New report sections that are added to reports that were originally created in

SAS Enterprise Guide do not include a static report creation date in the printed
output. o

Save a Report

To save a new report or changes to an existing report, complete these steps:

Note: For existing reports, you can select Report » Save to bypass the Save As
dialog box. A

1 Select Report » Save As to open the Save As dialog box.

2 For new reports, type the Name. (See “Guidelines for Naming Reports, Folders, and
Templates” on page 215 for information about valid names.) If you are saving an
existing report, then the name of that report is listed here. You can either leave
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the name as it is and overwrite the existing report, or you can change the name to
create a new report.

3 (Optional) Type a report Description. Report descriptions can be displayed in the
Open dialog box and the Report Management page. Users can search for reports
with specified text in the description. You cannot use these characters: < > & #

4 (Optional) Type Keywords. Users can view the report keywords in the Open dialog
box or the Report Management page before they open the report. They can also
search for reports with specified text in the keywords. Separate each keyword with
a comma. You cannot use these characters: < > & #

5 For the Type of report, select either Data is automatically refreshed or Data
can be manually refreshed. For information about these options, see “Data
Refresh: Manual vs. Automatic” on page 217.

6 Select a save to location, either Shared folders or My folders (your private
folder area). For more information, see “Share or Hide a Report” on page 169.

Note: 'To create a new folder, click *I. A

7 (Optional for manually refreshed reports) Select Retain previous instance of
output not to exceed, and then type the number of archived reports that you
want to maintain. Archived reports are saved in PDF format.

Note: Only one copy of a report can be saved per day. If a report is saved multiple
times in one day, then only the next to last saved report is used as that day’s
archived report. A

Note: You must be authorized to use this feature. A

8 (Optional) Select the Make read-only option to prevent other users from deleting,
modifying, renaming, or moving this report. (You will still be able to perform these
actions on your own report.)

9 (Optional) Select the Automatically replace if file already exists option
if you want to replace an existing report without being prompted to confirm this
action.

10 When you are done, click oK.

Share or Hide a Report

In general, reports in the Shared Reports folder area can be viewed by other report
users. The name of the shared folder is Reports. Your system administrator also can
create a subfolder in the Reports folder that is restricted to a specific group of users.
For example, the administrator might create a subfolder named Human Resources that
is restricted to human resources employees.

Reports in the My Reports folder area can be viewed only by you and your system
administrator. The name of your personal folder is derived from your user ID and is
visible only to your system administrator.

You can place a report in the shared Reports folder or your personal folder when you
copy a report, move a report, or save a report. For more information, see the following
topics:

o “Copying Reports” on page 173
o “Moving Reports” on page 175
O “Save a Report” on page 168
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Organizing Reports

About Folders

You can use folders to organize reports. For example, you could create a folder to
contain sales reports for a specific year, and then create subfolders to hold reports for
specific regions.

Display 12.3 A Folder Structure to Contain Reports for the 2005 Sales Year

a Open - Microsoft Internet Explorer provis = |E||i|

¥ Search for reports

Location: @ Shared folders ' My folders

[2005 Sales Bl 51 3 B} [0 show report description
Name . Actions Aurthor Date Keywords
L1 midwest Region = 09/28/2005
LI Northeast Region =l 05/28/2005
LI Northwest Region = 09/28/2005
LI southeast Region = 05/28/2005
LI southwest Region = 09/28/2005

Close Help

This chapter explains where you can create folders, how to delete folders, and how to
rename folders.

Create a Folder

You can create a new folder when you copy a report, move a report, or save a report.
For more information about how to perform these tasks, see the following topics:

o “Copying Reports” on page 173
o “Moving Reports” on page 175
O “Save a Report” on page 168

You also can create a new folder by clicking *I in the Open dialog box or the Report
Management page.
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Rename a Folder

To rename a folder, complete these steps:

1

4
5

Perform one of these tasks:
o0 Select Report » Open to open the Open dialog box.

o Click Manage in the upper right corner of the user interface to access the Report
Management page.

Next to the name of the folder that you want to rename, click | in the Actions
column, and then select Rename.

In the Rename Folder dialog box, type the new name. For information about valid
names, see “Guidelines for Naming Reports, Folders, and Templates” on page 215.

When you are done, click OK.
If you used the Open dialog box, click Close.

Note: You cannot rename a folder that contains a report that is currently open. 2

Deleting Folders

Delete Individual Folders

To delete an individual folder, complete these steps:

1

3
4

Perform one of these tasks:

0 Select Report » Open to open the Open dialog box.

o0 Click Manage in the upper right corner of the user interface to access the Report
Management page.

Next to the name of the folder that you want to delete, click = in the Actions

column, and then select Delete.

In the confirmation message box that appears, click ok to delete the folder.

If you used the Open dialog box, click Close.

Note: You cannot delete a folder that contains a report that is currently open. A

Delete Multiple Folders
To delete multiple folders, complete these steps in the Report Management page:

1

Select the check box next to each folder that you want to delete.

2 At the top of the check box column, click @, and then select Delete.

3

In the confirmation message box that appears, click oK to delete the folders.

Note: You cannot delete a folder that contains a report that is currently open. A
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Publish a Report to a Publication Channel

A publication channel is an information repository that has been established by
using the SAS Publishing Framework and which can be used to publish information to
users and applications. (An administrator creates the publication channels.) If you
publish your report to a publication channel, then authorized users and applications
can access your report by subscribing to the channel.

To publish a report to a publication channel (if one is available), complete these steps:

1
2

Select Report » Save As to open the Save As dialog box.

Type the Name that you want to give to this new report. For information about valid
names, see “Guidelines for Naming Reports, Folders, and Templates” on page 215.
(Optional) Type a report Description. You cannot use these characters: < > ( )

& # \

(Optional) Type Keywords. Separate each keyword with a comma. You cannot use
these characters: < > () & # \

5 For the Type of report, select Static report (.pdf format).

6 Select the Publication Channel to which you want to publish the report.

7 When you are done, click OK.

Rename a Report

To rename a report, complete these steps:

1

Perform one of these tasks:
O Select Report » Open to open the Open dialog box.

o Click Manage in the upper right corner of the user interface to access the Report
Management page.

Next to the name of the report that you want to rename, click [=| in the Actions
column, and then select Rename.

In the Rename Report dialog box, type the new name of the report. For
information about valid names, see “Guidelines for Naming Reports, Folders, and
Templates” on page 215.

When you are done, click OK.
If you used the Open dialog box, click Close.

Note: You cannot rename a report that is currently open. A
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Copying Reports

Copy Individual Reports

To copy an individual report, complete these steps:
1 Perform one of these tasks:
o0 Select Report » Open to open the Open dialog box.

o0 Click Manage in the upper right corner of the user interface to access the Report
Management page.

2 Next to the name of the report that you want to copy, click = in the Actions
column, and then select Copy.

3 In the Copy Report dialog box, select a folder location, either Shared folders or
My folders (your private folder area). For more information, see “Share or Hide a
Report” on page 169.

If you copy a report to the same folder that contains the original report, then
the copied report is renamed by prepending “Copy of” to the report name. For
example, if you copy a report named Orion Star Sales Forecast, then the
copied report will be renamed to Copy of Orion Star Sales Forecast.

If you copy a report to a different folder that already contains a report with the
same name, then you are asked if you want to replace the existing report with the
copied report.

Note: To create a new folder, click #I. A

4 When you are done, click OK.
5 If you used the Open dialog box, click Close.

Copy Multiple Reports

To copy multiple reports, complete these steps:

1 Click Manage in the upper right corner of the user interface to access the Report
Management page.

2 Select the check box next to each report that you want to copy.
3 At the top of the check box column, click El, and then select Copy.
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4 In the Copy Report dialog box, select a folder location, either Shared folders or

My folders (your private folder area). For more information, see “Share or Hide a
Report” on page 169.

If you copy the reports to the same folder that contains the original reports,
then the copied reports are renamed by prepending “Copy of” to the report names.
For example, if you copy a report named Orion Star Sales Forecast, then the
copied report will be renamed to Copy of Orion Star Sales Forecast.

If you copy the reports to a different folder that already contains reports with
the same names, then you are asked if you want to replace the existing reports
with the copied reports. If some of the reports have the same name but some do
not, you can click Cancel in the message box to cancel copying the reports with
the same name. Reports that do not have conflicting names are still copied.

Note: To create a new folder, click ¥, A

5 When you are done, click OK.

Deleting Reports

Delete Individual Reports

To delete an individual reports, complete these steps:

1

Perform one of these tasks:

O Select Report » Open to open the Open dialog box.

o Click Manage in the upper right corner of the user interface to access the Report
Management page.

Next to the name of the report that you want to delete, click | in the Actions

column, and then select Delete.

In the confirmation message box that appears, click oK to delete the report.

If you used the Open dialog box, click Close.

Note: You cannot delete a report that is currently open. A

Delete Multiple Reports

To delete multiple reports, complete these steps:

1

Click Manage in the upper right corner of the user interface to access the Report
Management page.

Select the check box next to each report that you want to delete.
At the top of the check box column, click @, and then select Delete.

In the confirmation message box that appears, click ok to delete the reports.

Note: You cannot delete a report that is currently open. A
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Moving Reports

Move Individual Reports

To move an individual report, complete these steps:

1

Perform one of these tasks:

o0 Select Report » Open to open the Open dialog box.

o0 Click Manage in the upper right corner of the user interface to access the Report
Management page.

Next to the name of the report that you want to move, click =l in the actions

column, and then select Move.

In the Move Report dialog box, select a folder location, either Shared folders or
My folders (your private folder area). For more information, see “Share or Hide a
Report” on page 169.

If you move a report to a folder that already contains a report with the same
name, then you are asked if you want to replace the existing report with the
moved report.

Note: To create a new folder, click ¥, A

When you are done, click OK.
If you used the Open dialog box, click Close.

Note: You cannot move a report that is currently open. A

Move Multiple Reports

To move multiple reports, complete these steps:

1

Click Manage in the upper right corner of the user interface to access the Report
Management page.

2 Select the check box next to each report that you want to move.
3 At the top of the check box column, click @, and then select Move.

4 In the Move Report dialog box, select a folder location, either Sshared folders or

My folders (your private folder area). For more information, see “Share or Hide a
Report” on page 169.

If you move reports to a folder that already contains reports with the same
names, then you are asked if you want to replace the existing reports with the
moved reports.

If some of the reports have the same name but some do not, you can click
Cancel in the message box to cancel moving the reports with the same names.
Reports that do not have conflicting names are still moved.

Note: To create a new folder, click ¥, A

5 When you are done, click OK.

Note: You cannot move a report that is currently open. A
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Archiving Reports

About Report Archiving

Authorized users can specify to maintain an archive for a manually refreshed report.
The archived copies are saved as PDF files. Files are named by using the date that they
were archived; for example, output that was saved on September 19, 2005, would be
named 2005_09_19.pdf.

Only one copy of a report can be saved per day. If a report is saved multiple times in
one day, then only the next to last saved report is used as that day’s archived copy. The
earliest archived copy is automatically removed when the user-specified number of
archived copies have been saved.

Anyone authorized to view reports can view an archived copy of a report.

Specify to Archive a Report

To maintain an archive of a specific report, complete these steps:

1 Display the report that you want to archive in either the Edit Report view or in
the View Report view.

2 Select Report » Save As to open the Save As dialog box.

3 In the Type drop-down list, select Data can be manually refreshed.

4 Select Retain previous instance of output not to exceed, and then type
the number of archived reports that you want to maintain. Archived reports are
saved in PDF format.

5 When you are done, click oK.

6 When you are prompted to replace the existing report, click oK. (The existing
report will be saved as a PDF file.)

Note: Users with the authorization to save reports must have additional
authorization in order to archive a report. If you have questions about your
authorization, contact your system administrator. A

Note: Authorized users also can specify to archive scheduled reports. A

View an Archived Copy of a Report

To view an archived copy of a report, complete these steps:
1 Perform one of these tasks:
O Select Report » Open to open the Open dialog box.
o0 Click Manage in the upper right corner of the user interface to access the Report
Management page.
2 Next to the name of the report that has the archived copy that you want to view,
click =l in the Actions column, and then select Archived Output.

Note: Archived reports are identified by this icon: A

3 In the Archived Output dialog box, select the archived copy that you want to view
and then click view. A PDF version of the report opens in a new Web browser
window.
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4 To close the Archived Output dialog box, click Close.

Delete an Archived Copy of a Report

To delete an archived copy of a report, complete these steps:

1

Perform one of these tasks:

o Select Report » Open to open the Open dialog box.

o0 Click Manage in the upper right corner of the user interface to access the Report
Management page.

Next to the name of the report that has the archived copy that you want to delete,
click =l in the Actions column, and then select Archived Output.

Note: Archived reports are identified by this icon: A

In the Archived Output dialog box, select the archived copy that you want to
delete and then click Remove.

4 In the confirmation message box that appears, click ok to delete the archived copy.

5 When you are done, click Close.
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Overview of Managing Report Templates

You can create report templates that contain one or more sections. Report templates
can contain the following content:

O tables and their properties (but not linking information)
o graphs and their properties (but not linking information)
O maps and their properties

images, their properties, and linking information

text objects, their properties, and linking information

headers

O o o o

footers
O stored process objects (without the stored process selected)
O positioning information

Templates cannot contain data items or group breaks (group breaks require that you
select data items from a data source).

SAS Web Report Studio comes with a selection of templates. You also can create your
own templates that you can share or keep private.

This chapter explains how you can create your own templates, delete and edit your
own templates or shared templates that are not saved as read-only, and share or hide
templates.

Note: Only authorized users can save templates. If you have questions about your
authorization, contact your system administrator. A

Create a Report Template

To create a report template that is based on the currently active report, complete
these steps:

1 Select Report » Save As to open the Save As dialog box.
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8

Type the Name that you want to give to this new template. For information about
valid names, see “Guidelines for Naming Reports, Folders, and Templates” on page
215.

(Optional) Type a template Description. The description is displayed in the
Select a Template dialog box. You cannot use these characters: < > & #

For the Type of report, select Template.

Note: If you are viewing a manually refreshed report, then refresh the data in
order to make the Template report type available. A

Select a save to location, either Shared templates or My templates (your
private area).

(Optional) Select the Make read-only option to prevent other users from deleting
or modifying this template. (You will still be able to perform these actions on your
own template.)

(Optional) Select the Automatically replace if file already exists option
if you want to replace an existing template without being prompted to confirm this
action.

When you are done, click OK.

If you saved the template from the View Report view, the currently displayed report
will be replaced by the template. Because the template does not include any data
selections, you might see invalid graph, table, and map icons, depending on which
objects the report contained. At this point, you can click Edit Report to add data and
create a new report based on the template that you created, or you can open another
report.

Delete a Report Template

To delete one of your own report templates or a shared template that is not saved as
read-only, complete these steps:

1

o Ol A W

Perform one of these tasks to open the Select a Template dialog box:

0 Select Report » New From Template.

0 Click Apply a template in the Edit Report view.

Depending on which type of template that you want to delete, select either the
Shared templates tab or the My templates tab.

Select a template.

Click pelete.

In the confirmation message box that appears, click OK.

To close the Select a Template dialog box, click Cancel.

Edit a Report Template

To edit one of your own report templates or a shared template that is not saved as
read-only, complete these steps:

1

Perform one of these tasks to open the Select a Template dialog box:
o Select Report » New From Template.
o Click Apply a template in the Edit Report view.
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2 Select a template from the Shared templates tab or the My templates tab and
click oK.

In the Edit Report view, make your changes.
Select Report » Save As to open the Save As dialog box.
Type the Name of the template that you just edited.

(- IS ) B — N ]

Type the Description (if any) for the template. You cannot use these characters:
<>& #

For the Type of report, select Template.

o ~

Select the save to location in which the original template is located.

9 (Optional) Select the Automatically replace if file already exists option
if you want to replace the existing template without being prompted to confirm
this action.

10 When you are done, click oK.

Share or Hide a Report Template

Report templates in the Shared Templates folder can be used by other report users,
and reports in the My Templates folder can be used only by you and your system
administrator.

You can place a template in either one of these folders when you save a report
template (see “Create a Report Template” on page 179).
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Scenario Overview

The report Delivery Performance for US Gold Customers in 2004 provides
U.S. management with a high-level view of delivery performance across all products.
Data is rendered in a chart and in a table.

0 The bar-line chart compares delivery cycles across regions and product categories.
A high standard deviation in a delivery cycle alerts management that delivery
issues might need to be addressed.

0 The crosstabulation table provides context for the revenue contribution of each
product category in each region. Long delivery cycles in areas with high revenue
contributions would be top priorities for further research.

This chapter describes the steps that you might take to create this report.
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Creating the Report

Access the Edit Report View

Select Report » New to open the Edit Report view. This is the main area for
creating and editing reports.

Display 14.1 The Edit Report View for a New Report

Section Section v

Select data

Currently, ho date is selected

Report Apply a template

Header

il & = k& L F @ |Independent0bjectsj

11y =)

Drag and drop a report object
here

Footer

View Report

For more information about the Edit Report view, see “About the Edit Report View”
on page 30.

Select the Data Items

To define the query that will be used to provide the data for this report section,
complete these steps:

1 In the data pane, select Select data to open the Select Data dialog box.
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2 On the standard tab, select the relational data source named Delivery
Performance US Gold Customer Orders.

3 Use the arrow buttons to move the following data items from the Available data
items list to the Selected data items list.

Year

Product Category
Revenue

Avg Delivery Cycle
Std Dev Delivery
Region

O 0O o oo od

Display 14.2 The Select Data Dialog Box After You Complete Step 3

3 Select Data - Microsoft Internet Explorer provided by = | Ellil

Data source: Delivery Performance US Gold Customer Orders Change Source ... |

Standard | Custom

Available data items: Selected data items:
£l Geographic Classifications = Byvear = ‘
.._|p,u locations ©iProduct Category -
--_IUS locations ﬂ gﬁyRevenue

» & fg Delivery Cwele

--_||nternat1'0nal locations &sm ey Dby
H-{_|Product Catalog @ Region

B Date Classifications

E{_|Customer Demographics ﬂ
B-__|Retail Channel

BH__|Measures

iy Q .

[ 4dd new data items to existing tables automatically

Ok Cancel | Help |

4 Click ok.

Select a Predefined Filter

If a data item has a predefined filter—which is true for the belivery Performance
US Gold Customer Orders data source—you can select it from the Filter drop-down
list that is next to that data item.

For this report section, for the Year data item, select For Year 2004 only from the
drop-down list.
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Display 14.3 The Data Section After the Predefined Filter Is Selected

Select data | Options

#  Data selected from: Rediven Performance US Gold Cusfomer Orders

Data item: Filter: Format:
Year ﬁ [Forear 2004 oniy E| =
Product Category ﬁ INnﬂIter j
<§5? Revenue Define
@ fug Delivery Cycle Define
42 5td Dev Delivery Define [—

Create the Header
Report sections can include headers that contain an image, text, or both. For this
report section, complete these steps:
1 Select Header.
2 In the Header dialog box, complete these steps:
a In the text box, type Delivery Statistics for US-based Gold Program

Customers in 2004.
b Format the text so that the size is 14 and the style is bold italic.

Display 14.4 The Edit Header Dialog Box After You Complete Step 2b

‘3 Edit Header - Microsoft Internet Explorer pr =T =

Banner: Mane | ===

Text

[Trebuchet ms 2k 2 v 5= = | - -

Delivery Statistics for US-based Gold
Program Customers in 2004

Dynamic text:
|Data Source MName j Insert

O Include a horzontal line between the header and report content

ﬂ Cancel Help

3 Click ok.

Insert the Bar-Line Chart

SAS Web Report Studio enables you to render data in any of six different graph
types: bar charts, bar-line charts, line graphs, pie charts, progressive bar charts, and
scatter plots.

A bar-line chart is a bar chart with an overlaid line graph. A bar chart consists of a
grid and some vertical or horizontal columns (bars). Each column represents
quantitative data. A line graph shows the relationship of one variable to another, often
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as movements or trends in the data over a period of time. Line graphs summarize source
data and typically are used to chart response values against discrete categorical values.
To include the bar-line chart in this report section, click E# on the horizontal toolbar.

Change Default Properties for the Bar-Line Chart

For graphs, you can set properties such as a title, color, size, and legend position. For
the bar-line chart that you just inserted, complete these steps to change some default

properties:

1 On the graph toolbar, click E and select Graph Properties.
2 On the Graph tab, complete these steps:

a In the text box, type Delivery Performance in Days by Region across

Product Categories.
b Format the text so that it is bright blue and bold.

3 On the Bar-1line tab, complete these steps:

a Change the Marker size to Medium.
b Change the Bar color to sky blue.
¢ Change the Line color to yellow.

4 Click ok.

Display 14.5 The Report Layout After You Complete Step 4

#| Header

Delivery Statistics for US-based Gold Program Customers in 2004

Group breaks =
= = [uﬂ[l_ & lﬂ % [uﬂ @ |Independent0hjectsj
& & | i

Ig=1

Footer
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Change Default Data Assignments for the Bar-Line Chart

By default, each data item that you included in the section query is assigned to a
specific function in the bar-line chart. For this report section, complete these steps to
change the default assignments:

1 On the graph toolbar, click ‘% to open the Graph Data dialog box.
2 Use the Move Items menu to assign data items to the functions that are shown in

the following display.

Display 14.6 The Graph Data Dialog Box After You Complete Step 2

) Graph Data - Microsoft

[ata items:

=10l x|

Move ltems~ |

1]l Bar Height {Limit 1)
g?&vg Delivery Cycle
t|~~Line Height (Limit 1)
éyStd D Dizlivery
Hi Bars (Limit 1)
B Product Category
ﬁ_@ Horizontal ihatrix
B (optional)
T%Vertical At rix
@ Region
¥ Hidden
B vear

gﬁyﬂewenue

e

OK

Cancel ‘ He!p|

3 Click ok.

Specify Conditional Highlighting for the Graph
SAS Web Report Studio enables you to highlight graph values that meet specified
conditions. To enter a highlighting condition for the bar-line chart, complete these steps:
1 On the graph toolbar, click &+ and select Conditional Highlighting.

2 For Measure, select std Dev Delivery.

3 For Condition, select Greater than or equal to.

4 For value, type 2.
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5 Click ok.

Insert the Crosstabulation Table

A crosstabulation table shows frequency distributions or other aggregate statistics for
the intersections of two or more categories.

To include a crosstabulation table in this report section, click & on the horizontal
toolbar, and then drag and drop the image into the cell beneath the bar-line chart.

Change Default Properties for the Crosstahulation Table

For tables, you can set properties such as a title, color, and table size. For the
crosstabulation table that you just inserted, complete these steps to change some
default properties:

1 On the table toolbar, click E and select Table Properties.
2 On the Table tab, complete these steps:
a In the text box, type Delivery Days and Revenue Contribution by Region
across Products.
b Format the text so that the font is Tahoma, the size is 11, the color is bright
blue, and the style is bold.
¢ For Columns, select Limit the number of columns displayed at once and
type 600.

3 Click ok.
Display 14.7 The Report Layout After You Complete Step 3

% Header

Delivery Statistics for US-based Gold Program Customers in 2004

Group breaks -

H = Wl & = B L Fss | Independent Objects x|
2B & | i
i
B
B & | i

Footer
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Change Default Data Assignments for the Crosstabulation Tahle

By default, each data item that you included in the section query is assigned to a
specific function in the crosstabulation table. For this report section, complete these
steps to change the default assignments:

1 On the table toolbar, click ‘% to open the Table Data dialog box.

2 Use the Move Items menu to assign data items to the functions that are shown in
the following display.

Display 14.8 The Table Data Dialog Box After You Complete Step 2

3} Table Data - Microzof o m]
Data items: Move ltems~
ﬂﬂ(olumns —
T Region

gﬁyﬁ'ug Delivery Cvcle
gﬁy Revenue
ﬂﬂﬂows

3 Product Category
¥ Hidden

By vear

gQStd Dev Delivery

0K Cancel | Help |

3 Click ok.

Add a Percent of Total Column to the Crosstabulation Table

For tables, you can add columns that contain percentage calculations, totals, and
comparisons to summary values. To add a percent of total column to the crosstabulation
table, complete these steps:

1 On the table toolbar, click and select Percent of Total.
2 For For measure, select Revenue.

3 For show percent of, select Column Total.

4 For Label, type $ Region.
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5 Click add.

Display 14.9 The Percent of Total Dialog Box After You Complete Step 5

‘3 Percent of Total - Microzoft Int =10l x|
For measure: IRevenue j
Show percent of: ICDlumn Total j
Label: |

Al Bermmye |

For measure: Show percent of: Label:
Revenue Column Total % Region
0K Cancel | Help ‘
6 Click OK.

Specify Conditional Highlighting for the Crosstabulation Table

SAS Web Report Studio enables you to highlight table values that meet specified
conditions. To enter a highlighting condition for the crosstabulation table, complete
these steps:

1 On the table toolbar, click and select Conditional Highlighting.
2 In the Conditional Highlighting dialog box, click New.
3 On the Rule tab, complete these steps:

a For Measure, select ¥ Region.

b For Condition, select Greater than or equal to.
¢ For value, type 0.2.

4 On the color and Font tab, select dark green as the Font color.

5 On the Image and Text tab, complete these steps:

Select the Highlight by adding an image or text option.
For add, select the Image option.

For Position, select To the right of cell value.

For Image, select the three-dimensional green diamond.

6 Click ok.

2 0 oo
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Display 14.10 The Conditional Highlighting Dialog Box After You Complete Step 6

7 Click ok.

Add a Footer

Report sections can include footers that contain an image, text, or both. For this
report section, complete these steps in the Layout section:

1

2
3
4

Select Footer to open the Edit Footer dialog box.
In the text box, type Data Source:
For bynamic Text, select Data Source Name and then click Insert.

Select all of the text, including the dynamic text, and change the font size to 10
and the style to italic.

Select the Data Source: text and then select yellow as the background color.

Display 14.11 The Footer Dialog Box After You Complete Step 5

3 Edit Footer - Microsoft Intemnet Explorer provided — 10l x|
Banner: Mone j EE§|EE
rText

|Trebuchet S jlm ijB z g=_ --;ﬁ('

Daka Source: | Data Source Mame |

Dynamic text:

 Data Source Name = Insert

[T Include a horizontal line between the footer and report content

0K| Cancel | Help |
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6 Click ok.

Save the Report

To save the report, complete these steps:

1 To open the Save As dialog box, select Report » Save.
Note: After a new report is saved for the first time, the Save As dialog box does
not appear when you select Report » Save. A
For Name, type Delivery Performance for US Gold Customers in 2004.

For Description, type Provides U.S. management with a high-level view
of delivery performance across all products.

For Keywords, type orders,delivery, performance.
5 For Type, select Data is automatically refreshed.

Display 14.12 The Save As Dialog Box After You Complete Step 5

3 Save As - Microsoft Internet Explorer =10l =]
Hame: |De|iver\,r Perfarmance for US Gold Customers in 2004
Description: Frovides U.S. management with a high-level view

of delivery performance across all products

Keywords: |0rders,deliver\,f,performance
Type: | Data is automatically refreshed =
= |1D—
Save to
% Shared folders ¥ Reports =
© My folders {2004 Sales

| |2005 Sales
12004 Sales
--_| Delivery Analyziz

& Publication Channel I j

T inake read-only
| Automatically replace if file already exists

DK| Cancel | Help |

6 Save the report in the Delivery Analysis folder.
7 Click ok.

Next Steps

For instructions for linking this high-level report to a more detailed report and then
viewing both reports, see Chapter 15, “Example: Linking a High-Level Report to a
Detailed Report,” on page 197.



196



197

CHAPTER

15

Example: Linking a High-Level
Report to a Detailed Report

Scenario Overview 197
Link the High-Level Report to the Detailed Report 197
View the Reports 199

Scenario Overview

Orion Star Sports & Outdoors executives need to analyze delivery performance for
2004. Their reports need to look at the number of days on average that it took to
deliver orders from Internet and catalog sales channels. There are two reports that
provide this information.

O The high-level report is named Delivery Performance for US Gold Customers
in 2004. It contains a bar-line chart and a crosstabulation table. The bar-line
chart links to a more detailed report that shows delivery statistics for a selected
product category in a selected region.

Note: For instructions for creating this report, see Chapter 14, “Example:
Creating a Report,” on page 185. A

0 The detailed report is named Detailed Delivery Performance by US
Operating Region. It enables executives to determine which products have the
longest delivery cycle and which suppliers are responsible for those products.

This chapter describes the steps that you might take to link the high-level report to
the detailed report. The steps needed to view both of the reports are also included.

Link the High-Level Report to the Detailed Report

To link Delivery Performance for US Gold Customers in 2004 to Detailed
Delivery Performance by US Operating Region, complete these steps:

1 Select Report » Open to open the Open dialog box.
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Display 15.1 The Open Dialog Box Listing the High-Level and Detailed Reports

‘3 Open - Microsoft Internet Explorer provided by SAS ol x|

¥ Search for reports

Location: o Shared folders (o My falders

b B [Tl Show report description

Name & Actions Author Date Heywords

SAS
Adrrinistrator

Delivery Performance for US Gold Customers in 2004 = 04/15/2005

Detailed Delivery Performance by US Operating Region = iﬁrﬁinistrator 0441372005

0 N o O AW

Next to Delivery Performance for US Gold Customers in 2004, click =l in

the Actions column, and then select Edit to open the report in the Edit Report
view.

On the bar-line chart toolbar, click and select Report Linking.
In the Report Linking dialog box, select Include report links in the graph.
For Link destination, select An existing report.

Select Detailed Delivery Performance by US Operating Region.
Click pefine Prompts.

In the Define Prompts dialog box, complete these steps:

a For Region, select Region from the drop-down list.
b For Product Category, select Product Category from the drop-down list.

Display 15.2 How the Define Prompts Dialog Box Looks When You Complete Step 8b

‘3 Define Prompts - Microsoft Inte -0 x|

Optionally, assign a prompt to one or more data items.

Data ltems: Destination report prompis:

Region IReginn j

Product Category IF'rl:ldLll:tCategtlnf j

0K Cancel ‘ Help |

¢ Click oK.
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Note: For tips on defining prompts, see “Tips for Defining Prompts in Report
Linking” on page 155. A

9 For Tool-tip text, type Click on the bar to go to a detailed report
for product categories in the U.S. region.

Display 15.3 How the Report Linking Dialog Box Looks When You Complete Step 9

<3 Report Linking - Microsoft Internet Ex -0l x|

¥ Include repaort links in the graph

Link destination: & ewisting repaort

0 AWeb page

¥ Reports =
H{_|StoredProcesses |
Delivery Performance for US Gold Customers in 2004

-] Detailed Delivery Performance by US Operating Region

-] Orion Product Profitability Summary

Praduct Group Detail Repart

Product Group Revenue Contrdbutionsz by Age Group
E‘.‘ Supplier reports

B Delivery Performance for US Gald Customers in 2004

@ Detailed Delivery Performance by US Operating Region

Report: Detailed Delivery Performance by US Operating Region

Define prompts... |

Tool-tip text: Click on the bar to go to & detailed repart for product cat

OK Cancel ‘ He!p|

10 Click oxk.

11 Select Report » Save. When you are asked if you want to replace the existing
report, click OK.

View the Reports

In the View Report view, complete these steps:
1 Select Report » Open to open the Open dialog box.
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Display 15.4 The Open Dialog Box Listing the High-Level and Detailed Reports

<3 Dpen - Microsoft Internet Explorer provided by SAS | =] ]

¥ Search for reports

Location: ® Shared folders T My folders
B [T Show report description

Name o Actions Author Date HKeywords

SAS

Delivery Performance for US Gold Customers in 2004 E Adrministrator 04/15/2005

g : N . . i = SAS
Detailed Delivery Performance by US Operating Region = Al GT 047132005

2 Select Delivery Performance for US Gold Customers in 2004 to open the
report in the View Report view.

3 The bar-line chart at the top of the report is linked to the report betailed
Delivery Performance by US Operating Region, which has two prompts: one
for product category, and one for region. Click on a bar to send the region and
product category values that are associated with that bar to the prompts for the
Detailed Delivery Performance by US Operating Region report.

Display 15.5 Bar That Links to a Detail Report for Winter Sports Apparel in the Northeast

Region
5.0
Miclwest E_“_-—--—-_-——n.
0.0 -
.U
Mortheast e T ey DR e e
0-

1]
5.0 Product Categary: *inter Sports
Morthwest — P = = ] Region: Northeast
oo Avwg Delivery Cycle: 3.7
50 Std Dev Delivery: 2.5
Seutheast L] u S ————— L Click on the bar to go to a detailed report for product
00~ categories in the 5. region.
-

50
Fouthwest E-—---—-------—-n
0.0 -

Team Sports

Running - Jogging
Shoes
Swim Sports
‘Wirter Sports

Aszsorted Sports Aricles
Children Sports
Cutdoors
Facket Sports

Product Category

.Avg Delivery Cycle Std Dev Delivery
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Display 15.6 Detail Report on Winter Sports Apparel Sales in the Northeast

4 Return to previous report

For Product Category: Winter Sports

For LIS Regiorn: Northeast

& & & | iy

Delivery Performance for US Gold Customers in 2004

201

Product Hame Supplier Name Ave Detivery Fastest Delivery [Slowest Delivery | $td Dev Delivery

- Cycle
e Mowegli Vertilation Air Jacket Scandinavian Clothing A0S 1.0 1.0 1.0
dce Oregon Wentilation Air Snowe Jacket | Scandinavian Clothing &5 13.0 13.0 13.0
4men Men's Invert Jacket Miller Trading Inc 4.0 4.0 4.0 .
Amber Co CrystalClear Optics Inc 26 1.0 4.0 1.3
Big Guy Men's Revert Jacket Miller Trading Inc 1.0 1.0 1.0
Bllack PG CrystalClear Optics Inc 4.0 4.0 4.0 .
Birowvn PGL CrystalClear Optics Inc 2.0 1.0 3.0 1.4
C.A M. Bone CrystalClear Optics Inc 3.8 1.0 6.0 149
Cayenne Red CrystalClear Optics Inc 3.8 3.0 5.0 1.0
Cup Stopsign CrystalClear Optics Inc 4.0 4.0 4.0
Dark Grey PGB CrystalClear Optics Inc 5.0 5.0 5.0 .
Gtx Povwder Thermo 04 Red Twvain Inc 43 4.0 2.0 0E
Gtx Povwder Thermo 06 Iris/Blue Twvain Inc 4.0 1.0 6.0 2.2 a
Hot Duck Men's Krypton Ski Jacket Morzok AS5 5.0 5.0 5.0 .
Hot Duck Men's Ski Pants Halley Morzok AS5 k) 3.0 4.0 0.7
Hot Duck YWomen's Ponert Ski Jacket Morsok ASS 4.0 4.0 4.0
Inzul Jacket AllSeazons Outdoor Clothing 2.0 20 20
Like Regulator Carbon CrystalClear Optics Inc 4.0 4.0 4.0 .
Mazsif Bandit L Ski Axial Mazsif 5.4, 30 1.0 a0 2.8 a
Mazsif Bandit Ski Parcel Axial Mazsif 5.4, 4.0 30 a0 07
Mazsif Cut ¥ Super 9.9 Ski Parcel Mazsif 5.4, 7.0 7.0 7.0
Mazsif Men's Monitor Bomber Jacket Mazsif 5.4, 30 30 30
Matterhorn Jacket Miller Trading Inc 5.0 5.0 5.0
Maryday Curve Pro Ski Jacket Maryday Inc 6.0 6.0 6.0
Maryday Girl's Rider Pants Maryday Inc 4.0 4.0 4.0
Mayday Shaped ki Pants Mayday Inc 4.0 4.0 4.0
Maryday Trippler 354 Long Ski Jacket Maryday Inc 1.0 1.0 1.0 .
Men's Ski Jacket Went Air Scandinavian Clothing A0S 2.5 2.0 3.0 0.7
Wt kerya Men's Ski Jacket Wertilation Air | Scandinavian Clothing &5 2.5 2.0 3.0 0.7
Mofa Down Jacket Miller Trading Inc 4.0 4.0 4.0 .
Mofa Jacket hdiller Trading Inc 30 30 30 o0

4 To return to Delivery Performance for US Gold Customers in
Return to previous report.

2004, select
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Example 1: Filtering an Alphanumeric Category in a List Table

Scenario Overview

The following list table includes information from all available age groups. The table
needs to be filtered so that only information about customers between the ages of 31
and 45 is displayed.

Display 16.1 Before the Filter Is Applied

Continent |Country |Order Type |Customer Age Group |Quantity | Total Retail Price | Cost of Goods Sold
Africa Benin Internet Zale |15-50 years - F209.50 $95.85
Africa Morocco | Catalog Sale | 31-45 vears 7 FE43.50 F282.75
Africa Morocco | Catalog Sale | 61-75 years 14 $1,259.40 F626 .05
Africa Migeria Irternet Sale | 31-45 vears 1 F144.90 7255
Azig lzrael Catalog Sale | 15-30 years 2 15560 F77 .6
Azia Izrael Catalog Zale | 31-435 years 10 F1,21410 F536.25
Azia lzrael Catalog Sale |46-60 vears g Fr55.50 F345.45
Asia lzrael Irternet Sale | 31-45 years 3 F71.893 $39.80
AustraliafPacific | Australia | Catalog Sale |15-30 vears 443 F25,528. 3 F135,491.10
AustraliaPacific | Australia | Catalog Sale | 31-45 years 347 $22,260.49 $10,5339.45

Rows 1- 10T £

This example describes the steps that you might take to create the filter that will
achieve your goal.
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Create the Category Filter

To create the filter, complete these steps:

1

Sl AW N

Open the Filter and Rank dialog box by clicking &+ on the table toolbar, and then
selecting Filter and Rank.

In the Item, Filter list, select Customer Age Group.
Select select category values from the Filter type drop-down list.
Select 31-45 years from the Available values list.

Click the right arrow button to move 31-45 years into the Selected values list.

Display 16.2 How the Filter and Rank Dialog Box Looks When Step 5 Is Completed

3 Filter and Rank - Microsoft Internet Explorer 10| x|

Item Filter

Delivery Date -
Crder Type

Customer #ge 31-45 vears J
Group

Cuantity -
Filter type: Select categary values j

Select category values

Showe values:

Available values: Selected values:
16-30 years M-45years
46-60 years

B1-75 years » |
=

0K| Cancel | Help ‘

6

Click oK to save the filter and redisplay the table.

Results
Here is what the table looks like after the filter is applied.
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Display 16.3 After the Filter Is Applied

Continent  |Country [(rder Type |Customer Age Group |Quantity | Total Retail Price | Cost of Goods Sold
Africa Morocco | Catalog Sale | 31-45 years 7 §645 80 529275
Africa MNigeria Internet Sale | 31-45 yvears 1 F144 90 FF255
Aszia Izrael Catalog Zale | 31-45 years 10 F1.21410 $5356.25
Azia Izrael Internet Sale | 31-45 yvears ) F71.08 F39.90
Auvsztralis/Pacific | Australia [Catalog Sale | 31-45 years 347 F22 26049 F10,539.45
AustraliaPacific | Australia |Internet Sale | 31-45 yvears 453 P27 22599 1267720
Auvsztralis/Pacific | Australia |Retsil Sale 31-45 years 1131 ¥79,555.10 F37 57570
Europe Belgium | Catalog Sale | 31-45 years 274 P17 31542 $5,146 .45
Europe Belgium | Internet Zale | 31-45 years 275 F15 23 .35 $5,570.40
Europe Belgium  |Retail Sale 31-45 years E0S 36, 72009 F17 44250

Rows 1- 10T £

Example 2: Filtering Measures in a Crosstabulation Tabhle

Scenario Overview

The following crosstabulation table shows Orion Club Gold member spending in each
country for the years 2001 and 2002. Spending is split between males and females. The
table needs to be filtered so that it only contains information for 2002 where females
spent more than $100,000.
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Display 16.4 Before the Filter Is Applied

Customer_Group Orion Club Gold members
Order Year 2001 2002
Customer_Gender Female Male Female Male
Customer Spend | Customer Spend | Customer Spend | Customer Spend
Customer_Country
Australia $37 41651 $37 927 36 $69,495.59 $79,955 26
Belgium §23,810.93 F41 G5d 29 $53,300 41 F60,190 24
Benin . . . $159.20
Bulzaria . 52 60 . 26 .90
Canada $2,256.30 $E3a7 .50 F1,04920 1,227 .05
Croatia 2720 . §997 .40 F556.40
Denmark $15,754.36 $21 56010 $13915.50 $20,794 56
Finland $2,945 50 $2,570.60 2,288 55 $&11.90
France F127 32562 $144 017 60 $159 445 57 $202,301 .01
Germany F167 13352 F174,349.23 F192,019.26 F190,630.52
Greece . $555.10 . $1,205.00
Hungary F485.80 $361 .30 Jd47 58 51,688383
Ireland $642 30 $1,555.10 $20.70 $641 .10
Israel . FE6S.25 . $152.90
Italy $209,275 50 $234 534,55 $178,336.44 $222,705.91
Lithuania $285.90 . $51.80 )
Luxembourg $3,010.530 $365.10 F1,455.00 F365.00
Macedonia 112 60 . .
Morocco . F226.00 . F437.00
Hetherlands $56,600.57 $100,521 25 111,891 00 §122,804 55
Spain $132,299.55 148,853 65 F175,27993 $193,285 81
United Kingdom $177 324 80 F206,569 .47 $204 064 51 $250,582 31
United States $283,296 85 $320,7589.40 $280 566 03 $301,008 .59

This example describes the steps that you might take to create the filter that will
achieve your goal.

Create the Category and Measure Filters

To create the necessary filters, complete these steps:

1 Open the Filter and Rank dialog box by clicking &+ on the table toolbar, and then
selecting Filter and Rank.

Click the category Filters tab.

Select the order Year data item.

For Filter type, select Type in category values.
For value, type 2002.

Click add.

S ol A W N
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Display 16.5 How the Filter and Rank Dialog Box Looks When Step 6 Is Completed

7 Select the Customer_Gender data item.

8 For Filter type, select Type in category values.
9 For value, type Female.

10 Click Add.
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Display 16.6 How the Filter and Rank Dialog Box Looks When Step 10 Is Completed

“J Filter and Rank - Microsoft Intermnet Explorer provid o ]
Category Filters I Measure Filter or Rank |
Item Filter

Customer_Group
Crder Year 2002
Customer_Gender Female

Customer_Country

Filter type: |Type in categorywalues j

[T Filter on formatted values

Value:

Add Remove

Multiple values:

0K Cancel | Help |

11 Click the Measure Filter or Rank tab.

12 Select the Filter a measure option.

13 For Show value of, select Customer_Country.
14 For Measure, select Customer Spend.

15 For Operator, select Greater than.

16 For value, type 100000.

Note: Do not include the currency symbol. 2



Display 16.7 How the Filter and Rank Dialog Box Looks When Step 16 Is Completed

a Filter and Rank - Microzoft Internet Explorer pr

Catepory Filters | Measure Filter or Ranlk

Examples: Filtering and Ranking Tables and Graphs

=101 x|

{0 Mo measure filter or rank ™ Filter a measure ' Rank a measure

— Filter

Measure:
Operator:

Value:

Show values of:

That meet this criterion:

ICustnmer_Cnuntrg,r

|Custnmer Spend

|Greaterthan

{100,000

The measure filter will be applied after the category Filters.

Cancel | He!p|

17 Click OK to save the filter and redisplay the table.

A Results
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Results

Here is what the table looks like after the filter is applied. It shows that women who
were Orion Club Gold members spent more than $100,000 in 2002 only in France,

Germany, Italy, the Netherlands, Spain, the United Kingdom, and the United States.

Display 16.8 After the Filter Is Applied

Customer_Group

Orion Club Gold members

Order Year

2002

Customer_Gender

Female

Customer Spend

Customer_Country

France $1589 448 57
Germany F192019.26
Italy §178,336 44
Hetherlands F111,991 .00
Spain $172,27903
United Kingdom F204 084 .51

United States

F250,566.03
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Example 3: Ranking a Bar Chart Based on Multidimensional Data

Scenario Overview

The following bar chart shows revenue for two sales channels for the years 1998,
1999, 2000, 2001, and 2002. The chart needs to be ranked so that it shows where the
top 10 percent of sales came from in each year.

Display 16.9 Before the Ranking Is Applied

Revenue
$300,000.00

$250,000.00

$200,000.00

$150,000.00

$100,000.00 H

$50,000.00

0.00
Order Channel[ Internet Sale [ Catalog Sale

Year

This example describes the steps that you might take to create the ranking that will
achieve your goal.

Create the Ranking

To create the ranking, complete these steps:

1 Open the Filter and Rank dialog box by clicking &+ on the graph toolbar, and then
selecting Filter and Rank.

Click the Measure Filter or Rank tab.
Select the Rank a measure option.

For show, select Top and type 10.

Select the percent (%) option.

For of, select sales Channel.

~N o0 o1 AW N

For Measure, select Revenue.
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Display 16.10 How the Filter and Rank Dialog Box Looks When Step 7 Is Completed

3 Filter and Rank - Microzoft Internet Expl

Category Filters | Measure Filter or Rank

' Mo measure Filter or rank

{7 Filter a measure

=10l x|

¥ Rank a measure

Based on values of:

—Rank
Show:
(Ol Top |1|:|— 7 percent(i) ¥ Exclude ties
7 Battom I— - percent(®) [T Exclude ties
Of: |Sa|es Channel j

Measure: IRE'\-'EHUE

[

The rank Filter will be applied after the category filters.

Ok | Cancel | Help

8 Click OK to save the ranking and redisplay the graph.

A Results
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Results

Here is what the chart looks like after the ranking is applied. It shows that the top
10 percent of sales for each year came from the Catalog Sale channel.
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Display 16.11 After the Ranking Is Applied

Revenue
$300,000.00

$250,000.00

$200,000.00

$150,000.00

$100,000.00 H

$50,000.00

30.00 -

Order Channel[ Catalog Sale

Year [1888]1999]20002001]2002]
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Guidelines for Naming Reports, Folders, and Templates 215

Guidelines for Naming Reports, Folders, and Templates

You can give a report, folder, or template any name, as long as the name meets these
criteria:

O It is unique within the folder that contains the item.
Note: Report, template, and folder names are not case sensitive. For example,

you cannot have a report named 2002 Vendor Costs and a report named 2002
VENDOR COSTS in the same folder. A

O It does not contain these characters: \ / : * 2 ** <> | @ # &

o It is 56 characters or fewer in length.
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Data Refresh: Manual vs. Automatic

You can save a report to be either manually or automatically refreshed. The
following table explains the consequences of each option.

Refresh Option Selected Consequences

Data is automatically refreshed 1 A large report might take a long time to
open. However, it will take less time to
save a large report this way.

2 The data in the report will automatically

match the data source when the report is
opened.

Data can be manually refreshed' 1 A large report that contains a lot of data
might open more quickly than if you
choose the other option. However, a large
report might take a long time to save.

2 The data that is shown in the report will
be updated to match the data source only
when the report user requests a refresh. :

3 While viewing the report, report users can
perform certain actions only after they
have refreshed the data. For example, the
report user would be able to apply a filter
or drill down into a crosstabulation table
only after refreshing the data.

4 The report can be archived.

1 Reports that are pre-generated on a schedule are also manually refreshed reports.
2 You must save the report in order to embed the refreshed data as the new report content.
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Tips for Using Reports Created with a Previous Version of SAS Webh
Report Studio

Here are some tips for using reports that were created with a previous version of
SAS Web Report Studio.

How to add visual elements to a stored process section
SAS Web Report Studio 3.1 enables you to add visual elements such as headers
and footers to report sections that contain a stored process. However, in order to
add the elements to a report that was created with a previous version of SAS Web
Report Studio, you must delete the existing stored process and then reinsert it.

Houw to create a report section that contains multiple stored processes
SAS Web Report Studio 3.1 enables you to create report sections that contain more
than one stored process. However, in order to add a stored process to a report
section that was created with a previous version of SAS Web Report Studio, you
must delete the existing stored process. You can then reinsert the stored process
and add any others.

How to improve query performance for some filters
In previous versions of SAS Web Report Studio, if a character type data item from
a relational data source used the default format, then filters on that data item used
formatted values. To improve query performance in SAS Web Report Studio 3.1,
clear the Filter on formatted values option. The option appears in the Filter
and Rank dialog box for tables and the Create New Filter dialog box for sections.

When you can use a custom data item that is a constant value
Beginning with SAS Web Report Studio 3.1, you cannot create a custom data item
that is a constant value. However, you can use this type of custom data item if it
is included in the data source that you are using or if it was created by using a
previous version of SAS Web Report Studio.
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bar chart
a chart that consists of a grid and some vertical or horizontal columns (bars). Each
column represents quantitative data.

bar-line chart
a bar chart with an overlaid line graph. See also bar chart, line graph.

category
a data item whose distinct values are used to group measure data items, using an
applied aggregate function.

crosstabulation table
a two-dimensional table that shows frequency distributions or other aggregate
statistics for the intersections of two or more categories. In a crosstabulation table,
categories are displayed on both the columns and rows, and each cell value represents
the data result from the intersection of the categories on the specific row and column.

cube
a set of data that is organized and structured in a hierarchical, multidimensional
arrangement. A cube includes measures, and it can have numerous dimensions and
levels of data.

data item
an item in a data source that is either a logical view of a physical data field or a
calculation. The author of a report decides which data items to use in a particular
section of a report. There are three types of data items: hierarchies, categories, and
measures.

data source
a collection of data items and filters that describes and provides a view of physical
data. Users of query and reporting applications such as SAS Web Report Studio can
easily build business reports by using data sources as the building blocks for their
reports.

detail data
(1) for multidimensional data sources, nonaggregated data. (2) for relational data
sources, every record in a selected data source. Duplicate records can be either
excluded or included. See also multidimensional data source, relational data source.
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dimension
a group of closely related hierarchies. Hierarchies within a dimension typically
represent different groupings of information that pertains to a single concept. For
example, a Time dimension might consist of two hierarchies: (1) Year, Month, Date,
and (2) Year, Week, Day. See also hierarchy.

equivalent interval
one group in a range of data that has been divided into equal groups.

expression
a combination of data elements, literals, functions, and mathematical operators. An
expression can be used to derive a value or to specify a condition that determines
whether or how data is processed.

hierarchy
an arrangement of members of a dimension into levels that are based on parent-child
relationships. Members of a hierarchy are arranged from more general to more
specific. For example, in a Time dimension, a hierarchy might consist of the members
Year, Quarter, Month, and Day. In a Geography dimension, a hierarchy might consist
of the members Country, State or Province, and City. More than one hierarchy can be
defined for a dimension. Each hierarchy provides a navigational path that enables
users to drill down to increasing levels of detail. See also member, level.

histogram
in a process capability analysis, histograms are used to visualize the shape of the
data distribution and to compare the data distribution with specification limits.

level
in a multidimensional database (or cube), an element of a dimension hierarchy.
Levels describe the dimension from the highest (most summarized) level to the
lowest (most detailed) level. For example, possible levels for a Geography dimension
are Country, Region, State or Province, and City.

line graph
a graph that shows the relationship of one variable to another, often as movements
or trends in the data over a period of time. Line graphs summarize source data and
typically are used to chart response values against discrete categorical values.

list table
a two-dimensional representation of data, in which the data values are arranged in
rows and columns.

locale
a value that reflects the language, local conventions, and culture for a geographic
region. Local conventions can include specific formatting rules for dates, times, and
numbers, and a currency symbol for the country or region. Some examples of locale
values are French_Canada, Portuguese_Brazil, and Chinese_Singapore.

mean
the arithmetic average, which is calculated by adding the values of a sample variable
and dividing this sum by the number of observations.

measure
(1) a data item or column whose value can be used in computations or analytical
expressions. Typically, these values are numeric. (2) a special dimension that usually
represents numeric data values that are analyzed.

member
in a multidimensional database (or cube), a name that represents a particular data
element within a dimension. For example, September 1996 might be a member of the
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Time dimension. A member can be either unique or non-unique. For example, 1997
and 1998 represent unique members in the Year level of a Time dimension. January
represents non-unique members in the Month level, because there can be more than
one January in the Time dimension if the Time dimension contains data for more
than one year.

multidimensional data source
a collection of data items and filters that describes and provides a view of a cube. See
also cube, data item, data source.

natural break
a boundary in a range of data as determined by a histogram of data distribution. See
also histogram.

pie chart
a circular chart that is divided into slices by radial lines. Each slice represents the
relative contribution of each part to the whole.

progressive bar chart
a type of bar chart that shows how the initial value of a measure data item increases
or decreases during a series of operations or transactions. See also bar chart.

publication channel
an information repository that has been established using the SAS Publishing
Framework and which can be used to publish information to users and applications.

quantile
any of the points or values that divide data into groups that contain equal numbers
of observations, or any of those groups.

query
a set of instructions that requests particular information from one or more data
sources.

relational data source
a collection of data items and filters that describes and provides a view of
two-dimensional physical data, in which the data values are arranged in rows and
columns. See also data item, data source.

scatter plot
a two-dimensional plot that shows the joint variation of two data items.

standard deviation
a statistical measure of the variability of a group of data values. This measure,
which is the most widely used measure of the dispersion of a frequency distribution,
is equal to the positive square root of the variance.

stored process
a SAS program that is stored on a server and which can be executed as requested by
client applications.
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